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Equipment warranty

The term of guarantee of normal operation of the storage system and free service is one year from
date of purchase.

If a failure occurs multiple times, the storage system might shut off to avoid a serious accident.

Backup

Hitachi cannot guarantee against data loss due to failures. Therefore, back up your data to minimize
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Data backup is also critical when hardware components are added or replaced, because performing
such hardware procedures restores parameter settings that can affect how data is managed on the
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Disposal
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This symbol on the product or on its packaging means that your electrical and electronic equipment should be
disposed at the end of life separately from your household wastes.

There are separate collection systems for recycling in the European Union. For more information, contact the
local authority or the dealer where you purchased the product.

UEFI Development Kit 2010

This product includes UEFI Development Kit 2010 written by the UEFI Open Source Community. For more
information, see the UEFI Development Kit website:

http://sourceforge.net/apps/mediawiki/tianocore/index.php?title=UDK2010

© 2004, Intel Corporation.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted provided that the
following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions and the following
disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and the
following disclaimer in the documentation and/or other materials provided with the distribution.

Neither the name of the Intel Corporation nor the names of its contributors might be used to endorse or
promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY EXPRESS
OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE
COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)
HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT
(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN
IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Preface
This document describes how to service components in the Hitachi Virtual
Storage Platform G200, G400, G600, G800 or Hitachi Virtual Storage
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Safety and environmental notices
Equipment warranty

The term of guarantee of normal operation of the storage system and free service is one year from
date of purchase.

If a failure occurs multiple times, the storage system might shut off to avoid a serious accident.

Notice of export controls

Export of technical data contained in this document might require an export license from the United
States government, the government of Japan. or both. Contact the Hitachi Legal Department for
guidance about any export compliance questions.

Backup

Hitachi cannot guarantee against data loss due to failures. Therefore, back up your data to minimize
chances for data loss.

Data backup is also critical when hardware components are added or replaced, because performing
such hardware procedures restores parameter settings that can affect how data is managed on the
storage systems.

Disposal

 

 
This symbol on the product or on its packaging means that your electrical and electronic equipment
should be disposed at the end of life separately from your household wastes.

There are separate collection systems for recycling in the European Union. For more information,
contact the local authority or the dealer where you purchased the product.

UEFI Development Kit 2010

This product includes UEFI Development Kit 2010 written by the UEFI Open Source Community. For
more information, see the UEFI Development Kit website:

http://sourceforge.net/apps/mediawiki/tianocore/index.php?title=UDK2010

© 2004, Intel Corporation.

All rights reserved.

Redistribution and use in source and binary forms, with or without modification, are permitted
provided that the following conditions are met:

Redistributions of source code must retain the above copyright notice, this list of conditions and the
following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of conditions and
the following disclaimer in the documentation and/or other materials provided with the distribution.

Neither the name of the Intel Corporation nor the names of its contributors might be used to endorse
or promote products derived from this software without specific prior written permission.

THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS “AS IS” AND ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES
OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT
SHALL THE COPYRIGHT OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT,
INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED
TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR
BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN
CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY
WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH
DAMAGE.
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General safety guidelines
Before starting maintenance:
• Maintenance must be performed by trained and qualified engineers only.
• The safety guidelines and procedures in this manual must be read and

followed.
• In this manual and on the storage system, hazard warnings are provided

to aid you in preventing or reducing the risk of death, personal injury, or
product damage. Understand and follow these hazard warnings fully.

• If the warning labels on the storage system become dirty or start peeling
off, replace them.

• If an anomaly such as an unusual noise, smell, or smoke occurs on the
storage system while it is running, turn off the system or remove the
power cables immediately.

• Hazard warnings in this manual or on the storage system cannot cover
every possible case, because it is impossible to predict and evaluate all
circumstances beforehand. Be alert and use common sense.

• To verify normal operation, operate the storage system according to the
information in this manual.

Read the following safety guidelines carefully and follow them when you
conduct maintenance of the machine:
• Do not use materials that are outside the specifications for the storage

system.
• Use the spare parts, consumables, and materials for maintenance that are

specified in this manual; otherwise, personal injury, system damage, and
degradation in system quality can occur.

• Keep the maintenance area neat.
• Always put away parts, materials, and tools when not in use.

Handling of heavy parts
• When lifting a heavy object, hold it close to yourself and keep your back

erect to prevent back injury.
• When lifting an object designated with a caution in this manual, use a

proper lifting tool or ask someone to assist you.

Preventing electric shock
• Before starting work, be sure that, unless otherwise specifically instructed,

there is no potential electric hazard in the maintenance area such as
insufficient grounding or a wet floor.

• Before starting work, know where the emergency off switches are located
and know how to operate them.

Preface 15
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• Unless otherwise specifically instructed, remove all power sources to the
machine before starting maintenance. Switching off the storage system
power supplies is usually not sufficient.

• Do not touch any uninsulated conductor or surface that remains charged
shortly after the external power supply to the storage system is
disconnected.

• Do not replace parts during a thunderstorm.

Avoiding rotating or moving parts
• Do not supply power to any device with rotating or moving parts that are

not properly covered.
• Tuck in your tie, scarf, shirt, or any other loose clothing to prevent it from

getting caught by a rotating or moving part.

Preventing machine damage
• Use the tools and instruments, as instructed in this manual, or equivalent

commercially available tools and instruments suited for the purpose.
• Use measurement instruments and powered tools that are properly

calibrated or periodically inspected.
• Before finishing your work, be sure all parts removed during maintenance

have been installed in their original positions in the storage system. Do not
leave any tools or foreign material in the storage system.

Working when the storage system is in operation
Observe the following safety measures when working on a storage system
that is in operation. When you perform maintenance, do not touch live
electric parts to prevent an electric shock.
• Do not touch heat sinks immediately after a board is removed because the

heat sinks can be extremely hot.
• While performing maintenance, do not drop tools, screws, or other items

into the storage system, because doing so can cause a short circuit.
• While performing maintenance, do not damage or pinch wires.
• When moving a heavy object, ask at least two people to move the object

after confirming there are no obstacles nearby.

Precautions when using the storage system
• Use the supplied power cords included with the storage system. Do not

use the supplied power cords for other products. Do not use other power
cords with the storage system.

• Stop the power feed to the equipment and inform the system
administrator immediately if you notice an unusual smell, abnormal heat
generation, or smoke emission. Leaving such conditions unattended can
cause electric shock or fire.
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• Be careful when handling the storage system and its parts. Do not drop
the equipment or parts.

• Do not stand on the storage system. Avoid using the storage system for
any use other than the one for which it was designed.

• Do not place heavy objects on the storage system, near the vents on the
front and rear panels, or on the cables attached to the storage system.

• Do not put a container with items like water or paper clips on the storage
system or near the power supply.

• Route cables so as to prevent people from tripping over them.
• Do not operate the storage system in a moist or dusty place.
• Keep these vents open and be sure they are not blocked to keep the

storage system ventilated. Cool air enters the storage system from the air
vent on the front panel and exits through the vent on the rear panel.

• If a failure occurs in the storage system, follow the instructions in this
manual. If the problem is not covered by this manual, contact your system
administrator.

Emergency procedures
Use the following procedures to prevent electrical shock or fire when working
with the storage system while it is in operation.

For electric shock
• Before performing maintenance, clear away any potential electric hazards

in the maintenance area, such as insufficient grounding, loose electrical
cables or a wet floor.

• Before performing maintenance, locate the emergency off switches and
know how to operate them.

• Unless instructed, remove all power sources to the storage system before
working on it. Switching off the storage system power supplies is not
sufficient. When power is distributed from a wall or floor outlet, unplug the
power supply cord or turn off the switch on the power distribution panel or
board.

• If the power supply has a lockout device, lock the device after powering off
the storage system and retain the key. Attach a notice on the panel or
board prohibiting the use of the switch.

• If the machine power has been already turned off, verify these conditions
have been satisfied.

For fire
• Stop all the power to the machine.
• Turn off the emergency power switch or stop the power supply to the

storage system.
• If the fire continues to burn after the power is turned off, take necessary

actions such as using a fire extinguisher or contacting the fire department.
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Audience and qualifications
This guide is intended for data center administrators, facility managers, and
others who perform the planning and preparation work for storage system
installations. It references skilled tasks and describes important safety
considerations, and is not intended as a training aid for untrained personnel.

The information in this guide assumes the reader has the following abilities:
• Is familiar with computing terminology, RAID technology, and optical and

Ethernet connectivity.
• Understands networking concepts, network switch technology, and

network cabling.
• Knows how to calculate floor loads and power budgeting.
• Understands the procedures for installing rack-mounted components and is

trained in safe work procedures.
• Is familiar with high-speed interconnects for modular storage systems.

Product version
This document revision applies to Hitachi Virtual Storage Platform G200,
G400, G600, G800 and Hitachi Virtual Storage Platform F400, F600, F800
firmware 83-04-2x or later.

Release notes
Read the release notes before installing and using this product. They may
contain requirements or restrictions that are not fully described in this
document or updates or corrections to this document. Release notes are
available on Hitachi Data Systems Support Connect: https://
knowledge.hds.com/Documents.

Changes made in this revision
For more information about availability, contact customer support.

• Added new front end module (DW-F800-4HF32R) equipped with 32-Gbps
Fibre Channel SFP for connecting VSP Gx00 models and VSP Fx00 models
with external devices.

• Added support for the NAS Module
• Modified information related to replacing a channel board to support a 32-

Gbps Fibre Channel 4-port front end module.
• Added support for 10-TB hard disk drive (HDD) and Flash Module Drives

(FMD) with capacities of 7 TB and 14 TB.
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Document conventions
This document uses the following typographic conventions:

Convention Description

Bold • Indicates text in a window, including window titles, menus, menu options,
buttons, fields, and labels. Example:
Click OK.

• Indicates emphasized words in list items.

Italic • Indicates a document title or emphasized words in text.
• Indicates a variable, which is a placeholder for actual text provided by the

user or for output by the system. Example:

pairdisplay -g group

(For exceptions to this convention for variables, see the entry for angle
brackets.)

Monospace Indicates text that is displayed on screen or entered by the user. Example:
pairdisplay -g oradb

< > angle brackets Indicates variables in the following scenarios:
• Variables are not clearly separated from the surrounding text or from

other variables. Example:

Status-<report-name><file-version>.csv

• Variables in headings.

[ ] square brackets Indicates optional values. Example: [ a | b ] indicates that you can choose a,
b, or nothing.

{ } braces Indicates required or expected values. Example: { a | b } indicates that you
must choose either a or b.

| vertical bar Indicates that you have a choice between two or more options or arguments.
Examples:

[ a | b ] indicates that you can choose a, b, or nothing.

{ a | b } indicates that you must choose either a or b.

This document uses the following icons to draw attention to information:

Icon Label Description

Note Calls attention to important or additional information.

Tip Provides helpful information, guidelines, or suggestions for performing
tasks more effectively.

Caution Warns the user of adverse conditions and/or consequences (for
example, disruptive operations, data loss, or a system crash).
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Icon Label Description

WARNING Warns the user of a hazardous situation which, if not avoided, could
result in death or serious injury.

Conventions for storage capacity values
Physical storage capacity values (for example, disk drive capacity) are
calculated based on the following values:

Physical capacity unit Value

1 kilobyte (KB) 1,000 (10 3) bytes

1 megabyte (MB) 1,000 KB or 1,0002 bytes

1 gigabyte (GB) 1,000 MB or 1,0003 bytes

1 terabyte (TB) 1,000 GB or 1,0004 bytes

1 petabyte (PB) 1,000 TB or 1,0005 bytes

1 exabyte (EB) 1,000 PB or 1,0006 bytes

Logical capacity values (for example, logical device capacity, cache memory
capacity) are calculated based on the following values:

Logical capacity unit Value

1 block 512 bytes

1 cylinder Mainframe: 870 KB

Open-systems:
• OPEN-V: 960 KB
• Others: 720 KB

1 KB 1,024 (210) bytes

1 MB 1,024 KB or 1,0242 bytes

1 GB 1,024 MB or 1,0243 bytes

1 TB 1,024 GB or 1,0244 bytes

1 PB 1,024 TB or 1,0245 bytes

1 EB 1,024 PB or 1,0246 bytes

Accessing product documentation
Product user documentation is available on Hitachi Data Systems Support
Connect: https://knowledge.hds.com/Documents. Check this site for the
most current documentation, including important updates that may have
been made after the release of the product.
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Getting help
Hitachi Data Systems Support Connect is the destination for technical support
of products and solutions sold by Hitachi Data Systems. To contact technical
support, log on to Hitachi Data Systems Support Connect for contact
information: https://support.hds.com/en_us/contact-us.html.

Hitachi Data Systems Community is a global online community for HDS
customers, partners, independent software vendors, employees, and
prospects. It is the destination to get answers, discover insights, and make
connections. Join the conversation today! Go to community.hds.com,
register, and complete your profile.

Comments
Please send us your comments on this document to doc.comments@hds.com.
Include the document title and number, including the revision level (for
example, -07), and refer to specific sections and paragraphs whenever
possible. All comments become the property of Hitachi Data Systems
Corporation.

Thank you!
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1
Verifying component failures

This chapter describes how to use the maintenance utility to confirm
component failures.

□ Replaceable parts

□ Identifying hardware faults
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Replaceable parts
The following list shows the components that you can replace on site for the
storage systems.

Note: For the dense intermix drive tray, the only user-replacement procedure
supported by Hitachi is installing or replacing disk drives.

• Drive (replacing drives on the flash module drive tray is is strictly limited
to Hitachi and certified partners)

• Battery
• Fan for CBSS or CBSL
• Power supply unit
• Controller
• Cache memory
• Front end module
• Small Form-Factor Pluggable
• Back end module for CBLM or CBLH
• ENC
• SAS cable
• Cache Flash Memory
• LAN blade
• Backup module (BKM) for CBSS or CBSL
• Backup module (BKMF) for CBLM or CBLH

Identifying hardware faults
There are several ways the storage system can alert you to failures:
• When notified about an error by email or the Simple Management Network

Protocol (SMNP).
• When a failure is indicated by storage system LED (for example, WARNING

or ALARM LED goes on or READY LED does not go on).

To identify a failed part and recover the storage system:

Procedure

1. Check the serial number of the storage system referenced in the email
notification or SNMP alert.

2. Start the maintenance utility.
3. In the Maintenance Utility window, check the serial number of the

storage system where the error was reported. Confirm that this serial
number matches the one in step 1.
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4. In the left pane of the Maintenance Utility window (circled in the figure

below), check the Status of the storage system.
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Storage system
status Description Has the alert been

acknowledged? Navigation area

Failed The storage system
might be down.

No  

 

Yes  

 

Warning A part has a Blocked
or Warning status.

No  

 

Yes  

 

Ready All parts have a
normal status.

No  

 

Yes  

 

Power-on in
progress

Power-on is in progress.  

 

Power-off in
progress

Power-off is in progress.  

 

Unknown The storage system is in an unknown state prior to
power on.

 

 

5. At the top-right of the Maintenance Utility window, click Alert.
 

26 Verifying component failures
Service Guide for VSP Gx00 and VSP Fx00 Models



 
The window switches to the Alerts tab.

 

 
6. Click the Alert ID.

The Alert Detail window shows the failed part that must be replaced.
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Note: If SEE MANUAL does not appear at the top of Location in
the Alert Detail window, go to the next step. If SEE MANUAL
appears, take action based on the reference code displayed in the
Alert Detail window. If the user takes action or contact the HDS
Support Portal at https://support.hds.com/en_us/contact-us.html,
steps 7 and beyond are not required.

 

 
7. Refer to the following table for a description of the reference codes.

Reference code Recovery action Reference

aff20x Tighten the Cache Flash
Memory (CFM) screw if
necessary.

Replacing cache flash
memory on page 251

af400x Tighten the backup module
(BKM/BKMF) screw if
necessary.

Replacing a backup module
on page 269

af200x Check power supply (DKCPS)
connections.

Replacing a power supply on
page 141

af210x Check the connection of the
power cables on the power
supply (DKCPS).

Replacing a power supply on
page 141

af60xx Check the connection of the
power cables on the power

Replacing a power supply on
page 141
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supply (DBPS) for the small/
large form factor drive trays.

af50xx Check the connection of the
power cables on the power
supply (DBPS) for the flash
module drive tray.

Replacing a power supply on
page 141

fffa0x Check the connection of the
batteries on the backup
module (BKMF).

Replacing a backup module
on page 269

aff1xx Troubleshoot the GUM failure. Troubleshooting the
maintenance utility on
page 338

af4a0x Check power supply
(CHBBPS) connections.

Checking power cable
connections on a host port
expansion chassis on
page 157

af4b0x Check the connection of the
CHBBPS power cables to the
CHBB power supply unit.

Checking power cable
connections on a host port
expansion chassis on
page 157

af4cxx Check that the screw is
secure on the CHBBFAN fan.

Checking the screw on a host
port expansion chassis fan on
page 137

Reference codes other than
those above

Contact the HDS Support Portal at https://support.hds.com/
en_us/contact-us.html.

8. Click Action Code to check the replacement procedure.
 

 
9. Read the recovery steps shown in the Recovery Procedure window.

The following window shows an example of a drive failure.
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In this example:
• Drive = slot location of the drive in the drive tray.
• DB = number of the drive tray.

30 Verifying component failures
Service Guide for VSP Gx00 and VSP Fx00 Models



2
Hardware description

The system controllers, drive trays and service processor are essential
hardware components for a storage system. The following sections provide
technical description of the storage system components.

□ Storage system controllers

□ Virtual Storage Platform G200 Virtual Storage Platform G400, G600
Virtual Storage Platform G800 Virtual Storage Platform F400, F600 Virtual
Storage Platform F800 Controller LEDs and interfaces

□ Storage system drive trays

□ Host port expansion chassis

□ NAS Module Ports and LEDs

□ Hitachi Virtual Storage Platform Service processor server
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Storage system controllers
Every storage system has two controllers. The controllers contain fans and
power supplies, and provide the interfaces between a host and the storage
system.

A controller manages the I/O between the host system and data volumes.

CBSS controller
The CBSS controller includes specific functional LEDs located on the front and
rear of controller and power supplies to provide its operating status.

CBSS with front panel bezel
The following table describes the definitions of the CBSS controller front
panel bezel LEDs.

 

 

Number Item Description

1 POWER LED Green: Storage system is
powered on.

Amber: Storage system is
receiving power.

2 READY LED Green: Normal operation.

3 WARNING LED Off: Normal operation.

Amber: Component requires
maintenance.

Blink: Failure requires
maintenance.

Note: When System Option
Mode 1097 is set to ON, the
WARNING LED does not blink,
even if the following failure
service information messages
(SIM) are issued: 452xxx,
462xxx, 3077xx, 4100xx, and
410100.
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Number Item Description

LED might turn off during user
maintenance.

4 ALARM LED Off: Normal operation.

Red: Processor failure (system
might be down). Go to the
Customer Contact Us page at 
https://support.hds.com/
en_us/contact-us.html.

5 POWER ON/OFF (main switch) Powers the storage system.

6 Lock Locks and unlocks the front
panel bezel by using the
supplied key.

Note: Removing a controller can cause the POWER, READY, WARNING, and
ALARM LEDs on the front panel to turn off. These LEDs return to their on state
after the storage system recovers from the controller replacement.

CBSS front panel without bezel
The following table describes the definitions of the CBSS controller front
panel LEDs.

 

 

Number Item Description

1 ACT LED Green: Normal operation.

Blink green: Drive is being
accessed.

2 ALM LED Red: Drive stopped due to a
failure and can be replaced.

3 POWER, READY, WARNING, and
ALARM LEDs

Note: When System Option
Mode 1097 is set to ON, the
WARNING LED does not blink,
even if the following failure
service information messages
(SIM) are issued: 452xxx,
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Number Item Description

462xxx, 3077xx, 4100xx, and
410100.

4 POWER ON/OFF (main switch) Powers the storage system.

5 Small form factor drives The twenty-four 2.5-inch small
form factor drives are
positioned vertically. The slots
are organized from 0 to 23.

CBSS rear panel
The following table describes the definitions of the CBSS controller rear panel
LEDs.

Number Item Description

1 Controllers Controller 1 (left) and
Controller 2 (right).

2 Front end module N/A

3  CTL ALM LED Red: Controller can be
removed.

Blink red: Failure with the
power supply unit of the
controller.

Amber: LAN reset switch
was pressed.

4 BACKUP STTS LED Green: Power restoration
in progress following
power outage.

Fast blink green:
Restoring.

Slow blink green:
Restoring, or sequential
shutdown in progress.

5 CTL WARN LED Amber blink one time:
Failure with fan 0.
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Number Item Description

Amber blink two times:
Failure with fan 1.

6 Cache flash memory N/A

7 LAN-RST switch Use only when instructed
by customer support.

8 LAN port Maintenance LAN port
(left) and user LAN port
(right).

9 Uninterruptible power supply (UPS) port N/A

10 ALARM LED (for cache flash memory) Red: Cache flash memory
can be removed.

11 Backup module N/A

12  STATUS Green: Charging of the
battery in the backup
module is complete.

Blink green: Battery in the
backup module is charging
or discharging.

Red: Backup module can
be removed.

Blink red: Backup module
can be removed.

Blink red one time: Battery
failure

Off: battery is not
installed, failure occurred,
or firmware is being
upgraded.

13 SAS port N/A

14 Port LED Blue: Port link is
established.

15 Power supply unit N/A

CBSL controller
The CBSL controller includes specific functional LEDs located on the front and
rear of controller and power supplies to provide its operating status.

CBSL with front panel bezel
The following table describes the definitions of the CBSL controller front panel
bezel LEDs.
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Number Item Description

1 POWER LED Green: Storage system is
powered on.

Amber: Storage system is
receiving power.

2 READY LED Green: Normal operation.

3 WARNING LED Off: Normal operation.

Amber: Component requires
maintenance.

Blink: Failure requires
maintenance.

Note: When System Option
Mode 1097 is set to ON, the
WARNING LED does not blink,
even if the following failure
service information messages
(SIM) are issued: 452xxx,
462xxx, 3077xx, 4100xx, and
410100.

LED might turn off during user
maintenance.

4 ALARM LED Off: Normal operation.

Red: Processor failure (system
might be down). Go to the
Customer Contact Us page at 
https://support.hds.com/
en_us/contact-us.html.

5 POWER ON/OFF (main switch) Powers the storage system.

6 Lock Locks and unlocks the front
panel bezel by using the
supplied key.

Note: Removing a controller can cause the POWER, READY, WARNING, and
ALARM LEDs on the front panel to turn off. These LEDs return to their on state
after the storage system recovers from the controller replacement.
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CBSL front panel without bezel
The following table describes the definitions of the CBSL controller front panel
LEDs.

 

 

Number Item Description

1 ACT LED Green: Normal operation.

Blink green: Drive is being
accessed.

2 ALM LED Red: Drive stopped due to a
failure and can be replaced.

3 POWER, READY, WARNING, and
ALARM LEDs

Note: When System Option
Mode 1097 is set to ON, the
WARNING LED does not blink,
even if the following failure
service information messages
(SIM) are issued: 452xxx,
462xxx, 3077xx, 4100xx, and
410100.

4 POWER ON/OFF (main switch) Powers the storage system.

5 Large form factor drives The twelve 3.5-inch large form
factor drives are positioned
horizontally. The slots are
organized in the following
order:

8   9   10  11
4   5   6   7
0   1   2   3

CBSL rear panel
The following table describes the definitions of the CBSL controller rear panel
LEDs.

 

Hardware description 37
Service Guide for VSP Gx00 and VSP Fx00 Models



 

Number Item Description

1 Controllers Controller 1 (left) and
Controller 2 (right).

2 Front end module N/A

3  CTL ALM LED Red: Controller can be
removed.

Blink red: Failure with the
power supply unit of the
controller.

Amber: LAN reset switch
was pressed.

4 BACKUP STTS LED Green: Power restoration
in progress following
power outage.

Fast blink green:
Restoring.

Slow blink green:
Restoring, or sequential
shutdown in progress.

5 CTL WARN LED Amber blink one time:
Failure with fan 0.

Amber blink two times:
Failure with fan 1.

6 Cache flash memory N/A

7 LAN-RST switch Use only when instructed
by customer support.

8 LAN port Maintenance LAN port
(left) and user LAN port
(right).

9 Uninterruptible power supply (UPS) port N/A

10 ALARM LED (for cache flash memory) Red: Cache flash memory
can be removed.

11 Backup module N/A
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Number Item Description

12  STATUS Green: Charging of the
battery in the backup
module is complete.

Blink green: Battery in the
backup module is charging
or discharging.

Red: Backup module can
be removed.

Blink red: Backup module
can be removed.

Blink red one time: Battery
failure

Off: Battery is not
installed, failure occurred,
or firmware is being
upgraded.

13 SAS port N/A

14 Port LED Blue: Port link is
established.

15 Power supply unit N/A

CBLM controller
The CBLM controller includes specific functional LEDs located on the front and
rear of controller and power supplies to provide its operating status.

CBLMCBLH with front panel bezel
The following table describes the definitions of the CBLMCBLH controller front
panel bezel LEDs.
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Number Item Description

1 POWER LED Green: Storage system is
powered on.

Amber: Storage system is
receiving power.

2 READY LED Green: Normal operation.

3 WARNING LED Off: Normal operation.

Amber: Component requires
maintenance.

Blink: Failure requires
maintenance.

Note: When System Option
Mode 1097 is set to ON, the
WARNING LED does not blink,
even if the following failure
service information messages
(SIM) are issued: 452xxx,
462xxx, 3077xx, 4100xx, and
410100.

LED might turn off during user
maintenance.

4 ALARM LED Off: Normal operation.

Red: Processor failure (system
might be down). Go to the
Customer Contact Us page at 
https://support.hds.com/
en_us/contact-us.html.

5 POWER ON/OFF (main switch) Powers the storage system.

6 Lock Locks and unlocks the front
panel bezel by using the
supplied key.

Note: Removing a controller can cause the POWER, READY, WARNING, and
ALARM LEDs on the front panel to turn off. These LEDs return to the on status
after the storage system recovers from the controller replacement.

CBLMCBLH front panel without bezel
The following table describes the definitions of the CBLMCBLH controller front
panel LEDs.
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Number Item Description

1 POWER ON/OFF (main switch) Powers the storage system.

2 POWER, READY, WARNING, and
ALARM LEDs

Note: When System Option
Mode 1097 is set to ON, the
WARNING LED does not blink,
even if the following failure
service information messages
(SIM) are issued: 452xxx,
462xxx, 3077xx, 4100xx, and
410100.

3 Controllers Controller 1 (bottom) and
Controller 2 (top).

4 Backup module N/A

5 BACKUP LED Green: Power restoration in
progress following power
outage.

Fast blink green: Restoring.

Slow blink green: Restoring, or
sequential shutdown in
progress.

6 Cache flash memory N/A

7 ALM LED (for cache flash
memory)

Red: Cache flash memory can
be removed.

8  CTL ALM LED Red: Controller can be
removed.

Blink red: Failure with the
power supply unit of the
controller.

Amber: LAN reset switch was
pressed.

9 LAN-RST switch Use only when instructed by
customer support.
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Number Item Description

10  STATUS LED (for BKMF) Green: Charging of the battery
in the backup module is
complete.

Red: Backup module can be
removed.

Blink red one time: Main
battery failure.

Blink red two times: Backup
battery failure.

Blink red three times: Both
batteries failed or preventive
maintenance replacement of
batteries can run.

Off: Battery is not mounted,
battery-mounting failure
occurred, or firmware is being
upgraded. Off is normal status
for configurations without
batteries (for example,
BKMF-10 and BKMF-20).

CBLMCBLH rear panel
The following table describes the definitions of the CBLMCBLH controller rear
panel LEDs.
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Number Item

1 Power supply unit

2 Front end module

3 Back end module

4 LAN blade

Rear view (includes NAS modules)

Number Item

1 NAS module

2 Front end module

3 Back end module

4 LAN blade

5 Power supply unit

CBLH controller
The CBLH controller includes specific functional LEDs located on the front and
rear of controller and power supplies to provide its operating status.

CBLH with front panel bezel
The following table describes the definitions of the CBLH controller front panel
bezel LEDs.
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Number Item Description

1 Power Green: Storage system is
powered on.

Amber: Storage system is
receiving power.

2 Ready Green: Normal operation.

3 Warning Off: Normal operation.

Amber: Component requires
maintenance.

Blink: Failure requires
maintenance.

Note: When System
Option Mode 1097 is
set to ON, the
WARNING LED does
not blink even if the
following failure
information issues SIM:
Failure information
SIM: 452xxx, 462xxx,
3077xy, 4100xx and
410100.

LED might go OFF during user
maintenance.

4 Alarm Off: Normal operation.

Red: Processor failure (system
may be down). Go to the
Customer Contact Us page at 
https://support.hds.com/
en_us/contact-us.html.

5 Power ON/OFF Powers the storage system.

6 Lock Locks and unlocks the front
bezel by using the supplied key.
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Note: Removing a controller can cause the POWER, READY, WARNING, and
ALARM LEDs on the front panel to go off. These LEDs return to their on state
after the storage system recovers from the controller replacement.

CBLH front panel without bezel
The following table describes the definitions of the CBLH controller front panel
LEDs.

 

 

Number Item Description

1 POWER ON/OFF (main switch) Powers the storage system.

2 POWER, READY, WARNING, and
ALARM LEDs

See the previous table.

3 Controllers Controller 1 (bottom) and
Controller 2 (top).

4 Backup module N/A

5 BACKUP LED Green: Power restoration in
progress following power
outage.

Fast blink green: Restoring.

Slow blink green: Restoring, or
sequential shutdown in
progress.

6 Cache flash memory N/A

7 ALM LED (for cache flash
memory)

Red: Cache flash memory can
be removed.

8  CTL ALM LED Red: Controller can be
removed.

Blink red: Failure with the
power supply unit of the
controller.
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Number Item Description

Amber: LAN reset switch was
pressed.

9 LAN-RST switch Use only when instructed by
customer support.

10  STATUS LED (for BKMF) Green: Charging of the battery
in the backup module is
complete.

Red: Backup module can be
removed.

Blink red one time: Main
battery failure.

Blink red two times: Backup
battery failure.

Blink red three times: Both
batteries failed or preventive
maintenance replacement of
batteries can run.

Off: Battery is not mounted,
battery-mounting failure
occurred, or firmware is being
upgraded. Off is normal status
for configurations without
batteries (for example,
BKMF-10 and BKMF-20).

CBLH rear panel
The following table describes the definitions of the CBLH controller rear panel
LEDs.
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Number Item

1 Power supply unit

2 Front end module

3 Back end module

4 LAN blade

Rear view (includes NAS modules)

Number Item

1 NAS module

2 Back end module

3 LAN blade

4 Power supply unit

Virtual Storage Platform G200 Virtual Storage Platform
G400, G600 Virtual Storage Platform G800 Virtual Storage
Platform F400, F600 Virtual Storage Platform F800
Controller LEDs and interfaces

The controllers are equipped with interfaces for connecting, powering,
configuring, and managing the storage system. The component LEDs display
the operating status of the storage system.
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Front end module descriptions
The front end module LEDs display the operating status of the module.

10-Gbps iSCSI board LEDs and connectors (optical)
 

 

Number Item Description

1 STATUS LED Green: Front end module is in
the power-on state.

Red: Front end module can be
removed safely.

2 PORT LED Red: Small form factor
pluggable can be removed.

Blue: Normal link status.

Blink blue: Front end module is
in communication status.

3 iSCSI connectors Connect to Ethernet LAN
cables.

10-Gbps iSCSI board LEDs and connectors (copper)
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Number Item Description

1 STATUS LED Green: Front end module is in
the power-on state.

Red: Front end module can be
removed safely.

2 PORT (Link/Speed) LED Yellow: 1-Gbps link.

Green: 10-Gbps link.

Off: No link connection.

3 PORT LED Green: Link connection is
established.

Blinking: Communication is in
progress.

Off: No link connection or not
ready to communicate.

4 iSCSI connectors Connect to Ethernet LAN
cables.

8-Gbps, 16-Gbps, or 32-Gbps Fibre Channel (4-port) board LEDs and connectors
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Table 1  8-Gbps Fibre Channel

Number Item Description

1 Fibre Channel connectors Connect to Fibre Channel
cables.

2 STATUS LED Green: Front end module is in
power-on state.

Red: Front end module can be
removed safely.

3 PORT LED Red: Small form factor
pluggable can be removed.

Blue: Normal link status at 8-
Gbps.

Green: Normal link status at 2-
Gbps or 4-Gbps.

Table 2  32-Gbps, 16-Gbps Fibre Channel

Number Item Description

1 Fibre Channel connectors Connect to Fibre Channel
cables.

2 STATUS LED Green: Front end module is in
power-on state.

Red: Front end module can be
removed safely.

3 PORT LED Red: Small form factor
pluggable can be removed.

Blue: Normal link status at 16-
Gbps (16-Gbps).

Blue: Normal link status at 32-
Gbps (32-Gbps).
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Number Item Description

Green: Normal link status at 4-
Gbps or 8-Gbps (16-Gbps).

Green: Normal link status at 8-
Gbps or 16-Gbps (32-Gbps).

Port assignments

CHB number
8-Gbps, 16-Gbps, or 32-Gbps Fibre Channel Ports (left to right)

Port 1 Port 2 Port 3 Port 4

CHB-1A 1A 3A 5A 7A

CHB-1B 1B 3B 5B 7B

CHB-1C 1C 3C 5C 7C

CHB-1D 1D 3D 5D 7D

CHB-1E 1E 3E 5E 7E

CHB-1F 1F 3F 5F 7F

CHB-1G 1G 3G 5G 7G

CHB-1H 1H 3H 5H 7H

CHB-2A 2A 4A 6A 8A

CHB-2B 2B 4B 6B 8B

CHB-2C 2C 4C 6C 8C

CHB-2D 2D 4D 6D 8D

CHB-2E 2E 4E 6E 8E

CHB-2F 2F 4F 6F 8F

CHB-2G 2G 4G 6G 8G

CHB-2H 2H 4H 6H 8H

16-Gbps Fibre Channel (2-port) board LEDs and connectors
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Number Item Description

1 STATUS LED Green: Front end module is in
the power-on state.

Red: Front end module can be
removed safely.

2 PORT LED Red: Small form factor
pluggable can be removed.

Blue: Normal link status at 16-
Gbps.

Green: Normal link status at 4-
Gbps or 8-Gbps.

3 Fibre Channel connectors Connect to Fibre Channel
cables.

Port assignments

CHB number
16-Gbps Fibre Channel Ports (left to right)

Port 1 Port 2

CHB-1A 1A 3A

CHB-1B 1B 3B

CHB-1C 1C 3C

CHB-1D 1D 3D

CHB-1E 1E 3E

CHB-1F 1F 3F

CHB-1G 1G 3G

CHB-1H 1H 3H

CHB-2A 2A 4A

CHB-2B 2B 4B

CHB-2C 2C 4C

CHB-2D 2D 4D

CHB-2E 2E 4E

CHB-2F 2F 4F

CHB-2G 2G 4G

CHB-2H 2H 4H

PCIe module
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Number Item Description

1 STATUS LED Green: PCIe module is in the
power-ON status.

Red: PCIe module failure
occurred.

Off: PCIe module can be
removed safely.

2 Link Green: PCIe is Gen-3 (8-Gbps)
and is linked up normally.

Off: PCIe is not linked up (PCIe
cable might not be connected).
If a PCIe cable is connected, it
can be removed safely.

LAN blade LEDs and connectors
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Number Item Description

1 ACT LED Green: Data is being
transferred.

2 LINK LED Green: Link status is normal.

3 LAN 2 LAN port used by the user.

4 LAN 1 Maintenance LAN port used by
service personnel.

5 LAN ALARM LED Red: LAN blade can be
removed.

6 Uninterruptible power supply
(UPS) port

N/A

Back end module LEDs and connectors
The back end module LEDs display the operating status of the module.

 

 

Number Item Description

1 PATH 1 connector Connects to a drive tray.

2 PORT LED Blue: Normal link status.
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Number Item Description

1 STATUS LED Green: Back end module is in
the power-on state.

Red: Back end module can be
removed safely.

2 Port LED Blue: Link status is normal.

3 PATH 0 connector Connect to a drive tray.

4 PATH 1 connector Connects to a drive tray.

CBSS/CBSL AC power supply unit LEDs and connectors
The following table describes the definitions of the CBSS and CBSL AC power
supply unit LEDs and connectors.

 

 

Number Item Description

1 Receptacle Connects to the power cable
provided with the storage
system.

2 AC IN LED Blue: AC input is normal.

3 ALM/RDY LED Red: Power supply unit can be
replaced.

Green: Normal operation.

CBSSD/CBSLD DC power supply unit LEDs and connectors
The following table describes the definitions of the CBSSD and CBSLD DC
power supply unit LEDs and connectors.
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Number Item Description

1 ALM/RDY LED Red: Power supply unit can be
replaced.

Green: Normal operation.

2 DC IN LED Blue: DC input is normal.

CBLM power supply unit LEDs and connectorsCBLH power supply
unit LEDs and connectors

The following table lists the definitions of the CBLMCBLH power supply unit
LEDs and connectors.

 

 

Number Item Description

1 ALM/RDY LED Red: Power supply unit can be
replaced.
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Number Item Description

2 Receptacle Connects to the power cable
provided with the storage
system.

3 RDY LED Green: Normal operation.

Storage system drive trays
Drive trays contain drives, power supplies, fans, and status LEDs. They also
provide interfaces for connecting to controllers and other drive trays.

All-flash storage arrays have various fixed storage capacity configurations of
FMD DC2 flash storage devices. To deliver consistent low latency host
response times and highest IOP performance across all host connection ports,
no HDDs are included or permitted to be configured as part of these
configurations.

Small form-factor (SFF) drive tray

SFF with front panel bezel
 

 

Number Item Description

1 POWER LED Green: Drive tray is powered
on.

2 READY LED Green: Drive tray is
operational.

3 LOCATE LED Amber:
• Indicates the location of the

chassis.
• Can be turned on or turned

off by the maintenance
utility.
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Number Item Description

4 Lock Locks and unlocks the front
panel bezel by using the
supplied key.

SFF front panel without bezel
 

 

Number Item Description

1 ACT LED Green: Normal operation.

Blink green: Drive is being
accessed.

2 ALM LED Red: Drive stopped due to a
failure and can be replaced.

3 POWER, READY, and LOCATE LEDs Green: Drive tray is powered
on.

Green: Drive tray is
operational.

Amber:
• Indicates the location of the

chassis.
• Can be turned on or turned

off by the maintenance
utility.

4 Small form factor drives The twenty-four 2.5-inch small
form factor drives are
positioned vertically. The slots
are organized from 0 to 23.
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SFF rear panel
 

 

Number Item Description

1 ENC N/A

2 POWER LED Green: ENC is in the power-on
state.

3 LOCATE LED Amber:
• Indicates the location of the

chassis.
• Can be turned on or turned

off by the maintenance
utility.

4 ALARM LED Red: ENC can be replaced.

5 PATH (IN) LED Blue: IN side port is linked up.

6 PATH (IN) connector Connects to a controller or
drive tray.

7 PATH (OUT)LED Blue: OUT side port is linked
up.

8 PATH (OUT) connector Connects to a drive tray.

9 Console This port is reserved.

10 Power supply unit N/A

11 Receptacle Connects to the power cable
provided with the storage
system.

12 AC IN LED Green: Normal operation.

13 ALM LED Red: Power supply unit can be
replaced.

14 RDY LED Green: Normal operation.

Large form-factor (LFF) drive tray

LFF with front panel bezel
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Number Item Description

1 POWER LED Green: Drive tray is powered
on.

2 READY LED Green: Drive tray is
operational.

3 LOCATE LED Amber:
• Indicates the location of the

chassis.
• Can be turned on or turned

off by the maintenance
utility.

4 Lock Locks and unlocks the front
panel bezel by using the
supplied key.

LFF front panel without bezel
 

 

Number Item Description

1 POWER, READY, and LOCATE LEDs Green: Drive tray is powered
on.

Green: Drive tray is
operational.

Amber:
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Number Item Description

• Indicates the location of the
chassis.

• Can be turned on or turned
off by the maintenance
utility.

2 ACT LED Green: Normal operation.

Blink green: Drive is being
accessed.

3 ALM LED Red: Drive stopped due to a
failure and can be replaced.

4 Large form factor drives The twelve 3.5-inch large form
factor drives are positioned
horizontally. The slots are
organized in the following
order:

8   9   10  11
4   5   6   7
0   1   2   3

LFF rear panel
 

 

Number Item Description

1 ENC N/A

2 POWER LED Green: ENC is in the power-on
state.

3 LOCATE LED Amber:
• Indicates the location of the

chassis.
• Can be turned on or turned

off by the maintenance
utility.

4 ALARM LED Red: ENC can be replaced.

5 PATH (IN) LED Blue: IN side port is linked up.
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Number Item Description

6 PATH (IN) connector Connects to a controller or
drive tray.

7 PATH (OUT)LED Blue: OUT side port is linked
up.

8 PATH (OUT) connector Connects to a drive tray.

9 Console This port is reserved.

10 Power supply unit N/A

11 Receptacle Connects to the power cable
provided with the storage
system.

12 AC IN LED Green: Normal operation.

13 ALM LED Red: Power supply unit can be
replaced.

14 RDY LED Green: Normal operation.

Flash module drive (FMD) tray

FMD with front panel bezel
 

 

Number Item Description

1 POWER LED Green: Drive tray is powered
on.

2 READY LED Green: Drive tray is
operational.

3 LOCATE LED Amber:
• Indicates the location of the

chassis.
• Can be turned on or turned

off by the maintenance
utility.

4 Lock Locks and unlocks the front
panel bezel by using the
supplied key.
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FMD front panel without bezel
 

 

Number Item Description

1, 2 ACT LED Green: Normal operation.

Blink: Drive is being accessed.

Slow blink:
• DKC-F710I-1R6FM/3R2FM:

Insufficient battery capacity
in the flash module drive.

• DKC-F810I-1R6FN/3R2FN/
6R4FN: Flash module drive
built-in capacitor is charged.
If the storage system is
turned on, the LED stops
blinking when the capacitor
is finished charging
(approximately two
minutes).

Note: ACT indicator is only
printed on some types of FMDs.

ALM LED Red: Drive stopped due to a
failure and can be replaced.

Note: ACT indicator is only
printed on some types of FMDs.

3 POWER, READY, and LOCATE LEDs Green: Drive tray is powered
on.
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Number Item Description

Green: Drive tray is
operational.

Amber:
• Indicates the location of the

chassis.
• Can be turned on or turned

off by the maintenance
utility.

4 Flash module drives Twelve flash module drives.
Slots are organized the
following way:

9, 10, 11

6, 7, 8

3, 4, 5

0, 1, 2

FMD rear panel
 

 

Number Item Description

1 ENC N/A

2 POWER LED Green: ENC is in the power-on
state.

3 LOCATE LED Amber:
• Indicates the location of the

chassis.
• Can be turned on or turned

off by the maintenance
utility.

4 ALARM LED Red: ENC can be replaced.

5 PATH (IN) LED Blue: IN side port is linked up.
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Number Item Description

6 PATH (IN) connector Connects to a controller or
drive tray.

7 PATH (OUT)LED Blue: OUT side port is linked
up.

8 PATH (OUT) connector Connect to a drive tray.

9 Console This port is reserved.

10 Receptacle Connects to the power cable
provided with the storage
system.

11 Three LEDS, top to bottom:
RDY LED

AC IN LED

ALM REPLACE LED

Green: Power supply unit is
operating normally.

Green: Power supply unit is
operating normally.

Red: Power supply unit can be
replaced.

Dense intermix drive tray

Dense intermix drive tray with front panel bezel
 

 

Number Item Description

1 POWER LED Green: Drive tray is powered
on.

2 READY LED Green: Drive tray is
operational.

3 LOCATE LED Amber:
• Indicates the location of the

chassis.
• Can be turned on or turned

off by the maintenance
utility.
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Number Item Description

4 Lock Locks and unlocks the front
panel bezel by using the
supplied key.

Dense intermix drive tray display LEDs
 

 

Number Item Description

1 ACT                       Green: Normal operation.

Blink green: Drive is being
accessed.

2 ALM LED Red: Drive stopped due to a
failure and can be replaced.

Note: At the rear of the drive tray, the drives are organized from left to right.
On the left side of the preceding figure, the rear of the drive tray is at the
top.
• Rear of drive tray: 48-59
• 36-47
• 24-35
• 12-23
• Front of drive tray: 00-11

66 Hardware description
Service Guide for VSP Gx00 and VSP Fx00 Models



Dense intermix drive tray rear panel
 

 

Number Item Description

1 Power supply unit N/A

2 RDY LED Green: Normal operation.

3 AC IN LED Green: Normal operation.

4 ALM LED Red: Power supply unit can be
replaced.

5 Receptacle Connects to the power cable
provided with the storage
system.

6 ENC N/A

7 PATH (OUT)LED Blue: OUT side port is linked
up.

8 PATH (OUT) connector Connect to a drive tray.

9 PATH (IN) LED Blue: IN side port is linked up.

10 PATH (IN) connector Connects to a controller or
drive tray.

11 Console This port is reserved.

12 ALARM LED Red: ENC can be replaced.

13 LOCATE LED Amber:
• Indicates the location of the

chassis.
• Can be turned on or turned

off by the maintenance
utility.
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14 POWER LED Green: ENC is in the power-on
state.

SFF and LFF AC power supply unit LEDs and connectors
Both SFF and LFF drive trays are equipped with AC power supply units. The
AC power supply units include LEDs to display its operating status.

 

 

Number Item Description

1 RDY LED Green: Normal operation.

2 AC IN LED Green: AC input is operating
normally.

3 ALM LED Red: Power supply unit can be
replaced.

SFF and LFF DC power supply unit LEDs and connectors
Both SFF and LFF drive trays are equipped with DC power supply units. The
DC power supply units include LEDs to display its operating status.

 

 

Number Item Description

1 RDY LED Green: Normal operation.
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2 DC IN LED Green: DC input is operating
normally.

3 ALM LED Red: Power supply unit can be
replaced.

Host port expansion chassis

Host port expansion chassis front panel bezel LEDs
 

 

Number Item Description

1 POWER LED Green: Host port expansion is
turned on.

Amber: PCIe module is turned
on.

Off: PCIe module is turned off.

2 Safety lock Lock or unlock the front bezel.

PCIe switchboard
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Number Item Description

1 STATUS LED Green: PCIe switchboard is
powered on.
Red: PCIe switchboard can be
replaced safely.

Off: PCIe switchboard is
powered off.

Host port expansion chassis fan
 

 

Number Item Description

1 ALM LED Red: Fan failure has occurred.
Off: Normal operation.

PCIe cable connector
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Number Item Description

1 STATUS LED Green: PCIe cable connector is
powered on.

Red: PCIe cable connector can
be replaced safely.

Off: PCIe cable connector is
powered off.

2 Link Basic LED Green: Basic PCIe Gen-3.0 (8-
Gbps) is linked up normally.

Off: Basic PCIe is not linked up
(PCIe cable might not be
connected). If a cable is
connected, it can be removed
safely.

3 InAct Basic LED Amber: Basic PCIe status
changed from link up to link
down and cables. Cables can be
removed safely.

Off: Basic PCIe is normal or not
set.

4 Link Option LED Green: Option PCIe Gen-3.0 (8-
Gbps) is linked up normally.

Off: Option PCIe is not linked
up (PCIe cable might not be
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connected). If a cable is
connected, it can be removed
safely.

5 InAct Option LED Amber: Option PCIe status
changed from link up to link
down and cables. Cables can be
removed safely.

Off: Option PCIe is normal or
not set.

Host port expansion chassis power supply
 

 

Number Item Description

1 ALM/RDY LED Red: Host port expansion
chassis power supply can be
replaced safely.

Green: Normal operation.

2 AC IN LED Blue: AC input is normal.
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NAS Module Ports and LEDs

Legend Name Color Description

1 User LAN port - This is used with the
file level access.

1. Target group 1
2. Target group 2
3. Target group 3
4. Target group 4
5. Target group 5
6. Target group 6

2 Cluster port - Reserved for future use

3 Status LED Green NAS modules are
functioning normally.

Red NAS modules can be
removed.

4 Link LED Blue Displays link status.

5 Fail LED Red A failure has occured.

Hitachi Virtual Storage Platform Service processor server
The VSP Gx00 models include a separate, dedicated 1U service processor
(SVP) to host an element manager (Storage Navigator). The SVP (model
number 3919435.P) operates independently from the CPU of the storage
system and operating system, and provides out‑of‑band configuration and
management of the storage system. The SVP also monitors and collects
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performance data for key components of the storage system to enable
diagnostic testing and analysis for customer support.

For more information about the SVP, see the Service Processor Technical
Reference.

Service processor description
The SVP runs Windows® Embedded Standard 7 operating system, which
provides the same desktop environment look and feel as Windows 7
Professional.

The SVP software application can also be installed on a customer-supplied
server running Windows 7 Professional x64 Service Pack 1, Windows 10
Professional or Enterprise, or Windows Server 2012 or Windows Server 2012
R2. For more information about supported hardware, operating systems and
virtual environments, see the Service Processor Technical Reference for VSP
Gx00 and VSP Fx00 Models.
• Microsoft Hyper-V Windows Server 2012 R2
• VMware ESXi
• Linux KVM

Note: This product is also designed for IT power distribution systems with
phase-to-phase voltage.

The SVP provides four RJ-45 ports:
• Two ports connect to the storage system controllers (one port for each

controller).
• One port connects to the IP network of the user.
• One port connects to a user-supplied management console PC.

Three of the four RJ-45 ports (which connect to the controllers and the IP
network) are configured as a bridge. The SVP can be addressed using the
default IP address 192.168.0.15.

In the unlikely event you cannot connect to the SVP using the default IP
address, use the following emergency login: http://<default SVP IP 
address>/dev/storage/<model number><system serial number>/
emergency.do. For example:

Storage system model number Storage system serial number URL

8320004 456789 http://192.168.0.15/dev/
storage/8320004456789/
emergency.do

8340004 456789 http://192.168.0.15/dev/
storage/8340004456789/
emergency.do
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Storage system model number Storage system serial number URL

8360004 456789 http://192.168.0.15/dev/
storage/8360004456789/
emergency.do

Users are responsible for adopting the appropriate security procedures with
the SVP, including:
• Applying Windows security patches.
• Turning on automatic Windows updates or using the manual Windows

update method.
• Installing antivirus software that has been tested and approved by Hitachi.

SVP front panel
The front panel of the physical SVP is equipped with LEDs, a reset button,
and a power button.
 

 

Number Description

1 LEDs. From left to right, the LEDs are:
• BMC Heartbeat
• LAN card 2
• LAN card 1
• Hard drive
• System standby power

2 Reset button.

3 Power button. Applies power to or removes
power from the SVP.

SVP rear panel
The only ports used on the rear panel of the physical SVP are the power
socket and the four LAN ports.
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1 Power socket. Attach the power cable supplied
with the SVP.

2 Four LAN ports arranged as follows:

LAN3 LAN4

LAN1 LAN2

These ports connect to your IP network, the
management console PC, and the user LAN port
on each storage system controller.

Note: After the Initial Startup Wizard is run, the SVP can be used in non-
bridge mode. In this mode, the cables can be removed from SVP ports LAN3
and LAN4 and attached to switches. For more information, contact customer
support.
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3
Replacing storage system components

The following describes the preparation tasks taken before replacing a
component and how to check the system status after replacing its
components.

□ Electrostatic discharge precautions

□ Unpacking replacement components

□ Follow appropriate power on and power off work procedures

□ Safety considerations

□ Guidelines for replacing a component

□ Guidelines to follow after replacing a component

□ Using the maintenance utility

□ Replacement parts

□ Attaching and removing the front panel bezel

□ Removing cables

□ Logging on to NAS Manager

□ EVS migration before servicing nodes

□ EVS migration after servicing nodes

□ Checking recovery after replacing components
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Electrostatic discharge precautions
Static electricity can damage the storage system’s static-sensitive
components.

When performing the service procedures in this document, observe the
following electrostatic discharge (ESD) precautions:
• Wear an antistatic wrist strap at all times when handling any field

replaceable unit (FRU). Clip the end of the wrist strap to the metal frame
of the storage system enclosure. For convenience, a wrist strap is supplied
with the storage system. Do not remove the wrist strap until you have
completed the removal or replacement.

• Before handling any FRU, discharge any static electricity by touching a
grounded surface. Grounded surfaces include static-dissipating mats
(already grounded) or grounded workstations.

• Remove all plastic, vinyl, and foam material from the work area.
• Do not remove a FRU from its antistatic protective bag until you are ready

to install it.
• Handle any card FRU only by its edges and avoid touching the components

or circuitry.
• Do not slide a FRU over any surface.
• Limit body movement (which builds up static electricity) during the

removal and replacement of a FRU.
• To avoid electric shock when performing a hot replacement of a part, do

not wear metallic accessories or a watch and avoid touching live parts of
the storage system with a screwdriver or similar tools.

Unpacking replacement components
Unpack replacement components in a dry location that is not exposed to
moisture, direct sunlight, dust, and temperature extremes. If the part to be
added has been exposed to high or low temperature during transport, the
part might not operate properly.

Follow appropriate power on and power off work
procedures

If a replacement procedure requires power off and power on steps, follow the
steps carefully to ensure the security of data.

After powering off the storage system, remove the power cables from the two
power supply units on the storage system.
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Safety considerations
Observe the following guidelines to ensure safety when replacing parts.
Failure to follow these guidelines could result in bodily injury or damage to
the chassis or components.

• Use the host to back up user data on the storage system before replacing
components.

• When performing any installation, comply with all local health and safety
requirements.

• Wear protective footwear when moving storage system hardware.
• Do not wear loose clothing that could get caught in the chassis or

mounting hardware. Fasten ties and scarves and roll up sleeves.
• Wear safety glasses when working under conditions that are hazardous to

your eyes.
• Keep walkways clear of tools, cables, and parts to prevent them from

being stepped on or causing people to trip and fall.
• Do not work on the equipment or disconnect cables during a

thunderstorm, when wearing a wool sweater or other heavy wool clothing,
or when power is applied.

• Always turn off the storage system and unplug all data and power cables
before lifting the storage system.

• Keep floors dry to prevent slips and falls.
• Do not use ungrounded power cables.
• Use only the power cables supplied with this product. Do not use power

cables from other products. Otherwise, unexpected failures or accidents
can occur.

• If you encounter unusual odors, heat generation, or smoke emission, shut
off power to the equipment and inform the appropriate personnel Leaving
such conditions unattended can cause electric shock or fire.

• Keep the area clean and dust-free when replacing components.
• Do not block or cover the openings of the storage system hardware. Never

place a unit near a radiator or heat register. Failure to follow these
guidelines can cause overheating and affect the unit’s reliability.

• After a component is replaced, secure the chassis cover to the storage
system. Cooling air flow can effectively within the chassis. An open chassis
allows air leaks that might interrupt and redirect the flow of cooling air
from internal components.

• Do not make mechanical or electrical modifications or repairs to the
equipment. Such actions can cause an electric shock or cause the storage
system to malfunction. Hitachi is not responsible for regulatory compliance
of a modified Hitachi product.

• When removing cables, hold the cable connector and leave enough slack in
the cables, so they do not bend to a diameter of less than 76 mm (3") or a
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radius less than 38 mm (1.5") when extended and do not become pinched
when retracted.

Guidelines for replacing a component
Observe the following guidelines when replacing a component.

• Use only the replacement parts specified in this guide.
• Do not perform maintenance when the storage system is being started,

Wait for the READY LED on the controller to go on before performing
maintenance.

• If you replace a drive, controller, cache memory, front end module, backup
module, back end module, ENC, fan, or power supply unit while the
storage system is turned on:
○ Wait at least 20 seconds after the failed part was removed before

installing the new part.
○ Complete the replacement within 10 minutes. Otherwise, the system

might turn off due to an abnormal rise in temperature.

If a power supply unit and another component fail at the same time,
replace the power supply unit first, and then replace the other failed
component. Otherwise, the system might turn off due to an abnormal rise
in temperature.

• If a fan on the controller fails at the same time when another component
fails, replace the fan first, and then replace the other failed component.
Otherwise, the system might turn off due to an abnormal rise in
temperature.

• Insert replacement parts quickly. Otherwise, the recovery might fail.
• If only the power main switch is off, the power is provided by the basic

supply. Do not leave components removed from the storage system for
long periods of time because this can trigger a power supply alarm.

• If the replacement part has a cover over one or more connectors, replace
the cover of the connector part that is going to be used.

Guidelines to follow after replacing a component
Observe the following guidelines after replacing a component in the Hitachi
storage system.
• When restarting the storage system, wait for the amber POWER LED to go

ON, and then turn off the main switch. Wait at least one minute before
turning on the main switch.

• After you replace components, close all the external storage system
covers.
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Using the maintenance utility
To configure the storage system using the maintenance utility, start the
maintenance utility from Hitachi Device Manager - Storage Navigator.

Note:
• When adding cache memory or replacing controllers (Type Change) on the

VSP G200 model, specify the controller boards for adding cache memory
or replacement (Type Change), and then start Maintenance Utility.

• Click  in the window to see the help menu for the description of the
Maintenance Utility.

• To display the help, the settings for enlarging and reducing the display
might not be reflected in the help window, depending on the type or
version of your browser.

 

 

Starting from Hitachi Command Suite

Procedure

1. Start Hitachi Command Suite.
2. In the Hitachi Command Suite main window, click the Resources tab,

and then click Storage Systems from the tree view.
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3. Expand the tree, and then right-click a storage system and click Other
Functions.

4. In Hitachi Device Manager - Storage Navigator, click the Maintenance
Utility menu, and then click Hardware to start the maintenance utility.
 

 

Starting from Hitachi Device Manager - Storage Navigator

Procedure

1. Launch a web browser from the console PC connected to the SVP, and
then start Device Manager - Storage Navigator.

2. Enter the following URL in the address field of your browser, and then
press Enter: http://[IP address of SVP]/module/sn2/0/index.do

3. In the Storage Device List window, click the picture of the registered
storage system.

4. Log in to Device Manager - Storage Navigator.
5. On the Maintenance Utility menu, click Hardware.
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6. Select the menu for the part that needs to be replaced (see the following

table).

Menu Replace part

Controller board (CTL) replacement for CTL1 • Controller 1.

• LAN blade installed on controller 1 (VSP
G400, G600 or VSP F400, F600).

Controller board (CTL) replacement for CTL1 • Controller 1.

• LAN blade installed on controller 1 (VSP
G800 or VSP F800).

Controller board (CTL) replacement for CTL1 Replacing (Type Change) Controller board 1 of
VSP G200.

Cache Memory replacement/installation for

CTL1

Cache memory installed on controller 1.

FAN replacement for CTL1 Fan installed in controller 1 (VSP G200).

Controller board (CTL) replacement for CTL2 • Controller 2.

• LAN blade installed on controller 2 (VSP
G400, G600 or VSP F400, F600).

Controller board (CTL) replacement for CTL2 • Controller 2.

• LAN blade installed on controller 2 (VSP
G800 or VSP F800).

Controller board (CTL) replacement for CTL2 Replacing (Type Change) Controller board 2 of
VSP G200.
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Cache Memory replacement/installation for

CTL2

Cache memory installed on controller 2.

FAN replacement for CTL2 Fan installed in controller 2 (VSP G200).

Other hardware maintenance Component other than a controller, fan, and

LAN blade.

Replacement parts
The storage system is equipped with removable and replaceable components.
Each component is assigned with a specific model or part number.

The table provides a list of available replaceable parts for the storage system.

Part name Part number Part model

Status of host and storage
system

I/O from the
host

No I/O from
the host

200 GB, MLC, 12-Gbps, 2.5-
inch flash drive

5559263-A DKC-
F810I-200MEM

Yes Yes

300 GB, 15 kmin-1, 6 Gbps,
SAS, SFF (contains BNST)

5552785-A DKC-
F810I-300KCM

Yes Yes

300 GB, 15 kmin-1, 6 Gbps,
SAS, SFF

5552785-P DKC-
F810I-300KCMC

Yes Yes

400 GB, MLC, 12 Gbps, SFF,
flash drive

5559016-A DKC-
F810I-400MEM

Yes Yes

400 GB, MLC, 12 Gbps, LFF,
flash drive

5559086-A DKC-
F810I-400M8M

Yes Yes

600 GB, 10 kmin-1, 6 Gbps,
SAS, SFF (contains BNST)

5552786-A DKC-
F810I-600JCM

Yes Yes

600 GB, 10 kmin-1, 6 Gbps,
SAS, SFF

5552786-P DKC-
F810I-600JCMC

Yes Yes

600 GB, 15 kmin-1, 12 Gbps,
SAS, SFF

5559498-A DKC-
F810I-600KGM

Yes Yes

1.2 TB, 10 kmin-1, 6 Gbps,
SAS, SFF (contains BNST)

5552789-A DKC-
F810I-1R2JCM

Yes Yes

1.2 TB, 10 kmin-1, 6 Gbps,
SAS, SFF

5552789-P DKC-
F810I-1R2JCMC

Yes Yes

1.2 TB 10 kmin-1, 6 Gbps,
SAS, LFF

5559119-P DKC-
F810I-1R2J7MC

Yes Yes

1.6 TB, MLC, 6 Gbps, SFF,
flash drive

3286549-A DKC-
F710I-1R6FM

Yes Yes

1.6 TB, MLC, 6 Gbps, SFF,
flash drive

3286550-A DKC-
F710I-3R2FM

Yes Yes
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Part name Part number Part model

Status of host and storage
system

I/O from the
host

No I/O from
the host

1.8 TB, 10 kmin-1, 6 Gbps,
SAS, SFF

5560490-A DKC-
F810I-1R8JGM

Yes Yes

1.8 TB 10 kmin-1, 6 Gbps,
SAS, LFF

5560694-A DKC-
F810I-1R8J8M

Yes Yes

1.92 TB, MLC, 12 Gbps, SAS,
SFF, flash drive

5562403-A DKC-
F810I-1R9MEM

Yes Yes

1.92 TB, MLC, 12 Gbps, SAS,
SFF, flash drive

5562403-B DKC-
F810I-1R9MGM

Yes Yes

4 TB, 7200min-1, 6 Gbps,
SAS 7.2K, LFF (contains
BNST)

5552784-A DKC-
F810I-4R0H3M

Yes Yes

4 TB 7200min-1, 6 Gbps,
SAS, LFF

5559015-P DKC-
F810I-4R0H4MC

Yes Yes

4 TB, 7200min-1, 6 Gbps,
SAS 7.2K, LFF

5552784-P DKC-
F810I-4R0H3MC

Yes Yes

6 TB, 7200min-1, 12 Gbps,
SAS 7.2K, LFF

5560075-A DKC-
F810I-6R0H9M

Yes Yes

6 TB, 7200min-1, 12 Gbps,
SAS 7.2K, LFF

5560116-A DKC-
F810I-6R0HLM

Yes Yes

10 TB, 7.2K rpm, LFF, Disk
Drive

5562395-A DKC-
F810I-10RH9M

Yes Yes

10 TB, 7.2K rpm, LFF, Disk
Drive for DB60

5562396-A DKC-
F810I-10RHLM

Yes Yes

1.75 TB, 12 Gbps, LFF, flash
module drive DC2

3286696-A DKC-
F810I-1R6FN

Yes Yes

3.5 TB, 12 Gbps, LFF, flash
module drive DC2

3286697-A DKC-
F810I-3R2FN

Yes Yes

7 TB, 12 Gbps, LFF, flash
module drive DC2

3286698-A DKC-
F810I-6R4FN

Yes Yes

7 TB, MLC, 12 Gbps, SAS,
flash module drive

3286734-A DKC-
F810I-7R0FP

Yes Yes

14 TB, MLC, 12 Gbps, SAS,
flash module drive

3286735-A DKC-
F810I-14RFP

Yes Yes

Battery (VSP G400, G600, G800 or VSP F400, F600, F800)

CBLM 3289081-A DW-F800-BAT Yes Yes

CBLH 3289081-A DW-F800-BAT Yes Yes

Fan

CBSS and CBSL 3290738-A N/A Yes Yes
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Part name Part number Part model

Status of host and storage
system

I/O from the
host

No I/O from
the host

Yes

CBSS and CBSL 3290737-A N/A Yes Yes

CBLM 3289056-A N/A Yes Yes

CBLH 3289056-A N/A Yes Yes

CHBBPS (host port expansion
chassis)

3290737-A N/A Yes Yes

DW-F800-DBS and DW-F800-
DBL (contains BNST)

3290647-A N/A Yes Yes

DW-F800-DBSC and DW-
F800-DBLC
These units can be added to
VSP G400, G600, G800 or
VSP F400, F600, F800
storage systems.

3290647-P N/A N/A N/A

FMD drive tray 3286659-A N/A Yes Yes

Controller

CBSS and CBSL 3290733-A DW-F800-CTLS Yes Yes

CBSS and CBSL encryption 3290733-B DW-F800-CTLSE Yes Yes

CBLM 3289039-A DW-F800-CTLM Yes Yes

CBLH 3289038-A DW-F800-CTLH Yes Yes

Cache memory

8 GB 3290718-A DKC-F810I-
CM8G

Yes Yes

16 GB 5552764-A DKC-F810I-
CM16G

Yes Yes

32 GB 5552765-A DKC-F810I-
CM32G

Yes Yes

Front end modules

10-Gbps SFP iSCSI optical 3289048-A DW-
F800-2HS10S

Yes Yes

10-Gbps iSCSI copper 3289049-A DW-
F800-2HS10B

Yes Yes

8-Gbps Fibre Channel 3289046-A DW-F800-4HF8 Yes Yes

16-Gbps Fibre Channel (2-
port)

3289047-A DW-F800-2HF16 Yes Yes

32-Gbps Fibre Channel (4-
port)

3292131-A DW-
F800-4HF32R

Yes Yes

PCIe module 3289195-A DW-F800-1HP8 Yes Yes
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Part name Part number Part model

Status of host and storage
system

I/O from the
host

No I/O from
the host

Small Form Factor Pluggable

Optical module (8-Gbps
longwave)

5556750-A DKC-F810I-1PL8 Yes Yes

Optical module (8-Gbps
shortwave)

5557409-A DKC-
F810I-1PS8

Yes Yes

Optical module (10-Gbps
shortwave)

5559354-A N/A Yes Yes

Optical module (16-Gbps
longwave)

5552782-A DKC-
F810I-1PL16

Yes Yes

Optical module (16-Gbps
shortwave)

5552781-A DKC-
F810I-1PS16

Yes Yes

Optical module (32-Gbps
shortwave)

5562178-A DKC-
F810I-1PS32

Yes Yes

Back end module (DKB)

CBLM 3289045-A DW-F800-
BS12G

Yes Yes

CBLM (Encryption)1 3289094-A DW-F800-
BS12GE

Yes Yes

CBLH 3289045-A DW-F800-
BS12G

Yes Yes

CBLH (Encryption)1 3289094-A DW-F800-
BS12GE

Yes Yes

Note:

1. Achieved FIPS 140-2 certification.

ENC

SFF and LFF drive trays 3290646-A N/A Yes Yes

FMD drive tray 3286658-A N/A Yes Yes

SAS cables

1 m SAS cable including two
omega clips

3290630-A DW-F800-SCQ1 Yes Yes

1.5 m SAS cable including
two omega clips

3290631-A DW-F800-
SCQ1F

Yes Yes

3 m SAS cable including two
omega clips

3290632-A DW-F800-SCQ3 Yes Yes

5 m SAS cable including two
omega clips

3290633-A DW-F800-SCQ5 Yes Yes

10 m SAS optical cable 3290666-A DW-F800-
SCQ10A

Yes Yes
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Part name Part number Part model

Status of host and storage
system

I/O from the
host

No I/O from
the host

30 m SAS optical cable 3290667-A DW-F800-
SCQ30A

Yes Yes

100 m SAS optical cable 3290723-A DW-F800-
SCQ1HA

Yes Yes

PCIe cable 3290994-A DW-F800-PC1F Yes Yes

Cache flash memory (CFM)

CFM 3290736-A DW-F800-BM10 Yes Yes

CFM 3289043-A DW-F800-BM20 Yes Yes

CFM 3289043-B DW-F800-BM30 Yes Yes

LAN blade

LAN board 3289044-A N/A Yes Yes

LAN board 3289044-A N/A Yes Yes

Backup module (BKM)

CBSS and CBSL 3290735-A N/A Yes Yes

CBLM 3289036-A N/A Yes Yes

CBLH 3289036-A N/A Yes Yes

PCIe cable connector 5560935-A DW-F800-PC1F Yes Yes

PCIe switch board 5560933-A DW-F800-1HP8 Yes Yes

Host port expansion
chassis fan

5560934-A DW-F800-CHBB N/A N/A

NAS module

NAS module (HNAS) 3289196-A DW-F800-NAS Yes Yes

Cache Memory for NAS
module (RND1)

3289198-A N/A Yes Yes

Small Form-Factor (SFP+) for
NAS module (RSFP)

5559354-A DW-F800-1PS10 Yes Yes

Service processor 3919435.P N/A Yes Yes

Attaching and removing the front panel bezel
The controller and drive tray contains a front bezel ready to install. In
addition, the controller and drive tray accessory kits also provide keys for
locking and unlocking the respective front bezels.

Attaching the front bezel to the SVP
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Procedure

1. Use the provided key to unlock the front bezel.
2. Hold the key and bottom of the bezel with both hands while facing the

front bezel.
3. Insert the tabs on the left-front side of the SVP into the tab holes on the

front bezel.
4. Push the right side of the bezel to engage it with the ball catch on the

front of the SVP to secure the bezel.
5. Use the provided key to lock the front bezel. To avoid damaging the key,

verify the key is fully inserted into the lock before turning it.

 

 

Removing the front bezel from the SVP

Procedure

1. Use the provided key to unlock the bezel.
2. Holding the lower right part of the bezel, gently pull the key toward you

and disengage the right side of the bezel from the ball catch
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3. Holding the lower right part of the bezel, gently pull the key toward you
and disengage the right side of the bezel from the ball catch.

Note: To prevent any damages to the bezel, do not open the bezel
more than 45 degrees when disengaging the front bezel.

4. Disengage the front bezel from the left tabs and then remove the bezel.

Attaching the front bezel to a CBSS or CBSLAttaching the front bezel
to an FMDAttaching a front bezel to an SFF, LFF, or FMD

Procedure

1. Use the provided key to unlock the front bezel.
2. Insert the tabs on the left-front side of the storage system into the tab

holes on the front bezel.
3. Use the provided key to lock the front bezel.

Note: To avoid damaging the key, verify the key is fully inserted
into the lock before turning it.

4. Remove the key from the lock.

Note: To avoid damaging the lock, align the groove of the key with
the positioning mark on the lock before removing the key.

 

 

Removing the front bezel from a DBS or DBL drive tray

Procedure

1. Use the provided key to unlock the bezel.
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2. Holding the lower right part of the bezel, gently pull the key toward you
and disengage the right side of the bezel from the ball catch.

Note: To avoid damaging the bezel, do not open the bezel more
than 45 degrees when disengaging the front bezel.

 

 
3. Disengage the front bezel from the left tabs, and then remove the bezel.

Removing the front bezel from a CBLM CBLH controller

Procedure

1. Use the provided key to unlock the bezel.
2. Holding the lower right part of the bezel, gently pull the key toward you

and disengage the right side of the bezel from the ball catch.

Note: To avoid damaging the bezel, do not open the bezel more
than 45 degrees when disengaging the front bezel.
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3. Disengage the front bezel from the left tabs, and then remove the bezel.

Attaching the front bezel to a CBLM CBLH controller

Procedure

1. Use the provided key to unlock the front bezel.
2. Insert the tabs on the left-front side of the storage system into the tab

holes on the front bezel.
3. Push the right side of the bezel until it engages with the ball catch on the

front of the storage system to secure the bezel.
4. Use the provided key to lock the front bezel.

Note: To avoid damaging the key, verify the key is fully inserted
into the lock before turning it.

5. Remove the key from the lock.

Note: To avoid damaging the lock, align the groove of the key with
the positioning mark on the lock before removing the key.
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Attaching the front bezel to a dense intermix drive tray

Procedure

1. Use the provided key to unlock the front bezel.
2. Insert the tabs on the left-front side of the storage system into the tab

holes on the front bezel.
3. Push the right side of the bezel until it engages with the ball catch on the

front of the storage system to secure the bezel.
4. Use the provided key to lock the front bezel.

Note: To avoid damaging the key, verify the key is fully inserted
into the lock before turning it.

5. Remove the key from the lock.

Note: To avoid damaging the lock, align the groove of the key with
the positioning mark on the lock before removing the key.
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Removing the front bezel from a dense intermix drive tray
To prevent the rack from tipping when removing a dense intermix drive tray:
• Do not remove multiple dense intermix drive trays simultaneously.
• After removing the dense intermix drive tray, do not place objects on it or

use it as a work space.

Procedure

1. Use the provided key to unlock the bezel.
2. Holding the lower right part of the bezel, gently pull the key toward you

and disengage the right side of the bezel from the ball catch.

Note: To avoid damaging the bezel, do not open the bezel more
than 45 degrees when disengaging the front bezel.

 

 
3. Disengage the front bezel from the left tabs, and then remove the bezel.

Removing cables
Observe the following instructions when removing cables form the storage
system.
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To remove a SAS cable, pull the tab of the SAS cable (1) to release the latch
and remove the SAS cable (2).

 

 

To remove an optical cable, push the top of the connector of the optical cable
(1) to release the latch and remove the SAS cable (2).

 

 

To remove a LAN cable, push the top of the LAN cable connector (1) to
release the latch and remove the LAN cable (2).

 

 

To remove a PCIe cable, pull the tab of the PCIe cable (1) to release the latch
and remove the PCIe cable (2).
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Logging on to NAS Manager
The following procedures describe how to log on to NAS Manager.

Procedure

1. Open a web browser.
2. Type https://<unified-management-IP-address>:20443 and press

Enter.

Note: Enter the IP address of controller 1.

3. Click  NAS Manager.

Tip: If you select the Open the window you choose this time
at the next access check box,, any subsequent login connections
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open to the previous window session. This behavior persists until
you clear the browser cache.

4. Enter your login credentials:
a. In the User ID field, type maintenance.
b. In the Password field, enter the password configured during the

initial set up of the storage system.
5. Click Login.
6. In the Home window, click the NAS cluster from the Server Status

Console drop down list.
 

 
7. To log off, click Sign Out in the application pane of the NAS Manager

window, and then close the web browser. If the NAS Manager session
does not end, close the web browser.

EVS migration before servicing nodes

Procedure

1. Log on to NAS Manager.
2. In the Home window, click Cluster Configuration.
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3. In the Cluster Configuration window, use the Name column to identify

the name of the node to be serviced, and then record the names of the
nodes. Nodes that require servicing have a status other than OK in the
Health column.

4. Click Server Settings.
 

 
5. In the Server Settings window, click EVS Management.
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6. Record the EVS that is operated in the node to be maintained:

a. In the EVS Management window, find the EVS confirmed in step 3 is
displaying in the Cluster Node column.

b. In the Label column, record the EVS name shown . For multiple
instances of the EVS, record all EVS names.

7. In the EVS Management window, click EVS Migration.
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8. Migrate all the EVS instances in the node that are to be serviced back to

the normal node.

Note: The EVS has no impact on client users of Microsoft Windows
NFS. File access for CIFS client users, however, ends and must be
restarted.

9. Perform the following steps in the EVS Migration window:
a. Click the Migrate all EVS from cluster node button.
b. Using the from cluster node list, select the node to be serviced. This

is the same node you confirmed in step 6.
c. Using the to cluster node list, select a normal node.
d. Click migrate to migrate the EVS.

10. At the confirmation message, confirm that the operations in step 9 are
correct, and then click OK.
When the migration completes, the message Successfully migrated
all EVS appears.

11. In the EVS Migration window, click EVS Management and return to
the EVS Management window.
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12. Confirm the EVS migrated from the node to be serviced to the normal

node. Confirm the node names in the destination directory for all
instances of the EVS recorded in step 6 appear in the Cluster Node
column.
 

 
13. Log out of NAS Manager.
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Related tasks

• Logging on to NAS Manager on page 96

EVS migration after servicing nodes

Procedure

1. Log on to NAS Manager.
2. In the Home window, click Server Settings.

 

 
3. In the Server Settings window, click EVS Migration.
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4. Perform the following steps in the EVS Migration window:

a. Click the Migrate EVS _ to cluster node _ button.
b. From the EVS list, select the EVS to be migrated. This destination

node is the same as specified in step 6 of the EVS migration before
servicing procedure.

c. From the to cluster node list, select the serviced node.
d. Click migrate to migrate EVS.
e. Repeat these steps for all the EVSes recorded in step 6 of the EVS

migration before servicing procedure.
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5. When the confirmation message appears, confirm that the operations in

step 4 are correct, and then click OK.
6. In the Home window, click EVS Management.

 

 
7. In the EVS Management window, confirm that the node names in the

destination directory for all instances of the EVS recorded in step 6 of the
EVS migration before servicing procedure appear in the Cluster Node
column.
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8. Log out of NAS Manager.

Related tasks

• Logging on to NAS Manager on page 96
• EVS migration before servicing nodes on page 97

Checking recovery after replacing components
After you replace one or more components, check to verify that the storage
system has recovered.

Procedure

1. In the Maintenance Utility window, click Refresh.
2. Confirm that the status of the replaced components is Normal or Ready.
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4
Replacing a drive

Before replacing a drive, read the precautions and understand the procedure
for your drive type.

□ Checking a drive

□ Blocking the drive

□ Replacing a drive for a CBSS or SFF drive tray

□ Replacing a drive for a CBSL or LFF drive tray

□ Replacing a drive for a flash module drive tray

□ Adding a drive to a dense intermix drive tray

□ Checking the drive status
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Checking a drive

Procedure

1. Start the maintenance utility.
2. Click Hardware > Controller Chassis Hardware > Drive Box.
3. Click the Drives tab.
4. Confirm that the status of the drive to be replaced is Warning, Failed,

Blocked, Copy incomplete, or Reserved.
5. Click Refresh.

 

 
6. Remove the front bezel and check whether the red ALM LED on the failed

drive is on or off:
• If the LED is on, replace the drive.
• If the LED is off, proceed to Blocking the drive on page 109.

Note: If the ALM LED is ON but the drive status is neither Blocked
nor Failed, go to the HDS Support Portal at https://
support.hds.com/en_us/contact-us.html.

108 Replacing a drive
Service Guide for VSP Gx00 and VSP Fx00 Models

https://support.hds.com/en_us/contact-us.html
https://support.hds.com/en_us/contact-us.html


Blocking the drive
If the red ALM LED on a failed drive is off, use the following procedure to
identify and block the failed drive before replacing it.

Before you begin
• Confirm that the storage system power is turned on.
• Use the Dump tool to collect the storage system configuration information.

Procedure

1. In the Drives tab of the maintenance utility, check that the blocked drive
is identified properly.
 

 
2. Click Block.
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3. If the following warning appears, click Yes.

 

 
4. Check that the drive status is Blocked or Failed in the Controller

Chassis Drive Box window. If the drive status is Copying, wait until it
changes to Blocked or Failed.

5. When the following window opens, click Close.
 

110 Replacing a drive
Service Guide for VSP Gx00 and VSP Fx00 Models



 
6. If you receive a message about the encryption environment setting is

applied, click Close, and then back up the encryption key after
completing the drive-replacement procedure.
 

 
7. In the Controller Chassis Drive Box window, check that the drive

status is Blocked. If the drive status is Copying, wait for it to change to
Blocked.

Replacing a drive for a CBSS or SFF drive tray
The drive numbering in a chassis is #0 to #23, from left to right.
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Before you begin

• Wear a wrist strap connected to the storage system to prevent part
failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Confirm that the storage system power is turned on.
• The front bezel is removed.

 

 

Procedure

1. Pull up the stopper of the drive handle toward you to release the lock.
2. Open the handle toward you, and then gently remove the drive to be

replaced.
Handle the drive with care.

3. Wait at least 30 seconds. Then place the new drive into the guide rail and
slide it gently in the direction of the arrow.

4. Push the lower part of the drive until it reaches the position where the
hook on the handle engages with the square hole on the frame.

5. Raise the stopper, which is tilted toward you, and then press the stopper
to disengage the lock.
If the handle is raised so the hook of the handle cannot enter into each
hole, the drive cannot be installed properly because it is blocked by the
frame of the storage system.
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6. Pull the drive handle gently to make sure the drive is installed securely

and cannot be pulled out.
7. Confirm that the red ALM LED is off at the new drive.
1. Note: If the ALM LED is ON but the drive status is neither Blocked

nor Failed, contact the HDS Support Portal at https://
support.hds.com/en_us/contact-us.html.

8. In the maintenance utility, click Hardware > Controller Chassis
Hardware > Drive Box.

9. Click the Drives tab.
10. Confirm that the status of the drive to be replaced is Normal.

If necessary, click Refresh to update the status in the window.
11. Attach the front bezel.

Replacing a drive for a CBSL or LFF drive tray
The drive numbering in the chassis is #0 to #11, from the bottom left to the
top right.

Before you begin

• Wear a wrist strap connected to the storage system to prevent part
failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Confirm that the storage system power is turned on.
• The front bezel is removed.
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Procedure

1. Pull up the stopper of the drive handle toward you to release the lock.
2. Open the handle toward you, and then gently remove the drive to be

replaced.
Handle the drive with care.

3. Wait at least 30 seconds. Then place the new drive into the guide rail and
slide it gently in the direction of the arrow.

4. Push the lower part of the drive until it reaches the position where the
hook on the handle engages with the square hole on the frame.

5. Pull the stopper lightly, close the handle, and then press the stopper to
engage the lock.
If the hook of the handle cannot enter the square hole, the drive cannot
be installed properly because it gets blocked by the frame of the storage
system.
 

 
6. Pull the drive handle gently to make sure the drive is installed securely

and cannot be pulled out.
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Note: If the ALM LED is ON but the drive status is neither Blocked
nor Failed, contact the HDS Support Portal at https://
support.hds.com/en_us/contact-us.html.

7. In the maintenance utility, click Hardware > Controller Chassis
Hardware > Drive Box.

8. Click the Drives tab.
9. Confirm that the status of the drive to be replaced is Normal.

If necessary, click Refresh to update the status in the window.
10. Confirm that the red ALM LED is off at the new drive.
11. Attach the front bezel.

Replacing a drive for a flash module drive tray
The drive numbering is #0 to #11, from the bottom left to the top right.

Before you begin

• Wear a wrist strap connected to the storage system to prevent part
failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Confirm that the storage system power is turned on.
• The front bezel is removed.

 

 

Note: Servicing flash module drives is strictly limited to Hitachi and certified
partners. The flash module drive tray accepts DKC-F810I-1R6FN, DKC-
F810I-3R2FN, DKC-F810I-6R4FN, DKC-F810I-7R0FP or DKC-F810I-14RFP
drives only. HDDs cannot be installed in a flash module drive tray. You cannot
install small form factor drive trays, large form factor drive trays, and dense
intermix drive trays on an all-flash array.
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Note: The top-rear area of the flash module drive is extremely hot when the
drive is removed from a working system. Avoid touching this hot area when
removing the drive.

Procedure

1. Pull up the stopper of the drive handle toward you to release the lock.
2. Open the handle toward you, and then gently remove the drive to be

replaced.
Handle the drive with care.

3. Wait at least 30 seconds. Then place the new drive into the guide rail and
slide it gently in the direction of the arrow.

4. Push the lower part of the drive until it reaches the position where the
hook on the handle engages with the square hole on the frame.

5. Pull the stopper lightly, close the handle, and then press the stopper to
engage the lock.
If the hook of the handle cannot enter the square hole, the drive cannot
be installed properly because it gets blocked by the frame of the storage
system.
 

 
6. Pull the drive handle gently to make sure the drive is installed securely

and cannot be pulled out.
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7. In the maintenance utility, click Hardware > Controller Chassis
Hardware > Drive Box.

8. Click the Drives tab.
9. Confirm that the status of the drive to be replaced is Normal.

If necessary, click Refresh to update the status in the window.
10. Confirm that the red ALM LED is off at the new drive.
11. Attach the front bezel.

Adding a drive to a dense intermix drive tray
The numbering of the drive slots in the dense intermix drive tray begins with
0 to 59 and reads from left to right.

When working on a dense intermix drive tray:
• Be mindful of other workers nearby.
• Exercise care when removing or storing the dense intermix drive tray.
• Do not remove multiple dense intermix drive trays all at once because the

rack can fall over.
• Do not put any objects on the removed dense intermix drive tray.
• Do not use the dense intermix drive tray as a work space because the rack

can fall over.

• Remove the dense intermix drive tray from the rack and remove the top
cover.

• Use only DKC-F810I-1R6FN, DKC-F810I-3R2FN, and DKC-F810I-6R4FN
drives when installing flash module drives.

Before you begin

• Wear a wrist strap connected to the storage system to prevent part
failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Confirm that the storage system power is turned on.

Procedure

1. Pull up the stopper of the drive handle toward you to release the lock.
2. Open the handle toward you, and then gently remove the drive to be

replaced.
Handle the drive with care.

3. Wait at least 30 seconds. Then place the new drive into the guide rail and
slide it gently in the direction of the arrow.

4. Push the drive until it snaps into place.
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5. Pull the drive handle gently to make sure the drive is installed securely

and cannot be pulled out.
6. Attach the top cover of the dense intermix drive tray, and then return the

drive tray to the rack.

Checking the drive status
Procedure

1. In the maintenance utility, click Hardware > Controller Chassis
Hardware > Drive Box.

2. Click the Drives tab.
3. Confirm that the status of the replacement drive is Normal.
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Observe the following guidelines:
• If you replaced a drive without blocking it, click Refresh in the

Maintenance Utility window, and then check the status of the
replaced drive.

• When replacing a drive after saving data to a spare drive, the drive
status changes to Normal after performing the copy-back operation.
This operation can take up to 12 hours to perform, depending on the
configuration and drive capacity

• If the drive status is Copy incomplete, the correction-copy operation
cannot be performed because a copy-processing operation is being
performed in the parity group to which the target drive belongs. If you
are not sure about the restoration method or if the restoration fails,
contact the HDS Support Portal at https://support.hds.com/en_us/
contact-us.html.
Restoration method: After completing other copy operations, replace
the drive using the drive-replacement procedure. For the drive
replacement, reuse the drive that was removed instead of using a new
drive.

• If the drive status is Reserved, the copy-back operation cannot be
performed because more than one copy-processing operation is being
performed in the parity group to which the copy-back source drive of
the target drive belongs. If you are not sure about the restoration
method or if the restoration fails, contact the HDS Support Portal at 
https://support.hds.com/en_us/contact-us.html.
Restoration method: After completing other copy operations, replace
the drive using the drive-replacement procedure. For the drive
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replacement, reuse the drive that was removed instead of using a new
drive.

• If the copy-back operation is set to disabled, this operation will not be
performed.
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5
Replacing a battery

The VSP G400, G600, G800 or VSP F400, F600, F800 storage systems have
replaceable batteries. Before replacing a battery on these storage systems,
read the precautions and understand the procedure for your battery.

□ Checking the battery

□ Replacing the battery

□ Checking battery cable connections
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Checking the battery
Before you begin

• Confirm that the storage system power is turned on.
• Confirm that the red STATUS LED for the backup module containing the

battery to be replaced is blinking.

• The power supply is operating normally.
• You have readBattery replacement guidelines on page 311.
• You have read the precautions supplied by the battery manufacturer and

understand the procedure for your battery.

Procedure

1. Start the maintenance utility.
2. In the Maintenance Utility window, click Hardware > Controller

Chassis.
3. In the Controller Chassis window, click the BKMFs tab.
4. To display the most recent status of the battery, click Refresh.
5. Confirm that the status of the battery to be replaced is Warning.
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Replacing the battery
The blink pattern of the red STATUS LED indicates which battery needs
replacement.
• One blink:: Replace the standard battery.
• Two blinks:: Replace the optional battery.
• Three blinks:: Replace both the standard and optional batteries.

Before you begin

• Wear a wrist strap connected to the storage system to prevent part
failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Confirm that the storage system power is turned on.
• Confirm that the red STATUS LED for the backup module containing the

battery to be replaced is blinking.
• Use the maintenance utility to check the battery.

Procedure

1. Loosen the blue screw that secures the BKMF whose red STATUS LED is
blinking.

2. Open the lever to pull out and remove the BKMF with both hands.
3. Find the BKMF whose red STATUS LED is blinking, and then loosen the

blue screw that secures that BKMF.
4. Slide the top panel of the BKMF and remove it.
5. Hold the latch of the cable connector of the battery to be replaced and

remove the connector from the socket.
6. Remove the battery to be replaced.
7. Install a new battery in the BKMF and route cables along the groove of

the BKMF.
If replacing one battery, install the replacement battery at the front (fan)
side of the system. The battery clicks into place when installed securely
in the slot. Route cables with minimum bending.

8. Connect the cable connector to the socket. You will hear a click when the
connection is secure.

9. Replace the BKMF top panel by sliding it and then attaching it.
10. Tighten the blue screw on the rear side of the BKMF.
11. With the lever of the BKMF opened, hold the BKMF with both hands and

insert it straight into the slot.
12. Close the lever of the BKMF, and tighten the blue screw.
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13. Check that the green STATUS LED on the BKMF is blinking.
14. In the Maintenance Utility window, click Hardware > Controller

Chassis.
15. Click the BKMF tab.
16. Confirm that the status of the replacement battery is Normal.
17. Log out and close the Maintenance Utility window.

Checking battery cable connections

Procedure

1. In the Alert Detail window of the maintenance utility, click Close.
2. In the maintenance utility, clickController Chassis in the left pane, and

then click the BKMF tab.
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CBLM/CBLH BKMF modules
 

 
DBF power supply unit locations
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Note: Check the target battery only. Do not touch other batteries.

3. Remove the front bezel.
4. Remove the BKMF in which the target battery is installed:

a. Check that the red STATUS LED on the BKMF is blinking.
b. Loosen the blue screw securing the BKMF on which the red STATUS

LED is blinking.
c. Close the lever and pull out the BKMF to remove it.

 

 
5. Check the connection of the battery cables:

a. Loosen the blue screw on the back of the BKMF.
b. Slide the top panel of the BKMF to remove the panel
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.

c. Check the connection of the target battery cables and connect the
connectors to the sockets securely.
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d. Slide the top panel of the BKMF to install it.
e. Tighten the blue screw on the back of the BKMF to secure the BKMF.

6. Install the BKMF:
a. Keep the BKMF lever open and insert the BKMF into the slot.
b. Close the BKMF lever and tighten the blue screw to secure the BKMF.

7. Attach the front bezel.
8. Log out of maintenance utility to close the window.
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6
Replacing a fan

Before replacing a fan, read the precautions and understand the procedure
for your fan.

□ Checking a fan

□ Blocking the controller

□ Replacing a fan

□ Restoring a fan

□ Replacing a fan on a host port expansion chassis
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Checking a fan

Before you begin

• Confirm that the storage system power is turned on.

Procedure

1. Start the maintenance utility.
2. In the Maintenance Utility window, click Hardware > Controller

Chassis.
3. In the Controller Chassis window, click the CTLs tab.
4. To display the most recent status of the fan, click Refresh.
5. Confirm that the status of the fan to be replaced is Warning.

 

 
6. Use the amber CTL WARN LED to identify the failed fan that needs to be

replaced:
• If the LED blinks 1 time, replace fan 0.
• If the LED blinks 2 times, replace fan 1.

7.
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Blocking the controller
Procedure

1. Click the Replace list, and then select the FAN-CTL to be replaced.
 

 
2. Check the controller that contains the fan to be replaced, and then click

Block.
3. When the Replace FANs window opens, verify that the fan shown in the

window is the one to be replaced, and then click Block.
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4. If the following window opens, click OK.
5.  

 
Check that the controller is blocked and becomes ready for replacing.
Leave the Replace FANs window open, but do not click the Restore
button.
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Replacing a fan

Caution: Storage system fans rotate at high speed. Exercise extreme caution
to avoid getting anything caught in the fan and to prevent injury.

Caution: A short-circuit can cause a fire. Never insert metal or other objects
into the cable connector; otherwise, a short-circuit can occur.

Before you begin
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Confirm that a fan is installed in the controller.
• Confirm that the storage system power is turned on.
• Confirm that the amber CTL WARN LED is blinking one or two times rapidly

(one blink = replace fan 0, two blinks = replace fan 1).
• Use the maintenance utility to block the controller.

Note: Storage system fans rotate at high speed. Exercise extreme caution to
avoid getting anything caught in the fan and to prevent injury.
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Procedure

1. Remove all cables connected to the controller.
2. Loosen the blue screw that secures the controller, and then open the

lever.
3. Hold the controller with both hands, and then pull it gently and remove

it.
4. Loosen the blue screw that secures the fan.
5. Lift the fan and remove it from the connector.
6. Install the new fan into the connector of the controller.

 

 
7. Tighten the blue screw to secure the fan.
8. Check that the controller connector is in good condition (not deformed or

damaged).
9. With the right and left controller levers open completely, insert the

controller into the slot of the Controller.
10. Push the controller in all the way, and then close the right and left levers

completely.
11. Tighten the blue screw to secure the controller.
12. Connect all the cables that you removed from the controller.

Next steps
• Use the maintenance utility to restore (unblock) the controller.
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Restoring a fan
Procedure

1. In the Replace FANs window, click Restore.
A progress bar shows the replacement status.

Note: The restore operation can take up to 20 minutes to
complete. If a message states that the recovery failed, go to the
Customer Contact Us page at https://support.hds.com/en_us/
contact-us.html.

 

 
2. When the progress bar goes away and the completion message appears,

click Close.
3. Confirm that the amber CTL WARN LED is off at the fan.
4. In the BKMFs tab, click Refresh at the top-right of the window and

confirm that the fan status is Normal.
5. Log out and close the Maintenance Utility window.
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Replacing a fan on a host port expansion chassis

Blocking a fan on a host port expansion chassis

Before you begin
• Confirm that the storage system power is turned on.
• Use the Dump tool to collect the storage system configuration information.
• The red ALM LED is on at the fan to be replaced.

Procedure

1. Start the maintenance utility.
2. Click Hardware > Channel Board Box.
3. Click the FAN tab.
4. To display the most recent status of the fan click Refresh.
5. Check the status of the fan is Warning.

 

 

Replacing a fan on a host port expansion chassis

Procedure

1. Remove the front bezel.
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2. Loosen the blue screw that secure the fan, and then remove the fan.
3. Insert the new fan into the slot, and tighten the blue screw to secure the

fan.
 

 
4. Attach the front bezel.

Restoring a fan on a host port expansion chassis

Procedure

1. In the FAN tab, click Refresh to display the current fan status.
2. Confirm that the status of the replaced fan is Normal.
3. Log out and close the Maintenance Utility window.

Checking the screw on a host port expansion chassis fan
Using the following procedure, you can check whether the screw securing the
CHBB fan is loose or secure.

Procedure

1. In the Alert Detail window of the maintenance utility, click Close.
2. In the left pane, under Hardware, click Channel Board Box to check

the location of the host port expansion chassis fan (CHBB).
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3. Remove the front bezel.
4. If the blue screw of the fan you want to check is loose, push the fan all

the way in and tighten the screw.

Note: Work only with the fan whose screw connection you want to
check. Do not touch other fans.
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5. Attach the front bezel.
6. Log out and close the Maintenance Utility window.

Replacing a fan 139
Service Guide for VSP Gx00 and VSP Fx00 Models



140 Replacing a fan
Service Guide for VSP Gx00 and VSP Fx00 Models



7
Replacing a power supply

Before replacing a power supply, read the precautions and understand the
procedure for your power supply.

The Hitachi Virtual Storage Platform G200 offers a CBSS, CBSL, DBS, or DBL
equipped with AC power supplies, or a CBSSD, CBSLD, DBSD, and DBLD
equipped with DC power supplies. Except for their power supplies, these
storage systems are functionally equivalent.

□ Checking the power supply

□ Replacing a power supply for a CBSS or CBSL

□ Replacing a power supply for a CBLM or CBLH

□ Checking DKCPS power supply unit connections

□ Replacing a power supply for SFF and LFF drive trays

□ Replacing a power supply for a FMD drive tray

□ Checking DBPS power supply unit connections

□ Confirming the power supply unit status

□ Replacing a power supply for a host port expansion chassis

Replacing a power supply 141
Service Guide for VSP Gx00 and VSP Fx00 Models



Checking the power supply
Procedure

1. Start the maintenance utility.
2. Click Hardware > Controller Chassis, Hardware > Drive Box or

Hardware > Channel Board Box.
3. Click the PSs tab.
4. To display the most recent status of the power supply, click Refresh.
5. Confirm that the status of the power supply to be replaced is Warning.

 

 

Replacing a power supply for a CBSS or CBSL

Caution: Be sure to replace the faulty power supply. If you replace the
operational power supply, the system will go down.

Caution: A short-circuit can cause a fire. Never insert metal or other objects
into the cable connector; otherwise, a short-circuit can occur.

Note: Power supply unit #1 and power supply unit #2 are installed in
opposite directions.
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Before you begin
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Confirm that the storage system power is turned on.
• Confirm that the red ALM/RDY LED for the power supply to be replaced is

on.

Note: If the red ALM/RDY LED is on at both power supplies, do not perform
this procedure. Go to the Customer Contact Us page at https://
support.hds.com/en_us/contact-us.html.

Procedure

1. Disconnect the power cable from the power supply to be replaced.
Remove the cable holder to disconnect the power cable from the power
supply.

2. Hold up the latch on the cable holder of the power supply to release the
lock, and then slide the cable holder forward.

3. Pull the lever open while pressing the latch on the power supply inward
with right thumb.
When the lever is completely opened, the power supply moves forward.
 

 
4. Pull out and remove it while holding the body of the power supply with

both hands.
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5. Insert the new power supply into the slot, just before the "shield finger."
6. Wait at least 20 seconds, and then push the power supply gently until

the latch clicks. If the latch does not click, reorient the power supply, and
then reinsert it into the slot.

7. Connect the power cable to the power supply, and then secure the cable
with the cable holder.

8. Confirm that the red ALM/RDY LED is off at the power supply and the
green ALM/RDY LED is on.
If the red ALM/RDY LED does not go off after more than 30 minutes
following replacement of the power supply, remove the power supply,
wait at least 30 seconds, and then reinstall it.

Replacing a power supply for a CBLM or CBLH

Caution: Be sure to replace the faulty power supply. If you replace the
operational power supply, the system will go down.

Caution: A short-circuit can cause a fire. Never insert metal or other objects
into the cable connector; otherwise, a short-circuit can occur.

Note: Power supply unit #1 and power supply unit #2 are installed in
opposite directions.

Before you begin
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Confirm that the storage system power is turned on.
• Confirm that the red ALM LED for the power supply unit to be replaced is

on.

Note: If the red ALM LED is on at both power supplies, do not perform this
procedure. Go to the Customer Contact Us page at https://support.hds.com/
en_us/contact-us.html.

Procedure

1. Disconnect the power cable from the power supply to be replaced.
Remove the cable holder to disconnect the power cable from the power
supply.

2. Using a Phillips screwdriver, loosen the blue screw that secures the power
supply.

3. Open the lever to remove the power supply.
When the lever is completely opened, the power supply moves forward.

144 Replacing a power supply
Service Guide for VSP Gx00 and VSP Fx00 Models

https://support.hds.com/en_us/contact-us.html
https://support.hds.com/en_us/contact-us.html


4. Hold the power supply with both hands, and then pull it gently and
remove it.
 

 
5. Hold up the latch on the cable holder of the new power supply to release

the lock, and then slide the cable holder forward.
6. With the lever opened completely, insert the new power supply into the

slot. Wait at least 20 seconds, and then insert the power supply all the
way into the slot. If the power supply does not install all the way into the
slot, reorient the power supply, and then reinsert it into the slot.

7. Close the lever completely.
8. Using a Phillips screwdriver, tighten the blue screw to secure the power

supply.
9. Connect the power cable to the power supply, and then secure the cable

using the cable holder.
10. Confirm that the red ALM LED is off at the power supply and the green

RDY LED is on.
If the red ALM LED does not go off after more than 30 minutes following
replacement of the power supply, remove the power supply, wait at least
30 seconds, and then reinstall it.

Checking DKCPS power supply unit connections

Procedure

1. In the Alert Detail window of the maintenance utility, click Close.
2. In the left pane, click Controller Chassis to check the locations of the

target power supply unit.
• CBSS/CBSL:
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• CBLM/CBLH:
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CBLM/CBLH power supply unit locations
 

 

Note: Check the target power supply units and power cables only.
Do not touch other power supply units and power cables.

3. Check the connection of the target power supply units and power cables:
• For the CBSS/CBSL, push the power supply units all the way into their

slots and check that the latches are locked.
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• For the CBLM/CBLH, push the power supply units all the way into their
slots and tighten using the blue screws. If the power cables connected
to the target power supply units are loose, push the plugs of the
power cables into the sockets of the power supply units to connect the
cables securely.
 

 
4. Log out of the maintenance utility to close the window.

Replacing a power supply for SFF and LFF drive trays

Caution: Be sure to replace the faulty power supply. If you replace the
operational power supply, the system will go down.

Caution: A short-circuit can cause a fire. Never insert metal or other objects
into the cable connector; otherwise, a short-circuit can occur.

Note: Power supply unit #1 and power supply unit #2 are installed in
opposite directions.

Before you begin
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Confirm that the storage system power is turned on.
• Confirm that the red ALM LED for the power supply unit to be replaced is

on.
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Note: If the red ALM LED is on at both power supplies, do not perform this
procedure, even if the status of the power supplies is Normal. Go to the
Customer Contact Us page at https://support.hds.com/en_us/contact-
us.html.

Procedure

1. Disconnect the power cable from the power supply to be replaced.
Remove the cable holder to disconnect the power cable from the power
supply.

2. Pull the lever open while pressing the latch on the power supply inward
with your right thumb. When the lever is completely opened, the power
supply moves forward.
 

 
3. Hold the power supply with both hands, and then pull it gently and

remove it.
4. With the lever opened completely, insert the new power supply into the

slot.
Wait at least 20 seconds, and then insert the power supply all the way
into the slot.
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5. Close the lever completely and secure the power supply. If the lever
cannot be moved, reorient the power supply, and then reinsert it into the
slot.

6. Connect the power cable to the power supply, and then secure the cable
using the cable holder.

7. Confirm that the red ALM LED is off at the power supply and the green
RDY LED is on.

Note: If the ALM LED is on and the status of the power supply is
Normal, go to the Customer Contact Us page at https://
support.hds.com/en_us/contact-us.html.

If the red ALM LED does not go off after more than 30 minutes following
replacement of the power supply, remove the power supply, wait at least
30 seconds, and then reinstall it.

Replacing a power supply for a FMD drive tray

Caution: Be sure to replace the faulty power supply. If you replace the
operational power supply, the system will go down.

Caution: A short-circuit can cause a fire. Never insert metal or other objects
into the cable connector; otherwise, a short-circuit can occur.

Note: Power supply unit #1 and power supply unit #2 are installed in
opposite directions.

Before you begin
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Confirm that the storage system power is turned on.
• Confirm that the red ALM LED for the power supply unit to be replaced is

on.

Note: If the red ALM LED is on at both power supplies, do not perform this
procedure, even if the status of the power supplies is Normal. Go to the
Customer Contact Us page at https://support.hds.com/en_us/contact-
us.html.

Procedure

1. Disconnect the power cable from the power supply to be replaced.
Remove the cable holder to disconnect the power cable from the power
supply.
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2. Pull the lever open while pressing the latch on the power supply inward
with your right thumb. When the lever is completely opened, the power
supply moves forward.
 

 
3. Hold the power supply with both hands, and then pull it gently and

remove it.
4. With the lever opened completely, insert the new power supply into the

slot. Wait at least 20 seconds, and then insert the power supply all the
way into the slot.

5. Close the lever completely and secure the power supply. If the lever
cannot be moved, reorient the power supply, and then reinsert it into the
slot.

6. Connect the power cable to the power supply, and then secure the cable
using the cable holder.

7. Confirm that the red ALM LED is off at the power supply and the green
RDY LED is on.

Note: If the ALM LED is on and the status of the power supply is
Normal, go to the Customer Contact Us page at https://
support.hds.com/en_us/contact-us.html.

If the red ALM LED does not go off after more than 30 minutes following
replacement of the power supply, remove the power supply, wait at least
30 seconds, and then reinstall it.

Checking DBPS power supply unit connections
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Procedure

1. In the Alert Detail window of the maintenance utility, click Close.
2. In the maintenance utility, click Drive Box to check the locations of the

target power supply units.
 

 
 

 
CBLM/CBLH power supply unit locations
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Note: Check the target power supply units and power cables only.
Do not touch other power supply units and power cables.

3. Check the connection of the target power supply units and power cables:
• For the CBSS/CBSL, push the power supply units all the way into their

slots and check that the latches are locked.
• For the CBLM/CBLH, push the power supply units all the way into their

slots and tighten using the blue screws. If the power cables connected
to the target power supply units are loose, push the plugs of the
power cables into the sockets of the power supply units to connect the
cables securely.
 

 
4. Log out of maintenance utility to close the window.

Confirming the power supply unit status
Procedure

1. Click Hardware > Controller Chassis or Hardware > Drive Box.
2. In the Controller Chassis or Drive Box window, click the PSs tab.
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3. In the PSs tab in the Maintenance Utility window, confirm that the
status of the power supply unit changed to Normal.
If necessary, click Refresh at the top-right of the window to update the
status in the window.

4. Log out and close the Maintenance Utility window.

Replacing a power supply for a host port expansion chassis

Caution: Be sure to replace the faulty power supply. If you replace the
operational power supply, the system will go down.

Caution: A short-circuit can cause a fire. Never insert metal or other objects
into the cable connector; otherwise, a short-circuit can occur.

Note: Power supply unit #1 and power supply unit #2 are installed in
opposite directions.

Before you begin
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Confirm that the storage system power is turned on.
• Confirm that the red ALM LED for the power supply unit to be replaced is

on.

Note: If the red ALM/RDY LED is on at both power supplies, do not perform
this procedure. Go to the Customer Contact Us page at https://
support.hds.com/en_us/contact-us.html.

Procedure

1. Disconnect the power cable from the power supply to be replaced.
Remove the cable holder to disconnect the power cable from the power
supply.

2. Hold up the latch on the cable holder of the power supply to release the
lock, and then slide the cable holder forward.

3. Pull the lever open (1 ) while pressing the latch on the power supply
inward with right thumb (2). When the lever is opened completely, the
power supply moves forward.

4. Hold the body of the power supply with both hands (3), and then remove
it.
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5. Wait at least 30 seconds, and then insert the new power supply, just

before the "shield finger."
6. Push the power supply into the unit gently until the power supply latch

clicks.
7. Connect the power cable to the power supply, and then secure the cable

by the cable holder
8. Confirm that the red ALM/RDY LED is off at the power supply and the

green ALM/RDY LED is on.
If the red ALM/RDY LED does not go off after more than 30 minutes
following replacement of the power supply, remove the power supply,
wait at least 30 seconds, and then reinstall it.

Checking the power supply connections on a host port expansion
chassis

Using the following procedure, you can check the power supply connection on
a host port expansion chassis.

Procedure

1. In the Alert Detail window of the maintenance utility, click Close.
2. In the left pane, under Hardware, click Channel Board Box to check

the location of the power supply unit on the host port expansion chassis
fan (CHBBFAN).
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3. Check the connection of the power supply unit and power cable. Push the

power supply unit all the way in, and then confirm that the latch is
locked and secure. If the power cable not connected to the power supply
unit securely, push the plug on the power cable into the socket on the
power supply unit and confirm that the connection is secure.
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Note: Check the target power supply units and power cables only.
Do not touch other power supply units and power cables.

 

 
4. Log out and close the Maintenance Utility window.

Checking power cable connections on a host port expansion chassis
Using the following procedure, you can check whether the power cable on a
host port expansion chassis is loose or secure.

Procedure

1. In the Alert Detail window of the maintenance utility, click Close.
2. In the left pane, under Hardware, click Channel Board Box to check

the location of the power supply unit on the host port expansion chassis
fan (CHBBFAN).
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3. Check the connection of the power supply unit and power cable. Push the

power supply unit all the way in, and then confirm that the latch is
locked and secure. If the power cable not connected to the power supply
unit securely, push the plug on the power cable into the socket on the
power supply unit and confirm that the connection is secure.
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Note: Check the target power supply units and power cables only.
Do not touch other power supply units and power cables.

 

 
4. Log out and close the Maintenance Utility window.
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8
Replacing a controller

Before replacing a controller, read the precautions and understand the
procedure for your controller.

Note: If replacing a controller on a CBSS or CBSL, pay close attention to
whether you need to replace the non-encrypting controller or the controller
that supports encryption.

□ Blocking the controller

□ Replacing a controller for a CBSS or CBSL controller

□ Replacing a CBLM or CBLH controller

□ Restoring a controller
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Blocking the controller

Procedure

1. Start the maintenance utility.
2. Click Hardware > Controller Chassis.
3. In the Controller Chassis window, click the CTLs tab.
4. To display the most recent status of the controller, click Refresh.

 

 
5. Confirm the status of the controller to be replaced is Warning or Failed.
6. Click Replace (Type Change) and select the controller you want to

replace.
7. When the Replace Controller Board (Type Change) window opens,

verify the controller shown in the window is the one to be replaced, and
then click Block.
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8. Check the controller is blocked and becomes ready for replacing. Leave
the Replace Controller Board (Type Change) window open, but do
not click the Restore button.

If the Controller Board block fails, click Close on the completion
message. Then click the CTLs tab on the Controller Chassis window
and check the Controller Board status.
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Note: Do not click Restore at this time.

Replacing a controller for a CBSS or CBSL controller
When you replace a CBSS or CBSL controller, you will have to install the
following components on the new controller:
• Fan
• Cache memory
• Front end module
• Cache flash memory
• Backup module

Removing the controller

Before you begin
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Use the maintenance utility to block the controller.
• Confirm that the storage system power is turned on.
• Confirm that the red CTL ALARM LED for the controller to be replaced is on.

Procedure

1. Remove all cables connected to the controller.
2. Loosen the blue screw that secures the controller, and then open the

lever.
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3. Hold the controller with both hands, and then pull it gently in a straight

direction and remove it.
Keep the controller straight to avoid jostling the components above and
below it.

4. Install the fan, cache memory, front end module, and CFM on the new
controller.

Next steps
• Install the controller.
• Use the maintenance utility to restore (unblock) the controller.

Removing and installing the fan

Caution: Storage system fans rotate at high speed. Exercise extreme caution
to avoid getting anything caught in the fan and to prevent injury.

Before you begin
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• The controller must be removed from the storage system.
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Procedure

1. Loosen the blue screw that secures the fan.
2. Lift the fan and remove it from the connector.
3. Install the fan into the connector of the new controller.
4. Tighten the blue screw to secure the fan.

 

 

Removing and installing cache memory

Before you begin
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.
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Procedure

1. Press the button, and then slide the dual in-line memory module (DIMM)
cover in the direction of the arrow and remove the DIMM cover from the
hooks on either side.

2. Lift the DIMM cover gently to remove it.

Note: The DIMM cover has a band that can be damaged easily.
Exercise care when removing the DIMM cover.

 

 
3. Pull the lever outward.
4. Hold both ends of the cache memory, and then gently pull out the cache

memory from the socket.

Note: Do not exert pressure on the cache memory. Otherwise, you
can damage the printed circuit board.
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5. Align the notch on the cache memory board with the projection inside

the slot.
6. Holding both ends of the cache memory, insert it into the socket.
7. Confirm that the lever is securing the cache memory.
8. To install the DIMM cover, slide it in the direction of the arrow. Confirm

that the DIMM cover is secured by the two hooks on either side.

Next steps
• Install the controller.
• Use the maintenance utility to restore (unblock) the controller.

Removing and installing a front end module

Before you begin

• Wear a wrist strap connected to the storage system to prevent part
failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Use the maintenance utility to block the controller.
• Remove the controller.

Procedure

1. Loosen the two blue screws that secure the front end module.
2. Using the blue screw, pull out the front end module in a straight direction

and remove.
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3. Connect the optical cable to the new front end module.
4. Insert the front end module into the slot of the new controller.
5. Push the front of the front end module until the module is inserted all the

way into the slot.
 

 
6. Tighten the two blue screws to secure the front end module.

Removing and installing cache flash memory

Before you begin

• Wear a wrist strap connected to the storage system to prevent part
failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Use the maintenance utility to block the controller.
• The controller must be removed from the storage system.

Procedure

1. Loosen the blue screw that secures the cache flash memory (CFM).
2. Open the lever.
3. Using both hands, hold the body of the CFM and remove it.
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4. With the lever opened completely, insert the CFM into the slot.
5. Push the CFM all the way into the slot.
6. Close the lever completely.
7. Tighten the blue screw to secure the CFM.

Next steps
• Once all parts are installed on the controller, install it in the storage

system.
• Use the maintenance utility to restore (unblock) the controller.

Removing and installing the backup module

Before you begin

• Wear a wrist strap connected to the storage system to prevent part
failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• The controller must be removed from the storage system.

Procedure

1. Loosen the blue screw that secures the backup module.
2. Open the lever, and then use both hands to remove the backup module.
3. With the backup module lever opened, insert the backup module into the

slot of the new controller.
4. Close the backup module lever and tighten the blue screw.
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Installing a controller

Before you begin

• Wear a wrist strap connected to the storage system to prevent part
failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Complete the installation of all components from the old controller.

Procedure

1. With the right and left levers of the new controller open completely,
insert it into the slot of CBSS or CBSL.

2. Push the bottom-front of the controller all the way into the slot. Stop
pushing when the right and left levers close completely.
 

 
 

 
3. Tighten the blue screw to secure the controller.
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4. Confirm that the red CTL ALM LED on the controller is off.
5. Connect all the cables you removed.

Replacing a CBLM or CBLH controller
When you replace a CBLM or CBLH controller, you will have to install the
following components on the new controller:
• Cache memory
• Cache flash memory
• Backup module

You must remove the backup module first, and then remove the controller.

Removing a CBLM or CBLH controller

Before you begin
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Confirm that the storage system power is turned on.
• Use the maintenance utility to block the controller.
• Confirm that the red CTL ALARM LED for the controller to be replaced is on.

Procedure

1. Loosen the right and left blue screws on the lever of the controller in the
front of the CBLM or CBLH controller, and then open the lever.

2. Loosen the blue screw securing the backup module (BKMF).
3. Pull out and remove the BKMF.
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4. Remove all four BKMF modules installed in the controller.
5. Loosen the blue right and left screws on the lever of the controller, and

then open the lever.
6. With the lever opened completely, hold the controller with both hands,

and then pull it gently and remove it.
Keep the controller straight to avoid jostling the components above and
below it.
 

 

Next steps
• Install the backup module (BKMF) in the new controller.
• Install the cache memory on the new controller.
• Install the cache flash memory on the new controller.
• Use the maintenance utility to restore (unblock) the controller.

Note: If the POWER, READY, WARNING, and ALARM LEDs on the front of the
CBLM/CBLH go off after removing the controller, check the status of the
storage system in the Maintenance Utility window, and then continue the
replacement work. After restoring the controller (described later), confirm
that the LED goes on.
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Removing and installing cache memory

Before you begin
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• The controller is removed from the storage system.

Procedure

1. Open the air guide.
 

 
2. Pull the lever outward.
3. Holding both ends of the cache memory, pull out the cache memory from

the socket.

Note: Do not exert pressure on the cache memory. Otherwise, you
can damage the printed-circuit board.
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Note: DIMMs are installed in sets of four. There are two groups of
cache memory DIMM slots: CMG0 and CMG1. Populate the CMGO slots
first, and then populate the CMG1 slots if necessary.

4. Align the notch on the cache memory board with the projection inside
the slot.

5. Holding both ends of the cache memory, insert it into the socket of the
new controller.

6. Check that the lever is securing the cache memory.
7. Close the air guide.

Next steps
• Once all components are installed on the controller, install the controller in

the storage system.
• Use the maintenance utility to restore (unblock) the controller.
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Removing and installing cache flash memory for a CBLM or CBLH
controller

Before you begin
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• The controller must be removed from the storage system.

Procedure

1. Loosen the blue screw that secures the cache flash memory (CFM).
2. Open the lever.
3. Using both hands, hold the body of the CFM and remove it.
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4. With the lever opened completely, insert the CFM into the slot.
5. Push the CFM all the way into the slot.
6. Tighten the blue screw to secure the CFM.

Next steps
• Once all parts are installed on the controller, install it in the storage

system.
• Use the maintenance utility to restore (unblock) the controller.

Replacing a controller 177
Service Guide for VSP Gx00 and VSP Fx00 Models



Installing a CBLM CBLH controller

Before you begin
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

Procedure

1. With the right and left levers on the new controller opened completely,
insert the controller into the slot of the CBLM CBLH chassis.
Hold the controller with both hands and move it in a straight direction.
 

 
2. With the lever closed on the BKMF you removed, tighten the blue screw

to secure the BKMF.
3. Install the four BKMFs on the controller.

 

178 Replacing a controller
Service Guide for VSP Gx00 and VSP Fx00 Models



 
4. Push the bottom of the controller all the way into the slot. Stop pushing

when the right and left levers close completely.
 

 
5. Tighten the blue screw to secure the controller.
6. Confirm that the red CTL ALM LED on the new controller is off.
7. Attach the front bezel.

Next steps
• Use the maintenance utility to restore (unblock) the controller.

Restoring a controller

Procedure

1. At the Replace Controller Board window, click Restore. A progress bar
shows the replacement status.
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Note: The restore operation can take up to 20 minutes to
complete. If you receive a message about the failed recovery, go
to the Customer Contact Us page at https://support.hds.com/
en_us/contact-us.html.

2. When the progress bar goes away and the completion message appears,
click Close.

3. If you receive a message about the encryption environment setting is
applied, click Close.
 

 
4. Click the CTLs tab and confirm that the status of the new controller you

replaced is Normal. If necessary, click Refresh at the top-right of the
window to update the status in the window.

5. Log out and close the Maintenance Utility window.
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9
Troubleshooting the controller

Procedure

1. In the Alert Detail window of the maintenance utility, click Close.
2. In the left pane, click Controller Chassis.

Maintenance Utility window for CBSS or CBSL
 

 
Maintenance Utility window for CBLM or CBLH
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CBSS/CBSL controller locations
 

 
CBLM/CBLH controller locations
 

182 Troubleshooting the controller
Service Guide for VSP Gx00 and VSP Fx00 Models



 
3. Log out of maintenance utility to close the window.
4. Remove the front bezel from the CBLM/CBLH.
5. Press the LAN-RST switch on the target controller (controller 1) using a

fine-tipped tool, such as a pen or screwdriver. Confirm that the amber
CTL ALM LED on the CBSS/CBSL or the amber ALM LED on the CBLM/
CBLH goes ON while the LAN-RST switch is being pressed.

LAN-RST button on CBSS/CBSL controller rear panel
 

 
LAN-RST button on CBLM/CBLH controller front panel
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6. Wait about 20 minutes.
7. Attach the front bezel to the CBLM/CBLH.
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Replacing cache memory

Before replacing cache memory, read the precautions and understand the
procedure for your cache memory.

□ Checking cache memory

□ Replacing cache memory for a CBLM or CBLH controller

□ Replacing cache memory for a CBSS or CBSL controller

□ Replacing cache memory for a CBLM or CBLH controller

□ Restoring a controller

□ Replacing cache memory for a NAS module
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Checking cache memory
Procedure

1. Start the maintenance utility.
2. Click Hardware > Controller Chassis.
3. Click the CTLs tab.
4. To display the most recent status of the cache memory, click Refresh.

 

 
5. Confirm that the status of the cache memory to be replaced is Warning.

Replacing cache memory for a CBLM or CBLH controller
Procedure

1. Start the maintenance utility.
2. Click Hardware > Controller Chassis.
3. In the Controller Chassis window, click the CTLs tab.
4. Confirm that the component you want to replace has the status Warning

or Failed.
5. Click the Replace list, and select the controller that contains the cache

memory you want to replace.
6. Click Block.
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7. Check that the controller has a normal status, and then click OK.

 

 
8. Check that the controller is blocked and becomes ready for replacing.

Leave the Replace Cache Memories window open, but do not click the
Restore button.
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Replacing cache memory for a CBSS or CBSL controller

Before you begin
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Use the maintenance utility to block the controller.
• Confirm that the storage system power is turned on.
• Confirm that the red CTL ALARM LED for the controller containing the cache

memory to be replaced is on.

Procedure

1. Remove all cables connected to the controller.
2. Loosen the blue screw that secures the controller and open the lever.

Note: The POWER, READY, WARNING, and ALARM LEDs might go off. If
the LED on the front goes off, check whether a component other
than the controller has normal status in the Maintenance Utility
window and continue the replacement. The green READY LED on
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the front of the CBSS/CBSL goes on after restoring the controller
at the end of the replacement procedure.

3. Hold the controller with both hands, and then gently remove it. Keep the
controller straight to avoid touching the components above and below it.
 

 
4. Press the button near the dual in-line memory module (DIMM) cover,

slide the cover in the direction of the arrow.
5. Lift and remove the DIMM cover from the hooks on either side.

Note: The DIMM cover has a band that can be damaged easily.
Exercise care when removing the DIMM cover.
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6. Note the cache memory locations.

 

 
7. Pull the lever outward.
8. Hold both ends of the cache memory by the fingers, and then gently

remove the cache memory from the socket.

Note: Do not exert pressure on the cache memory. Otherwise, you
can damage the printed-circuit board.
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9. Alight the notch on the cache memory board with the projection inside

the slot.
10. Holding both ends of the cache memory, insert it into the socket of the

new controller.
11. Check that the lever is securing the cache memory.
12. To install the DIMM cover, slide it in the direction of the arrow. Confirm

that the DIMM cover is secured by the two hooks on either side.
13. Check that the connector of the controller is not damaged, deformed, or

dusty.
14. With the right and left levers on the controller opened completely, insert

it into the slot of CBSS or CBSL controller.
15. Push the controller in all the way. The right and left levers close

completely.
16. Tighten the blue screw to secure the controller.
17. Connect all cables removed from the controller.
18. Confirm that the red CTL ALM LED on the controller in which the cache

memory was installed goes off.

Next steps
• Use the maintenance utility to restore (unblock) the controller.

Replacing cache memory for a CBLM or CBLH controller
When replacing cache memory on a CBLM or CBLH controller, remove the
backup module first, and then remove the controller. A single CBLM or CBLH
controller weighs approximately 42 pounds (19 kg).

 

Replacing cache memory 191
Service Guide for VSP Gx00 and VSP Fx00 Models



 

Note: DIMMs are installed in sets of four. There are two groups of cache
memory DIMM slots: CMG0 and CMG1. Populate the CMGO slots first, and then
populate the CMG1 slots if necessary.

Before you begin
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Use the maintenance utility to block the controller.
• Confirm that the storage system power is turned on.
• Confirm that the red CTL ALARM LED for the controller containing the cache

memory to be replaced is on.

Procedure

1. Remove the front bezel.
2. Loosen the blue left and right screws on the lever of the controller to add

the cache memory in the front of the CBLM or CBLH and open the lever.

Note: The POWER, READY, WARNING, and ALARM LEDs might go off. If
the LED on the front goes off, check whether a component other
than the controller has normal status in the Maintenance Utility
window and continue the replacement. The green READY LED on
the front of the CBLM/CBLH goes on after restoring the controller
at the end of the replacement procedure.

3. Loosen the blue screw securing the backup module.
4. With the lever opened, pull out and remove the backup module.
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5. Remove all four backup modules installed in the controller.
6. Loosen the blue right and left screws on the lever of the controller, and

then open the lever.
7. Hold the controller with both hands and gently remove it. Keep the

controller straight to avoid touching the components above and below it.
 

 
8. Open the air guide.
9. Pull the lever outward.
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10. Hold both ends of the cache memory, and then gently pull out the cache
memory from the socket.

Note: Do not exert pressure on the cache memory. Otherwise, you
can damage the printed circuit board.

 

 
11. Align the notch on the cache memory board with the projection inside

the slot.
12. Holding both ends of the cache memory, insert it into the socket.
13. Confirm that the lever is securing the cache memory.
14. Close the air guide.
15. Confirm that the connector of the controller is not damaged, deformed,

or dusty.
16. With the right and left levers of the controller opened completely, insert

it into the slot of the controller.
17. Push the controller all the way into the slot.

The right and left levers close completely.
18. Tighten the blue screw to secure the controller.
19. With the lever on the backup module open, insert the backup module

into the slot.
20. With the backup module lever closed, tighten the blue screw to secure it.
21. Install the four backup modules on the controller.
22. Tighten the blue screw to secure the controller.
23. Confirm that the red CTL ALM LED on the controller in which the cache

memory was installed goes off.

Next steps
• Use the maintenance utility to restore (unblock) the controller.
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Restoring a controller
Procedure

1. If you increased cache memory, click Restore in the Install Cache
Memories window.
 

 
If you replaced cache memory without increasing capacity, click Restore
in the Replace Cache Memories window.
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A progress bar shows the replacement status.

Note: The restore operation can take up to 20 minutes to
complete. If you receive a message about a failed recovery, go to
the Customer Contact Us page at https://support.hds.com/en_us/
contact-us.html.

2. When the progress bar goes away and the completion message appears,
click Close.

3. Click the CTLs tab and confirm that all status conditions are Normal.
If necessary, click Refresh at the top-right of the window to update the
status in the window.

4. Log out and close the Maintenance Utility window.

Replacing cache memory for a NAS module
Migrate the EVS manually before replacing cache memory for a NAS module

Related tasks

• EVS migration after servicing nodes on page 102

Blocking a NAS module
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Procedure

1. In the Maintenance Utility window, click Hardware > Controller.
2. Click the CHBs tab.
3. To display the most recent status of the cache memory, click Refresh.
4. In the Cache Memory (NAS Module) column of the cache memory that

failed, click Warning.
 

 
5. Check the cache memory to be replaced, and then click Replace.
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6. Click Block.
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7. Check that the NAS module is blocked and becomes ready for replacing.

Do not click Restore at this time.
 

Replacing cache memory 199
Service Guide for VSP Gx00 and VSP Fx00 Models



 

Related tasks

• EVS migration after servicing nodes on page 102

Replacing cache memory for a NAS module
Confirm that the red STATUS LED is on at the NAS module containing the
cache memory to be replaced.

Procedure

1. Remove the cables connected to the NAS module. Mark the port from
where the cable was removed.

2. Loosen the two blue screws that secure the NAS module and open the
lever.

3. Hold the NAS module with both hands, keep it straight, and gently pull it
toward you. Keep the NAS module level, so that no physical shock is
exerted on the parts.

Note: The heat sinks can be hot on a NAS module that is removed
from the storage system. Avoid touching these hot parts when
removing the NAS module.
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4. Replace the failed cache memory with the new cache memory.
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5. To remove the cache memory:

a. Pull the memory outward.
b. Use your fingers to hold both ends of the cache memory, and then pull

out the cache memory from the socket.
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6. Install the new cache memory:

a. Position the notch (cut) on the cache memory board with the
projection inside the slot, and then place the cache memory on the
socket

b. Use your fingers to hold both ends of the cache memory, and then
insert the cache memory into the socket.

Note: Applying too much pressure can bend the printed-circuit
board and damage the cache memory.

c. Check that the lever is firmly fitted in the cache memory.
 

 
7. Install the NAS module:

a. Insert the new NAS module into the slot while opening the lever.
b. Push the NAS module all the way into the slot and close the lever.
c. Tighten the two blue screws to secure the NAS module.
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8. On the NAS module, connect the cable to the same port to which the

cable was connected before replacing cache memory. Be sure the cable
clicks into place.

Related tasks

• EVS migration after servicing nodes on page 102

Restoring a NAS module

Procedure

1. Click Restore.
2. When the completion message appears, click Close.
3. Click the CHBs tab, and then confirm that the NAS module is Normal.
4. After completing the work, log out and close the Maintenance Utility

window.
5. Migrate the EVS manually from the operating NAS module to the other

NAS module.

Related tasks

• EVS migration after servicing nodes on page 102
• EVS migration after servicing nodes on page 102
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11
Replacing a front end module

Before replacing a front end module, read the precautions and understand
the procedure for your front end module.

Controller 1 and Controller 2 must have the same number of front end
modules installed. For example, if you install a second front end module to
Controller 1, you must also install a new front end module to Controller 2.
You cannot add a front end module to one controller without adding a front
end module to the other controller.

□ Blocking a front end module

□ Replacing a front end module on a controller

□ Replacing a front end module on a host port expansion chassis

□ Restoring a front end module
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Blocking a front end module
Procedure

1. Start the maintenance utility.
2. In the Maintenance Utility window, click Hardware > Controller

Chassis or Hardware > Channel Board Box.
3. Click the CHBs tab.
4. To display the most recent status of the front end module, click Refresh.
5.  

 
Confirm that the status of the front end module to be replaced is
Warning.

6. Click the front end module to be replaced, and then click Replace.
7. Click Block.
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8. Verify that the front end module is blocked and is ready for replacing.
9. Leave the Replace Channel Board window open, but do not click

Restore.
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Replacing a front end module on a controller
Before you begin
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Use the maintenance utility to block the front end module.
• Confirm that the storage system power is turned on.
• The red STATUS LED is on at the front end module to be replaced.
• Add the front end module to the same locations of controller 1 and

controller 2.

Procedure

1. Disconnect the cable from the front end module.
2. Loosen the two blue screws that secure the front end module.
3. Hold the blue screws, and then gently remove the front end module.

Keep the front end module straight to avoid jostling the components
above and below it.

4. If applicable, remove the SFPs from the failed component and insert the
SFPs into the replacement FED.
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a. Pull the SFP lever down toward you and pull out the SFP. If you cannot
remove the SFP, pull it out while pushing open the lever toward you.

b. Check the SFP insertion direction and insert the SFP into the port until
it clicks.

5. Orient the new front end module as shown below.
 

 
Replacing the front end module on a VSP G200
 

 
Replacing the front end module on a VSP G400, G600, G800

6. Insert the new front end module into the slot, just before the "shield
finger."
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7. Gently push the front end module all the way into the slot.

 

 
8. Tighten the two blue screws to secure the front end module.
9. Confirm that the red STATUS LED on the front end module goes off.

10. Connect the cable to the new front end module.

Next steps
• Use the maintenance utility to restore (unblock) the front end module.

Replacing a front end module on a host port expansion
chassis

Before you begin
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Use the maintenance utility to block the front end module.
• Confirm that the storage system power is turned on.
• The red STATUS LED is on at the front end module to be replaced.

Procedure

1. Disconnect the cable from the front end module.
2. Loosen the two blue screws that secure the front end module.
3. Hold the blue screws, and then gently remove the front end module.

Keep the front end module straight to avoid jostling the components
above and below it.
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4. If applicable, remove the SFPs from the failed component and insert the

SFPs into the replacement FED.
a. Pull the SFP lever down toward you and pull out the SFP. If you cannot

remove the SFP, pull it out while pushing open the lever toward you.
b. Check the SFP insertion direction and insert the SFP into the port until

it clicks.
5. Insert the new front end module into the slot, just before the "shield

finger."
6. Gently push the front end module all the way into the slot.

 

 
7. Tighten the two blue screws to secure the front end module.
8. Confirm that the red STATUS LED on the front end module goes off.
9. Connect the cable to the new front end module.

Next steps
• Use the maintenance utility to restore (unblock) the front end module.

Restoring a front end module
Procedure

1. At the Replace Channel Board window, click Restore.
A progress bar shows the replacement status.

Note: It can take up to 20 minutes for the controller to recover. If
a message states that the recovery failed, go to the Customer
Contact Us page at https://support.hds.com/en_us/contact-
us.html.
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2. When the progress bar goes away and the completion message appears,
click Close.

3. Click the CHBs tab in the Controller Chassis or Channel Board Box
window.

4. Confirm that the status of the new front end module is Normal.
If necessary, click Refresh at the top-right of the window to update the
status in the window.

5. Log out and close the Maintenance Utility window.
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Replacing a small form-factor pluggable

(SFP)
Before replacing a small form-factor pluggable (SFP), read the precautions
and understand the procedure for your SFP.

Note: SFP ports also have been referred to as a mini-GigaBit or (GBIC)
ports. However, this term has been made obsolete by SFP.

□ Checking the SFP

□ Replacing an SFP on a controller

□ Replacing an SFP on a host port expansion chassis

□ Replacing a small form-factor pluggable (SFP+) for a NAS module
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Checking the SFP
Before you begin

Confirm that the red PORT LED is on at the front end module whose SFP will
be replaced.

Procedure

1. Start the maintenance utility.
2. In the Maintenance Utility window, click Hardware > Controller

Chassis or Hardware > Channel Board Box.
3. Click the CHBs tab.
4. Confirm that the status of the SFP to be replaced is Warning.

 

 
5. In the SFP Status column, click the warning to display a pop-up window

with SFP port ID, status, and type information.
6. Replace the SFP. Do not click Close at this time.

Replacing an SFP on a controller
Install the same type of SFP as the one being replaced. The color of the lever
or the entire SFP identifies the SFP type:
• Shortwave SFPs are black.
• Longwave SFPs are blue.
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Before you begin
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Confirm that the storage system power is turned on.
• The red STATUS LED is on at the front end module whose SFP will be

replaced.

Procedure

1. Disconnect the optical fibre cable from the SFP to be replaced.
2. Pull the SFP lever down toward you and pull out the SFP.

If you cannot remove the SFP, pull it out while pushing open the lever
toward you.
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3. Wait at least 10 seconds, and then check the SFP insertion direction and

insert the SFP into the port until it clicks.

Note: Replace the SFP with the same type being removed.

4. Connect the optical fibre cable that matches the new SFP. Check that the
cable latch clicks and the cables are surely connected.

5. Confirm that the red PORT LED on the front end module is off.
6. In the Controller Chassis window, confirm that the status of the

replacement SFP is Normal.
If necessary, click Refresh at the top-right of the window to update the
status in the window.

7. Log out and close the Maintenance Utility window.
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Replacing an SFP on a host port expansion chassis
Install the same type of SFP as the one being replaced. The color of the lever
or the entire SFP identifies the SFP type:
• Shortwave SFPs are black.
• Longwave SFPs are blue.

Before you begin
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Confirm that the storage system power is turned on.
• The red PORT LED is on at the front end module whose SFP will be

replaced.

Procedure

1. Disconnect the optical fiber cable from the SFP to be replaced.
2. Pull the SFP lever down toward you and pull out the SFP. If you cannot

remove the SFP, pull it out while pushing open the lever toward you.
3. Check the SFP insertion direction and insert the SFP into the port until it

clicks.

Note: Replace the SFP with the same type being removed.
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4. Connect the optical fibre cable to the new SFP. Check that the cable latch

clicks and the cables are surely connected.
5. Confirm that the red PORT LED on the front end module is off.
6. In the Controller Chassis or Channel Board Box window, confirm that

the status of the replacement SFP is Normal.
If necessary, click Refresh at the top-right of the window to update the
status in the window.

7. Log out and close the Maintenance Utility window.

Replacing a small form-factor pluggable (SFP+) for a NAS
module

This section describes the procedure for replacing a SFP+ for the NAS
module.

Checking the SFP+ for a NAS module

Before you begin

Procedure

1. Start the maintenance utility.
2. In the Maintenance Utility window, click Hardware > Controller

Chassis.
3. Click the CHBs tab.
4. To display the most recent status of the SFP+, click Refresh.
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5. Check the SFP+ to be replaced, and then click Close.

 

 

Replacing an SFP+ for a NAS module
Confirm that the red network port LED is on at the SFP+ to be replaced. Be
sure to replace the SFP+ with the same type of SFP+.
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Procedure

1. Remove the cable from the SFP+ to be replaced. Mark the port from
where the cable was removed.

2. Remove the SFP+:
a. Pull the SFP lever down toward you and pull out the SFP+. If you

cannot remove it, pull it out while pushing open the lever toward you.
b. Wait at least 10 seconds.
c. Check the SFP+ insertion direction, and then inset the SFP+ into the

port until the cable clicks into place.
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3. On the new SFP+, connect the cable to the same port to which the cable

was connected on the old SFP+. Be sure the cable clicks into place.

Restoring the SFP+ for a NAS module

Procedure

1. In the Maintenance Utility window, click Hardware > Controller
Chassis.

2. Click the CHBs tab.
3. To display the most recent status of the NAS module, click Refresh.
4. Confirm that the status of the replaced SFP+ is Normal.
5. Log out of the Maintenance Utility window.
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Replacing a back end module

Back end module replacement is supported only on the VSP G800 or VSP
F800. Before performing the replacement, read the precautions and
understand the procedure for your back end module.

□ Blocking a back end module

□ Adding or replacing the back end module

□ Restoring a DKB
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Blocking a back end module
Procedure

1. Start the maintenance utility.
2. In the Maintenance Utility window, click Hardware > Controller

Chassis.
3. In the Controller Chassis window, click the DKBs tab.
4. Confirm that the status of the back end module to be replaced is

Warning.
5. To display the most recent status of the back end module, click Refresh.

 

 
6. Click the back end module to be replaced, and then click Replace.
7. When the Replace Disk Board window opens, verify that the back end

module shown is the one to be replaced.
8. Click Block.
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9. Leave the Replace Disk Board window open, but do not click the

Restore button.
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Adding or replacing the back end module
Before you begin
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Use the maintenance utility to block the back end module.
• Confirm that the storage system power is turned on.

• Confirm that the red STATUS LED on the back end module to be replaced is
on.

Procedure

1. Press the white tab on the SAS cable, and then remove the cable from
the back end module to be replaced.

2. Loosen the two blue screws that secure the back end module or dummy
board.

3. Holding the blue screw on the back end module, gently remove the back
end module. Keep the back end module straight to avoid jostling the
components above and below it.
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4. Insert the new back end module into the slot, just before the shield

finger.
 

 
5. Gently push the front of the back end module until the module is inserted

all the way into the slot.
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6. Connect the SAS cable to the new back end module.
7. Tighten the two blue screws to secure the back end module.
8. Confirm that the red STATUS LED on the new back end module is off.

Next steps
• Use the maintenance utility to restore (unblock) the back end module.

Restoring a DKB
Procedure

1. At the Replace Disk Board window, click Restore.
A progress bar shows the replacement status.

2. When the progress bar goes away and the completion message appears,
click Close.

3. If a warning message states that the encryption environment setting is
applied, click Close.
 

 
4. Click DKBs tab in the Controller Chassis window and confirm that the

status of the new back end module is Normal.
If necessary, click Refresh at the top-right of the window to update the
status in the window.

5. Log out and close the Maintenance Utility window.
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Replacing an ENC

Before replacing an ENC, read the precautions and understand the procedure
for your ENC.

□ Blocking an ENC

□ Replacing the ENC for SFF and LFF drive trays

□ Replacing the ENC for a FMD drive tray

□ Restoring an ENC
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Blocking an ENC
Procedure

1. Start the maintenance utility.
2. Click Hardware > Drive Box.
3. In the Drive Box window, click the ENCs tab.
4. To display the most recent status of the ENC, click Refresh.
5.  

 
Confirm that the status of the ENC to be replaced is Warning.

6. Click the ENC to be replaced, and then click Replace.
7. When the Replace ENC window opens, confirm that the ENC shown in

the window is the one to be replaced.
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8. Click Block.
9. Verify that the ENC is blocked and is ready for replacing.

10. Leave the Replace ENC window open, but do not click the Restore
button.
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Replacing the ENC for SFF and LFF drive trays
Do not touch the ENC connector because it is fragile. Check that the ENC
connector is in good shape and is not deformed, damaged, or dusty before
installing the ENC.

Note: Be sure to replace the faulty ENC. If you replace the operational ENC,
the system will go down.

Caution: A short-circuit can cause a fire. Never insert metal or other objects
into the cable connector; otherwise, a short-circuit can occur.

Before you begin
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Confirm that the storage system power is turned on.
• Use the maintenance utility to block the ENC.
• Confirm that the red ALARM LED for the ENC to be replaced is on.
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Procedure

1. Disconnect the SAS cable from the ENC to be replaced.
2. Open toward you the right and left levers that secure the ENC.

When the levers are completely opened, the ENC moves forward.
3. Hold the ENC with both hands, and then pull it gently and remove it.
4. Open completely the right and left levers of the new ENC.
5. Insert the ENC into the slot, and then push the right and left levers

toward the ENC until the levers open slightly.
 

 
6. Confirm that the red ALARM LED on the new ENC is off.
7. Connect the SAS cable to the new ENC.

Replacing the ENC for a FMD drive tray
Do not touch the ENC connector because it is fragile. Check that the ENC
connector is in good shape and is not deformed, damaged, or dusty before
installing the ENC.

Note: Be sure to replace the faulty ENC. If you replace the operational ENC,
the system will go down.

Caution: A short-circuit can cause a fire. Never insert metal or other objects
into the cable connector; otherwise, a short-circuit can occur.

Before you begin
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Confirm that the storage system power is turned on.
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• Use the maintenance utility to block the ENC.
• Confirm that the red ALARM LED for the ENC to be replaced is on.

Procedure

1. Disconnect the SAS cable from the ENC to be replaced.
2. Open toward you the right and left levers that secure the ENC.

When the levers are completely opened, the ENC moves forward.
3. Hold the ENC with both hands, and then pull it gently and remove it.
4. Open completely the right and left levers of the new ENC.
5. Insert the ENC into the slot, and then push the right and left levers

toward the ENC until the levers open slightly.
6. Confirm that the red ALARM LED on the new ENC is off.
7. Connect the SAS cable to the new ENC.

Restoring an ENC
Procedure

1. At the Replace ENC window, click Restore.
A progress bar shows the replacement status.

2. When the progress bar goes away and the completion message appears,
click Close.

3. Click the ENCs tab in the Drive Box window and confirm that the status
of the new ENC is Normal.
If necessary, click Refresh at the top-right of the window to update the
status of the window.

Note: Even if the ENC status is Normal, the red ALARM LED might
not go out. If this occurs, contact the HDS Support Portal at 
https://support.hds.com/en_us/contact-us.html.

4. Log out and close the Maintenance Utility window.
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Replacing a SAS cable

Before replacing a SAS cable, read the precautions and understand the
procedure for your SAS cable.

SAS cables come in the following shapes:

Model Name Shape

DW-F800-SCQ1

DW-F800-SCQ1F

DW-F800-SCQ3

DW-F800-SCQ5

 

 

DW-F800-SCQ10A

DW-F800-SCQ30A

DW-F800-SCQ1H

 

 

• Before you replace a cables, block any components connected to ths SAS
cables, such as controllers, backend modules, and ENCs.
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• For SAS cable DW-F800-SCQ1HA, replace the SAS adapter first. If
recovery fails even after replacing the SAS adapter, replace the cable.

• The cable thickness and connector shape depend on the model name of
the SAS cable.

□ Replacing SAS cables connected to a CBSS or CBSL controller

□ Replacing SAS cables connected to a CBLM or CBLH controller

□ Replacing SAS cables on a drive tray
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Replacing SAS cables connected to a CBSS or CBSL
controller

Replacing SAS cables for a CBSS or CBSL controller requires you to block a
controller before replacing the cables.

Procedure

1. Start the maintenance utility.
2. In the Maintenance Utility window, Hardware --> Controller

Chassis.
3. Click the CTLs tab.
4. To display the most recent status of the controller, click Refresh.

 

 
5. Check the status of the controller.
6. After checking that the appropriate controller has been selected, click

Block.
7. When the Replace Controller Board window opens, verify that the

appropriate controller is shown in the window, and then click Block.
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8. Check that the controller is blocked and becomes ready for replacing the

SAS cables. Leave the Replace Controller Board window open, but do
not click the Restore button.
 

 
9. Confirm that the red CTL ALM LED on the controller is on.

10. Release the routing of the SAS cable connected to the CBSS or CBSL.
11. Remove the SAS cable from the back end module on the CBSS or CBSL.
12. Remove the SAS cable from the ENC on the CBSS/CBSL drive tray.
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13. Remove the front end module of the blocked controller and the cables
connected to LAN.

14. Loosen the blue screw that secures the blocked controller and open the
lever.

Note: The POWER, READY, WARNING, and ALARM LEDs might go off. If
the LED on the front goes off, check whether any component other
than the controller is normal in the Maintenance Utility window and
continue the procedure. The green READY LED on the front of
CBSS/CBSL goes on after you restore the controller at the end of
the replacement procedure.

15. Wait at least 20 seconds, and then push the controller all the way in and
close the lever.
 

 
16. Tighten the blue screw and secure the controller.
17. Connect the cables you removed to the front end module and LAN.
18. Connect new SAS cables to the CBSS/CBSL back end module and the

ENC of the drive tray connected to the CBSS/CBSL.
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• When replacing DW-F800-SCQ1HA cables, pull the cable latches to
remove the cables from the SAS adapters. Attach new cables to the
SAS adapters and connect to the ENC.

• When replacing the SAS adapter of the SAS cable (DW-F800-
SCQ1HA), install the cable to a new SAS adapter, and then connect it
to the ENC and route the cable.

Note: The SAS cable does not have to be routed when connecting
the DW-F800-SCQ1HA SAS adapter.

 

 
19. At the Replace Controller Board window, click Restore.

A progress bar shows the replacement status.

Note: The restore operation can take up to 20 minutes to
complete. If a message states that the recovery failed, go to the
Customer Contact Us page at https://support.hds.com/en_us/
contact-us.html.

20. When the progress bar goes away and the completion message appears,
click Close.

21. Click the CTLs tab, and then check that the controller whose SAS cable
you replaced is Normal.

22. Log out and close the Maintenance Utility window.

Replacing SAS cables connected to a CBLM or CBLH
controller

Replacing SAS cables for a CBLM or CBLH controller requires you to block a
back end module before replacing the cables.

Procedure

1. Start the maintenance utility.
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2. In the Maintenance Utility window, click Hardware --> Controller
Chassis.

3. Click the DKBs tab.
4. To display the most recent status of the controller, click Refresh.

 

 
5. Check the status of the back end module.
6. Select the back end module whose SAS cable you want to replace, and

then click Replace.
7. After checking that the appropriate back end module has been selected,

click Block.
8. When the Replace Disk Board window opens, verify that the back end

module shown in the window is the one whose SAS cables are to be
replaced, and then click Block.
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9. Leave the Replace Disk Board window open, but do not click the

Restore button.
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10. Confirm that the red STATUS LED on the back end module whose SAS

cable you want to replace is on.
11. Unroute the SAS cable connected to the CBLM or CBLH.

Note: When replacing the SAS adapter for DW-F800-SCQ1HA, you
do not have to release the routing of the SAS cable.

12. Remove the SAS cable from the back end module on the CBLM or CBLH.
13. Remove the SAS cable from the ENC on the drive tray connected to the

CBLM or CBLH.
14. For SAS cable DW-F800-SCQ1HA:

a. Loosen the blue two screws that secure the back end module.
b. Hold the blue screw, and then gently pull out the back end module

slightly.
c. Wait at least 20 seconds, and then re-insert the back end module

before the "shield finger."
d. Push the back end module slightly.
e. Tighten the two blue screws to secure the back end module.
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15. Connect new SAS cables to the back end module on the CBLM/CBLH and

to the ENC of the CBLM/CBLH drive tray.
16. Confirm that the red STATUS LED for the back end module is off.
17. Connect the new SAS cables to the back end module on the CBLM or

CBLH and to the ENC of the drive tray connected to the CBLM or CBLH.
 

 
18. Connect the cables to the SAS adapters. When replacing the SAS adapter

for SAS cable DW-F800-SCQ1HA, install the cable into a new SAS
adapter, and then connect it to the ENC.

Note: When connecting the SAS cable DW-F800-SCQ1HA, be sure
the cable latch clicks and the cables are connected securely to the
SAS adapters.
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19. Route the cables appropriately.

Note: The SAS cable does not have to be routed when connecting
the DW-F800-SCQ1HA SAS adapter.

20. At the Replace Disk Board window, click Restore.
A progress bar shows the replacement status.

21. When the progress bar goes away and the completion message appears,
click Close.

22. Click the DKBs tab, and then check that the back end module whose
SAS cable you replaced is Normal.

23. Log out and close the Maintenance Utility window.

Replacing SAS cables on a drive tray
Replacing SAS cables for a drive tray requires you to block an ENC before
replacing the cables.

The following procedure describes how to replace SAS cables connected to a
drive tray. Wear a wrist strap connected to the storage system to prevent
part failures caused by static electricity. Do not remove the wrist strap until
you finish the procedure.

Procedure

1. Start the maintenance utility.
2. Click Hardware > Drive Box.
3. In the Drive Box window, click the ENCs tab.
4. To display the most recent status of the ENC, click Refresh.
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5. Click the ENC whose SAS cable you want to replace, and then click

Replace.
6. When the Replace ENC window opens, confirm that the ENC shown in

the window is the one to be replaced.
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7. Click Block.
8. Verify that the appropriate ENC is blocked.
9. Leave the Replace ENC window open, but do not click the Restore

button.
 

 
10. Confirm that the red ALARM LED on the ENC whose SAS cable you want to

replace is on.
11. Unroute the SAS cable connected to the drive tray.

Note: For SAS cable DW-F800-SCQ1HA, you do not have to
unroute the cable.

12. Remove the SAS cable from the ENC on the drive tray and from the ENC
on a drive tray connected to another drive tray.

13. For SAS cable DW-F800-SCQ1HA:
a. Open the lever securing the ENC. When the lever opens completely,

the ENC is completely pulled out.
b. Wait at least 20 seconds, and then re-insert the ENC until the right

and left levers close slightly, and then push the lever toward the ENC.
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14. Connect new SAS cables to the ENC on the drive tray(s).

Note: When connecting the SAS cable DW-F800-SCQ1HA, be sure
the cable latch clicks and that the cables are connected securely to
the SAS adapters.

 

 
15. Confirm that the red ALARM LED for the ENC is off.
16. Route the cables appropriately.
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Note: The SAS cable does not have to be routed when connecting
the DW-F800-SCQ1HA SAS adapter.

17. At the Replace ENC window, click Restore.
A progress bar shows the replacement status.

18. When the progress bar goes away and the completion message appears,
click Close.

19. Click the ENCs tab, and then check that the ENC whose SAS cable you
replaced is Normal.

1. Note: If the ENC status is NORMAL but the red ALARM LED does not
go out, contact the HDS Support Portal at https://
support.hds.com/en_us/contact-us.html.

20. Log out and close the Maintenance Utility window.
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Replacing cache flash memory

Before replacing cache flash memory (CFM), read the precautions and
understand the procedure for your CFM.

□ Blocking the CFM

□ Replacing the CFM

□ Restoring a CFM

□ Checking cache flash memory screws
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Blocking the CFM
Procedure

1. Start the maintenance utility.
2. Click Hardware > Controller Chassis.
3. In the Controller Chassis window, click the CFMs tab.
4. To display the most recent status of the CFM, click Refresh.

 

 
5. Confirm that the status of the CFM to be replaced is Warning.
6. Click the CFM to be replaced, and then click Replace.
7. When the Replace Cache Flash Memory window opens, confirm that

the CFM shown in the window is the one to be replaced, and then
clickBlock.
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8. Click Block.
9. Verify that the CFM is blocked and is ready for replacing.

10. Leave the Replace Cache Flash Memory window open, but do not click
the Restore button.
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Replacing the CFM

Before you begin
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Confirm that the storage system power is turned on.
• Use the maintenance utility to block the CFM.
• Confirm that the red STATUS LED for the CFM to be replaced is on.
• The red ALARM LED (CBSS/CBSL) or ALM LED (CBLM/CBLH) on the cache

flash memory (CFM) to be replaced is on.

Procedure

1. Loosen the blue screw securing the CFM.
2. Open the lever
3. Hold the CFM with both hands, and then pull it gently and remove it.
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4. With the lever opened completely, insert the new CFM all the way into

the slot.
5. Close the lever completely, and tighten the blue screw to secure the CFM.
6. Confirm that the red ALARM or ALM LED on the CFM is off.

Next steps
• Use the maintenance utility to restore (unblock) the CFM.

Restoring a CFM
In the maintenance utility:
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Procedure

1. In the Replace Cache Flash Memory window, click Restore.
A progress bar shows the replacement status.

2. When the progress bar goes away and the completion message appears,
clickClose.

3. Click the CFMs tab in the Controller Chassis window.
4. Verify that the status of the new CFM is Normal.

If necessary, click Refresh at the top-right of the window to update the
status of the window.

5. Log out and close the Maintenance Utility window.

Checking cache flash memory screws

Procedure

1. In the Alert Detail window of the maintenance utility, click Close.
2. In the left pane, click Controller Chassis.
3. Click the CFM tab of the maintenance utility to check the location of the

target CFM.
4. Click the target CFM, and then click Replace.

Maintenance Utility window for CBSS or CBSL
 

 
Maintenance Utility window for CBLM or CBLH
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5. Check that the target CFM is correct, and then click Block
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6. Check that the CFM is blocked and ready to be replaced. Do not click
Restore at this time.
 

 
7. Remove the front bezel for the CBLM/CBLH.

CBSS/CBSL CFM locations
 

 
CBLM/CBLH CFM locations
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8. If the screws of the target CFM are loose, push the CFM all the way in

and tighten the blue screws.
 

 
9. Attach the CBLM/CBLH front bezel.

10. In the Replace Cache Flash Memory window of the maintenance
utility, click Restore

11. When the completion message appears, click Close.
12. Log out of maintenance utility to close the window.
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Replacing a LAN blade

Before replacing a LAN blade, read the precautions and understand the
procedure for your LAN blade.

□ Blocking the controller

□ Replacing the LAN blade

□ Restoring the LAN blade
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Blocking the controller
Procedure

1. Start the maintenance utility.
2. Click Hardware > Controller Chassis.
3. In the Controller Chassis window, click the LANBs tab.
4. To display the most recent status of the LAN blade, click Refresh.

 

 
5. Confirm that the status of the LAN blade to be replaced is Warning.
6. Click the CTLs tab.
7. Click the Replace list and select the controller that contains the LAN

blade to be replaced.
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8. When the Replace Controller Board window opens, confirm that the

controller shown in the window is the one that contains the LAN blade to
be replaced.

9. Click Block.
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10. If the following window opens, click OK.

 

 
11. Confirm that the controller is blocked.
12. Leave the Replace Controller Board window open, but do not click the

Restore button.
 

 
13. Confirm that the red CTL ALM LED on the controller is on.

Replacing the LAN blade
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Before you begin
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Confirm that the storage system power is turned on.
• Use the maintenance utility to block the LAN blade.

• The red CTL ALM LED on the CBLM or CBLH controller is on.

Procedure

1. Remove the LAN cable from the user LAN port.
2. Release the controller:

a. Loosen the blue right and left screws on the lever of the controller to
be replaced.

b. Open the lever.

Note: The POWER, READY, WARNING, and ALARM LEDs might go off. If
the LED on the front goes off, check whether a component other
than the controller has normal status in the Maintenance Utility
window and continue the replacement. The green READY LED on
the front of the CBLM/CBLH goes on after restoring the controller
at the end of the replacement procedure.

3. Loosen the blue screw that secures the LAN blade.
4. Using both hands, pull out and remove the LAN blade.
5. Insert the new LAN blade into the slot, just before the "shield finger."

 

 
6. Gently push the new LAN blade all the way into the slot.
7. Tighten the blue screw to secure the LAN blade.
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8. Secure the controller.

a. Push in the controller all the way until the right and left levers close
completely.

b. Tighten the blue screw and secure the controller.
9. Confirm that the red CTL ALM LED on the controller is off.

10. Connect the LAN cable you removed to the user LAN port.

Next steps
• Use the maintenance utility to restore (unblock) the LAN blade.

Restoring the LAN blade
In the maintenance utility:

Procedure

1. In the Replace Controller Board window, click Restore.
A progress bar shows the replacement status.

Note: The restore operation can take up to 20 minutes to
complete. If a message states that the recovery failed, go to the
Customer Contact Us page at https://support.hds.com/en_us/
contact-us.html.

2. When the progress bar goes away and the completion message appears,
click Close.

3. Click the LANBs tab in the Controller Chassis window and confirm that
the status of the new LAN blade is Normal.
If necessary, click Refresh at the top-right of the window to update the
status in the window.

4. Confirm that the red CTL ALM LED is off at the controller that contains
new LAN blade.
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5. Log out and close the Maintenance Utility window.
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Replacing a backup module

Before replacing a backup module, read the precautions and understand the
procedure for the backup module.

□ Replacing a BKM

□ Replacing a BKMF

□ Checking BKM/BKMF screws
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Replacing a BKM
The following sections describe how to replace a BKM backup module.

Checking the BKM backup module

Before you begin
• Confirm that a backup module is installed in the backup module enclosure.
• Confirm that the storage system power is turned on.
• Confirm that the red STATUS LED on the backup module to be replaced is

on.
• Use the Dump tool to collect the storage system configuration information.

Procedure

1. Start the maintenance utility.
2. Click Hardware > Controller Chassis.
3. Click the BKMs tab.
4. To display the most recent status of the BKM, click Refresh.

 

 
5. Confirm that the status of the backup module to be replaced is Warning.
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Next steps

If Warning appears for BKM Status and ? appears for the Battery
Lifespan Remaining values of the batteries, resolve the Warning for BKM
Status so the ? returns to a numeral value.

Replacing the BKM backup module
Use the following procedure to replace the BKM backup module.

Procedure

1. Loosen the blue screw that secures the BKM.
2. Open the lever forward.
3. Using both hands, hold the body of the BKM, and then pull out and

remove the BKM.
4. With the lever of the BKM opened forward, insert the new BKM into the

slot.
 

 
5. Push the BKM all the way into the slot.
6. Close the lever and tighten the blue screw to secure the BKM.
7. Confirm that the green STATUS LED on the BKM is blinking.
8. In the BKMS tab of the maintenance utility, check that the status of the

BKM you replaced is Normal.
9. Log out and close the Maintenance Utility window

Replacing a BKMF
The following sections describe how to replace a BKMF backup module.

Replacing a backup module 271
Service Guide for VSP Gx00 and VSP Fx00 Models



Blocking a BKMF

Before you begin
• Confirm that a backup module is installed in the backup module enclosure.
• Confirm that the storage system power is turned on.
• Confirm that the red STATUS LED on the backup module to be replaced is

on.
• Use the Dump tool to collect the storage system configuration information.

Procedure

1. Start the maintenance utility.
2. Click Hardware > Controller Chassis.
3. Click the BKMFs tab.
4. To display the most recent status of the BKMF, click Refresh.

 

 
5. Confirm that the status of the backup module to be replaced is Warning.

If Warning appears for BKMF Status and ? appears for the Battery
Lifespan Remaining values of the batteries, resolve the Warning for
BKMF Status so the ? returns to a numeral value.
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Replacing the BKMF backup module

Before you begin
• Wear a wrist strap connected to the storage system to prevent part

failures caused by static electricity. Do not remove the wrist strap until you
finish the procedure.

• Confirm that the storage system power is turned on.
• Confirm that the red STATUS LED on the backup module to be replaced is

on.
• Use the Dump tool to collect the storage system configuration information.
• Use the maintenance utility to verify the backup module status.

Procedure

1. Loosen the blue screw that secures the backup module.
2. Open the lever forward.
3. Open the lever.
4. Hold the backup module with both hands, and then pull it out and

remove it.
5. Hold the latch of the cable connector of the battery to be installed in the

backup module and remove the connector from the socket.
6. Remove all batteries that are installed.

A maximum of two batteries can be installed.
7. Loosen the blue screw on the rear side of the new backup module.
8. Slide the top panel of the new backup module and remove it.
9. In the new backup module, install all batteries you removed and route

the cables along the groove of the backup module.
If you removed one battery, install the battery in the front (fan side) of
the storage system. Route the cables to avoid bending the cables.

10. Connect the cable connector to the socket.
11. Slide the top panel of the backup module and attach it.
12. Tighten the blue screw on the rear panel of the backup module.
13. With the lever of the backup module opened forward, insert the new

backup module into the slot.
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14. Push all the way into the slot.
15. Close the lever and tighten the blue screw to secure the backup module.
16. Confirm that the green STATUS LED on the BKMF is blinking.
17. In the BKMFs tab of the maintenance utility, check that the status of the

backup module you replaced is Normal.
If necessary, click Refresh at the top-right of the window to update the
status.

18. Log out and close the Maintenance Utility window.

Checking BKM/BKMF screws

Procedure

1. In the Alert Detail window of the maintenance utility, click Close.
2. In the left pane, click Controller Chassis to check the locations of the

target backup modules (BKM/BKMF).
Maintenance Utility window for CBSS or CBSL
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Maintenance Utility window for CBLM or CBLH
 

 

BKM Location on CBSS or CBSL
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BKMF Location on CBLM or CBLH
 

 
Remove the front bezel for CBLM/CBLH.

3. If the screws of the target backup modules are loose, push the backup
modules all the way in and tighten the blue screws.
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4. Attach the CBLM/CBLH front bezel.
5. Log out of maintenance utility to close the window.
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Replacing a PCIe module

The following sections describe how to replace a PCIe module.

□ Blocking a PCIe module

□ Replacing a PCIe module

□ Restoring a PCIe module
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Blocking a PCIe module

Before you begin
• Confirm that the storage system power is turned on.
• Use the Dump tool to collect the storage system configuration information.
• The red STATUS LED is on at the PCIe module to be replaced.

Procedure

1. Start the maintenance utility.
2. Click Hardware > Controller Chassis.
3. Click the PECBs tab.
4. To display the most recent status of the PCIe module click Refresh.

 

 
5. Confirm that the status of the PCIe module to be replaced is Warning.
6. Select the PCIe module to be replaced, and click Replace.
7. Click Block.
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8. Check that the PCIe module is blocked and becomes ready for replacing.

Do not click Restore at this time.
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Replacing a PCIe module

Procedure

1. Disconnect the cable from the PCIe module to be replaced.
2. Loosen the two blue screws that secure the PCIe module.
3. Holding the blue screw, pull out and remove the PCIe module. Keep the

module straight to prevent to avoid jostling the components above and
below.

4. Insert the new PCIe module into the slot just before the "shield finger."
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5. Gently push the front of the PCIe module until the module is inserted all

the way into the slot.
 

 
6. Tighten the two blue screws to secure the PCIe module.
7. Connect the cable to the new PCIe module.
8. Check that the red STATUS LED on the PCIe module is off.

Restoring a PCIe module

Procedure

1. At the Replace PCIe Channel Board window, click Restore.
2. When the completion message appears, click Close.
3. Click the PECBs tab and confirm that the status of the new PCIe module

is Normal. If necessary, click Refresh at the top-right of the window to
update the status of the window.

4. Log out and close the Maintenance Utility window.
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Replacing a PCIe switch board

The following sections describe how to replace a PCIe switch board.

□ Blocking a PCIe switch board

□ Replacing a PCIe switch board

□ Restoring a PCIe switch board
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Blocking a PCIe switch board

Before you begin
• Confirm that the storage system power is turned on.
• Use the Dump tool to collect the storage system configuration information.
• The red STATUS LED is on at the PCIe switch board to be replaced.
• Dropping the PCIe switch board can cause injury. Be aware of the red line

on the top of the controller when sliding out the controller past this mark
and always keep a firm hold on the PCIe switch board.

 

 

Procedure

1. Start the maintenance utility.
2. Click Hardware > Channel Board Box.
3. Click the SWPKs tab.
4. To display the most recent status of the PCIe switch board, click

Refresh.
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5. Confirm that the status of the PCIe switch board to be replaced is

Warning.
6. Select the PCIe switch board to be replaced, and click Replace.
7. Click Block.
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8. Check that the PCIe switch board is blocked and becomes ready for

replacing. Do not click Restore at this time.
 

 

Replacing a PCIe switch board

Procedure

1. Loosen the blue screws on the PCIe switch board and open the lever.
2. If the lever opens completely, the PCIe switch board is pulled out.
3. Hold the body of the PCIe switch board with both hands and remove it.
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4. Open the PCIe switch board lever completely.
5. Install the PCIe switch board in the set position until its lever closes

slightly, and then push the lever toward the PCIe switch board.
6. Tighten the blue screw and secure the PCIe switch board.

 

 
7. Confirm that the red STATUS LED is off at the PCIe switch board.
8. Attach the front bezel.

Restoring a PCIe switch board

Procedure

1. At the Replace PCIe switch board window, click Restore.
2. When the completion message appears, click Close.

Replacing a PCIe switch board 289
Service Guide for VSP Gx00 and VSP Fx00 Models



3. Click the SWPKs tab, and then check that the replaced PCIe switch
board is Normal.

4. Log out and close the Maintenance Utility window.
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Replacing a PCIe cable connector

The following sections describe how to replace a PCIe cable connector.

□ Blocking a PCIe cable connector

□ Replacing a PCIe cable connector

□ Restoring a PCIe cable connector
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Blocking a PCIe cable connector

Before you begin
• Confirm that the storage system power is turned on.
• Use the Dump tool to collect the storage system configuration information.
• The red STATUS LED is on at the PCIe cable connector to be replaced.

Procedure

1. Start the maintenance utility.
2. Click Hardware > Channel Board Box.
3. Click the PCPs tab.
4. To display the most recent status of the PCIe cable connector click

Refresh.
 

 
5. Confirm that the status of the PCIe cable connector to be replaced

isWarning.
6. Select the PCIe cable connector to be replaced, and click Replace.
7. Click Block.
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8. Check that the PCIe cable connector is blocked and becomes ready for

replacing. Do not click Restore at this time.
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Replacing a PCIe cable connector

Procedure

1. Disconnect the cable from the PCIe cable connector to be replaced.
2. Press the latch on the PCIe cable connector inward (2), and then open

the lever (1).
3. Pull out and remove the PCIe cable connector
4. With the PCIe cable connector lever opened completely, insert the new

PCIe cable connector into the slot location of the host port expansion
chassis.

5. Push the PCIe cable connector all the way into the slot. Stop when the
latch of the PCIe cable connector clicks.
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6. Connect the cable to the new PCIe cable connector.
7. Confirm that the red STATUS LED is off at the PCIe cable connector.

Restoring a PCIe cable connector

Procedure

1. At the Replace PCIe-cable Connecting Package window, click
Restore. A progress bar shows the replacement status.

2. When the progress bar goes away and the completion message appears,
click Close.

3. Click the PCPs tab in the Channel Board Box window and confirm that
the status of the new PCIe cable connector is Normal.

4. Log out and close the Maintenance Utility window.
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Replacing a PCIe cable

The following sections describe how to replace a PCIe cable.

□ Blocking a PCIe cable

□ Replacing the PCIe cable

□ Restoring a PCIe module
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Blocking a PCIe cable
To replace a PCIe cable, block a PCIe module, and then the replace PCIe
cables.

Before you begin
• Confirm that the storage system power is turned on.
• Use the Dump tool to collect the storage system configuration information.
• The red STATUS LED is on at the PCIe module whose PCIe cable you want

to replace.

Procedure

1. Start the maintenance utility.
2. Click Hardware > Controller Chassis.
3. Click the PECBs tab.
4. To display the most recent status of the PCIe module click Refresh.

 

 
5. Check the status. Then select the module whose PCIe cable you want to

replace and click Replace.
6. Click Block.
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7. Check that the PCIe module is blocked and becomes ready for replacing.

Do not click Restore at this time.
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Replacing the PCIe cable

Procedure

1. Remove the PCIe cable from the PCIe module on the CBLH and from the
PCIE cable connector on the host port expansion chassis connected to
the CBLH.

2. Loosen the two blue screws that secure the PCIe module.
3. Hold the blue screw, and then pull out the PCIe module slightly.
4. Wait 30 seconds, and then gently insert the PCIe module all the way into

the slot.
5. Tighten the two blue screws to secure the PCIe module.
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6. Connect new PCIe cables to the PCIe module on the CBLH and to the

PCIe cable connector of the host port expansion chassis connected to the
CBLH. Check that cable latch clicks and that the cables are connected
securely.

Restoring a PCIe module

Procedure

1. At the Replace PCIe Channel Board window, click Restore.
2. When the completion message appears, click Close.
3. Click the PECBs tab and confirm that the status of the new PCIe module

is Normal. If necessary, click Refresh at the top-right of the window to
update the status of the window.

4. Log out and close the Maintenance Utility window.
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Replacing a NAS module

Replacing a NAS module procedure involves blocking the NAS module,
replacing the component, and restoring the NAS module back to normal
working condition.

□ Blocking a NAS module

□ Replacing the NAS module

□ Restoring a NAS module
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Blocking a NAS module

Before you begin
• Confirm that the storage system power is turned on.
• Use the Dump tool to collect the storage system configuration information.
• The red STATUS LED is on at the NAS module to be replaced.

Procedure

1. Start the maintenance utility.
2. Click Hardware > Controller Chassis.
3. Click the CHBs tab.
4. To display the most recent status of the PCIe module, click Refresh.

 

 
5. Check that the status of the failed NAS module is Warning.
6. Click the NAS module where the failure occurred, and then click

Replace.
7. Click Block.
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8. Check that the NAS module is blocked and becomes ready for replacing.

Do not click Restoreyet.
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Replacing the NAS module

Procedure

1. Remove the cables connected to the NAS module. Mark the port from
where the cable was removed.

2. Loosen the two blue screws that secure the NAS module and open the
levers.

3. Hold the NAS module with both hands, keep it straight, and gently pull it
forward. Keep the NAS module level to avoid shocking any parts.

Note: The heat sinks can be hot on a NAS module that is removed
from the storage system. Avoid touching these hot parts when
removing the NAS module.
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4. Install the NAS module:

a. Remove the Small Form-Factor Pluggable (SFP+) from the NAS
module.

b. With the lever in an open position, insert the replacement NAS module
into the slot. Push the NAS module all the way into the slot and close
the lever.

c. Tighten the two blue screws to secure the NAS module.
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d. Insert the SFP+ into the NAS module.

5. On the NAS module, connect the cable to the same port before replacing
the NAS module. Verify the cable clicks into place.

Restoring a NAS module

Procedure

1. Click Restore.
2. When the completion message appears, click Close.
3. Click the CHBs tab, and then confirm that the NAS module is Normal.
4. After completing the work, log out and close the Maintenance Utility

window.
5. Migrate the EVS manually from the operating NAS module to the other

NAS module.

Related tasks

• EVS migration after servicing nodes on page 102
• EVS migration after servicing nodes on page 102
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General maintenance

This chapter provides general maintenance procedures.

□ Periodic maintenance

□ Cleaning the storage system

□ Inspecting fans

□ Battery replacement guidelines

□ Checking for loose or damaged cables or connectors

□ Restarting the storage system

□ Storing the storage system
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Periodic maintenance
The following table describes the periodic maintenance procedures you can
perform to extend the life of your storage system. Inspect and clean the
storage system regularly according to the operation environment.

Maintenance Interval Approximate time to perform
procedure

Clean the storage system Once a year 5 minutes

Inspect the fan Once a year 5 minutes

Replace the battery Every 3 years 10 minutes

Cleaning the storage system
When cleaning the storage system, check whether the system's air vents are
clogged by dust. If they are clogged, remove the dust with a vacuum cleaner
or wipe the dust using a dry cloth.

Keep the front bezel and rear panel clean. Otherwise, storage system
ventilation deteriorates and the inside temperature might rise, causing a
failure or fire.

Do not move the storage system during cleaning.

Procedure

1. Clean the outside of the front bezel.
2. Insert the key in the front bezel and turn in the direction shown by the

arrow to unlatch the bezel.

Caution: Attach or remove the front bezel carefully to avoid
pinching your fingers. Do not touch "live parts;" otherwise, you
can receive an electric shock.

3. Remove the front bezel.
4. Clean the internal surfaces of the front bezel.
5. Attach the front bezel.
6. Turn the key in the direction shown by the allow to latch the front bezel.
7. Clean the external surfaces of the rack.

Inspecting fans
Inspect the fans when storage system power is turned on.
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Caution: Storage system fans rotate at high speed. Exercise extreme caution
to avoid getting anything caught in the fan and to prevent injury.

Procedure

1. Gain access to the inside of the rack.
2. Open the front bezel of the storage system.
3. Confirm that the storage system fans are rotating
4. Close the front bezel, and then close the rack.

Battery replacement guidelines
Each controller contains a sealed battery that provides backup power to
cache memory. You must replace the battery every three years.

Note: Do not disassemble the battery; otherwise, you could get burned or
receive a shock.

If the storage system does not receive power for more than six months, the
battery can become discharged and possibly damaged. To avoid this
situation, charge the battery for more than three hours at least once every
six months.

Checking for loose or damaged cables or connectors
It is good practice to check cables for damage on a periodic basis. Confirm
that all cables and cable connectors are in good condition and connected
securely to the appropriate interfaces.

Restarting the storage system
Before restarting the storage system, wait at least one minute with the main
switch off (amber POWER LED is off).

Storing the storage system
If the storage system does not receive power for more than six months, the
battery can become discharged and possibly damaged. To avoid this
situation, charge the battery for more than three hours at least once every
six months.

Note: Do not store the equipment in an environment with temperatures of
104ºF (40ºC) or higher because battery life will be shortened.
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Troubleshooting the storage system

Proper maintenance of the storage system is important for maintaining high
performance. The component LEDs provide the operating status of the
storage system and alert the user of any troubleshooting and component
replacement activities.

□ General troubleshooting

□ Checking hardware replacement alerts

□ Troubleshooting Hitachi Device Manager - Storage Navigator

□ Troubleshooting NAS Manager

□ Troubleshooting the maintenance utility

□ Background service log

□ Dump tool

□ Checking the event log when NAS modules are installed

□ Checking SIM alerts

□ Turning the storage system on or off using the maintenance utility

□ Using LEDs to diagnose problems

□ Troubleshooting related to SMI-S provider startup setting

□ Troubleshooting SMI-S
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General troubleshooting

Correct values for the storage system IP address
Set appropriate value IP address, subnet mask, and default gateway settings
for the storage system for your environment.

IPv4 default value
Controller 1:
Controller 2:
IP Address: 192.168.0.16
Subnet Mask: 255.255.255.0
Default gateway: 0.0.0.0
Controller board 2:
IP Address: 192.168.0.17
Subnet Mask: 255.255.255.0
Default gateway: 0.0.0.0

IPv6 default value
Controller 1:
IP Address: Auto
Controller 2:
IP Address: Auto

DHCPv4 configuration for storage systems
The storage system can be configured to use the DHCPv4 server protocol.
When using the DHCPv4 server, configure the storage system to use a static
IP address.

If the storage system does not receive an IP address from a DHCP server
when it is configured for DHCP, Hitachi Device Manager - Storage Navigator
cannot connect to the storage system. Contact your network administrator,
and review the DHCPv4 server settings.

Default value
DHCPv4: Off (Static IP Address)

IP address being used by other storage systems or hosts
If the storage system is using the same IP address is used by other devices,
Hitachi Device Manager - Storage Navigator cannot connect to the storage
system.

Assign an IP address to the storage system that is not used by another
device.
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IP address configuration for the host
Use Hitachi Device Manager - Storage Navigator to set the IP address, subnet
mask, and default gateway that the host can use to communicate with the
storage system.

TCP/UDP port filtering being performed on the network switch
The default TCP port number for Hitachi Device Manager - Storage Navigator
is 2000.

Set an appropriate value for the network environment of the customer.

[default port number]: 2000 (standard)
28355 (secure)

Change the port number in network environments using Cisco SIP phones.

Searching storage system across IPv6 routers
The Auto Search Storage system of IPv6 uses link-local scope multicast.

The IPv6 router is unable to transfer this multicast to other local links, so the
IPv6 router cannot search storage systems across the IPv6 router. The Auto
Search Storage system of IPv6 uses link-local scope multicast. The IPv6
router cannot transfer this multicast to other local links, so the IPv6 router is
unable to search storage systems across the IPv6 router. For different local
links, register the storage system using a static IP address search.

Checking hardware replacement alerts
The Maintenance Utility window displays alerts when hardware components
need to be replaced.

Procedure

1. In the Maintenance Utility window, click Hardware > Target
Hardware.

2. Click the Status link for the hardware.
3. Open the Related Alerts window for the appropriate hardware

components, as listed in the following tables.

VSP G200 part Main window Tab Status link

Controller chassis Controller Chassis
window

Drives Status

CTLs CTL Status

Fan Status

CHBs Status

SFP Status1
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VSP G200 part Main window Tab Status link

BKMs BKM Status

Battery Status

CFMs Status

PSs Status

Small Form-Factor
Pluggable window

N/A SFP Status

Drive tray Drive Box window Drives Status

ENCs Status

PSs Status

Note:

1. An SFP can be installed in a CBLH only.

VSP G400,
G600VSP F400,

F600 part
Main window Tab Status link

Controller chassis Controller Chassis
window

Drives Status

CTLs CTL Status

CMG Status

BKMFs BKMF Status

Battery Status

CFMs Status

CHBs Status

SFP Status

If SFP Status is clicked,
the Small Form factor
Pluggable window opens.
If SFP Status is clicked
again, the Related Alerts
window opens.

CHBs Cache Memory Status (NAS
module)

This appears when the
firmware for NAS modules
is installed.

If Cache Memory Status
(NAS Module) is clicked,
the NAS Module Cache
Memory window opens. If
NAS Module Cache
Memory Status is clicked
again, the Related Alerts
window opens.

PECBs Status

A PECB can be installed in
a CBLH only.
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VSP G400,
G600VSP F400,

F600 part
Main window Tab Status link

DKBs Status

LAN boards Status

PSs Status

Small Form-Factor
Pluggable window

N/A SFP Status

Drive tray Drive Box window Drives Status

ENCs Status

PSs Status

Host port expansion
chassis

Channel Board Box
window

CHBs Status

SFP Status

SWPKs Status

Fans Status

PCPs Status

PS SFP Status

Small Form-Factor
Pluggable window

N/A SFP Status

NAS module

This is displayed
when the firmware
for NAS modules is
installed.

Main window - NAS Module Status window Unified Hypervisor

Hypervisor Network Module

NAS Unified Firmware

The description of Status is listed in the following tables.

Status Part frame color Description

 Normal N/A Indicates normal status.

 Warning Amber
• Possible parts failure.
• Possible parts failure due

to other related parts.
• Failure caused by other

related parts. Replace
failed part.

None NAS Module Status-limited

Any of the following failures
occur:
• NAS module hardware

fails.
• NAS-module-related

software is experiencing
issues.

• Warning is shown due to
possible failure of other
components. Change part
to return status to Active.
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Status Part frame color Description

 Failed Red A part failed.

Drive Status-limited

• Possible parts failure.
• Possible parts failure due

to other related parts.
• Failure caused by other

related parts. Replace
failed part.

Hypervisor Network
module status-limited

Failure occurred in Hypervisor
Network module.

 Failed (NAS Unified
Firmware)

None NAS Unified firmware
status-limited

Failure occurred in NAS
Unified firmware.

 Failed (hardware) None Unified Hypervisor status-
limited

Unified Hypervisor is blocked
due to hardware factors.

 Failed (software) None Unified Hypervisor status-
limited

Unified Hypervisor is blocked
due to software factors.

 Failed (service) None NAS Unified firmware
status-limited

Failure occurred in the file
storage function of NAS
Unified firmware.

 Failed (unknown) None Unified Hypervisor status-
limited

Unified Hypervisor is blocked.

 Blocked Red Only parts requiring blockage
instruction by using
Maintenance Utility are
displayed and in an
exchangeable status.

 Not fix Amber SFP Status-limited

The classification is in an
undetermined status.
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Status Part frame color Description

 Warning (Port n failed) Amber Drive Status-limited

The drive port is in a failure
status.

n: Failure drive port number

 Copying n % (TYPE to
DRIVE)

Amber Drive Status-limited

Copying is in progress.

n: Copy progress rate

TYPE: Correction copy,
Copy back, Dynamic
sparing, Drive copy

DRIVE: Copy destination
drive location (If the drive is a
copy destination drive in
Correction copy, DRIVE is
displayed as this Drive.)

When multiple copy statuses
exist, a line break is added to
every copy status line, and
then the information is
displayed.

 Copying n % (TYPE to
DRIVE)

Amber Drive Status-limited

Copying is in progress.

n: Copy progress rate

TYPE: Copy back, Dynamic
sparing, Drive copy

DRIVE: Copy source drive
location

When multiple copy statuses
exist, a line break is added to
every copy status line, and
then the information is
displayed.

 Pending (TYPE to DRIVE) Amber Drive Status-limited

Copying is suspended.

TYPE: Correction Copy,
Copy back, Dynamic
sparing, Drive copy

DRIVE: Copy destination
drive location (If the drive is a
copy destination drive in
Correction copy, DRIVE is
displayed as this Drive.)
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Status Part frame color Description

When multiple copy statuses
exist, a line break is added to
every copy status line, and
then the information is
displayed.

 Pending (TYPE to DRIVE) Amber Drive Status-limited

Copying is suspended.

TYPE: Copy back, Dynamic
sparing, Drive copy

DRIVE: Copy source drive
location

When multiple copy statuses
exist, a line break is added to
every copy status line, and
then the information is
displayed.

 Copy incomplete Amber Drive Status-limited

Copying is incomplete.

 Reserved Amber Drive Status-limited

The spare disk is unusable.

 Installing None NAS Unified Firmware
Status-limited

NAS Unified firmware is being
installed.

None NAS Module Status-limited

Unified Hypervisor is not
starting.

 Active None NAS Module Status-limited

This indicates normal status.

Unified Hypervisor Status-
limited

Unified Hypervisor started
completely.

Hypervisor Network
Module Status-limited

Hypervisor Network Module
operates normally.

NAS Unified Firmware
Status-limited
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Status Part frame color Description

NAS Unified firmware is
normal.

 Active (Not Redundant) None NAS Unified Firmware
Status-limited

NAS Unified firmware
detected a failure in either
cluster.

 Active (Warning) None NAS Unified Firmware
Status-limited

NAS Unified firmware
detected trouble in either
cluster.

 Inactive None NAS Module Status-limited

No trouble occurs, but start-
up is not completed.

 Initial None Unified Hypervisor Status-
limited

Unified Hypervisor is
initialized.

 Failure Processing None Unified Hypervisor Status-
limited

Unified Hypervisor is being
blocked.

NAS Unified Firmware
Status-limited

NAS Unified firmware is being
blocked.

 Failure Processing
(Stopped)

None Hypervisor Network
Module Status-limited

Hypervisor Network Module is
stopped.

 Failure Processing
(Restarting)

None Hypervisor Network
Module Status-limited

Hypervisor Network Module is
restarting.

 Processing None NAS Unified Firmware
Status-limited

NAS Unified firmware is
starting or stopping. (Case 2)

 Starting None Unified Hypervisor Status-
limited
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Status Part frame color Description

Unified Hypervisor is starting.

NAS Unified Firmware
Status-limited

NAS Unified firmware is
starting. (Case 1)

 Starting (Service) None NAS Unified Firmware
Status-limited

The file storage function of
NAS Unified firmware is
starting.

 Starting (NVRAM
Restoring)

None NAS Unified Firmware
Status-limited

NAS Unified firmware is
loading the configuration
definition.

 Stopping None Unified Hypervisor Status-
limited

Unified Hypervisor is
stopping.

 Stopping (Service) None NAS Unified Firmware
Status-limited

The file storage function of
NAS Unified Firmware is
stopping.

 Stopped None Unified Hypervisor Status-
limited

Unified Hypervisor is stopped.

NAS Unified Firmware
Status-limited

NAS Unified firmware is
stopped.

 Stopped (Service) None NAS Unified Firmware
Status-limited

The file storage function of
NAS Unified firmware is
stopped.

VSP G800VSP
F800HM800H Part Main window Tab Status link

Controller chassis Controller Chassis
window

Drives Status

CTLs CTL Status

CMG Status
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VSP G800VSP
F800HM800H Part Main window Tab Status link

BKMFs BKMF Status

Battery Status

CFMs Status

CHMs Status

CHBs Status

SFP Status

CHBs Cache Memory Status (NAS
module)
This appears when the
firmware for NAS modules
is installed.
If Cache Memory Status
(NAS Module) is clicked,
the NAS Module Cache
Memory window opens. If
NAS Module Cache
Memory Status is clicked
again, the Related Alerts
window opens.

PECBs Status

DKBs Status

LAN boards Status

PSs Status

Small Form-Factor
Pluggable window

— SFP Status

Drive tray Drive Box window Drives Status

ENCs Status

PSs Status

Host port expansion
chassis

Channel Board Box
window

CHBs Status

SFP Status

Host port expansion
chassis

Channel Board Box
window

SWPKs Status

Host port expansion
chassis

Channel Board Box
window

Fans Status

Host port expansion
chassis

Channel Board Box
window

PCPs Status

Host port expansion
chassis

Channel Board Box
window

PS SFP Status

Host port expansion
chassis

Small Form-Factor Pluggable window

NAS module

This is displayed
when the firmware
for NAS modules is
installed.

Main window - NAS Module Status window Unified Hypervisor

Hypervisor Network Module

NAS Unified Firmware
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Status Part frame color Description

 Normal N/A Indicates normal status.

 Warning Amber
• Possible parts failure.
• Possible parts failure due

to other related parts.
• Failure caused by other

related parts. Replace
failed part.

None NAS Module Status-limited

Any of the following failures
occur:
• NAS module hardware

fails.
• NAS module related

software is experiencing
issues.

• Warning is shown due to
possible failure of other
components. Change part
to return status to Active.

 Failed Red A part failed.

Drive Status-limited

• Possible parts failure.
• Possible parts failure due

to other related parts.
• Failure caused by other

related parts. Replace
failed part.

Hypervisor Network
module status-limited

Failure occurred in Hypervisor
Network module.

 Failed (NAS Unified
Firmware)

None NAS Unified firmware
status-limited

Failure occurred in NAS
Unified firmware.

 Failed (hardware) None Unified Hypervisor status-
limited

Unified Hypervisor is blocked
due to hardware factors.

 Failed (software) None Unified Hypervisor status-
limited

Unified Hypervisor is blocked
due to software factors.
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Status Part frame color Description

 Failed (service) None NAS Unified firmware
status-limited

Failure occurred in the file
storage function of NAS
Unified firmware.

 Failed (unknown) None Unified Hypervisor status-
limited

Unified Hypervisor is blocked.

 Blocked Red Only parts requiring blockage
instruction by using
Maintenance Utility are
displayed and in an
exchangeable status.

 Not fix Amber SFP Status-limited

The classification is in an
undetermined status.

 Warning (Port n failed) Amber Drive Status-limited

The drive port is in a failure
status.

n: Failure drive port number

 Copying n % (TYPE to
DRIVE)

Amber Drive Status-limited

Copying is in progress.

n: Copy progress rate

TYPE: Correction copy,
Copy back, Dynamic
sparing, Drive copy

DRIVE: Copy destination
drive location (If the drive is a
copy destination drive in
Correction copy, DRIVE is
displayed as this Drive.)

When multiple copy statuses
exist, a line break is added to
every copy status line, and
then the information is
displayed.

 Copying n % (TYPE to
DRIVE)

Amber Drive Status-limited

Copying is in progress.

n: Copy progress rate

TYPE: Copy back, Dynamic
sparing, Drive copy
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Status Part frame color Description

DRIVE: Copy source drive
location

When multiple copy statuses
exist, a line break is added to
every copy status line, and
then the information is
displayed.

 Pending (TYPE to DRIVE) Amber Drive Status-limited

Copying is in a suspended
status.

TYPE: Correction Copy,
Copy back, Dynamic
sparing, Drive copy

DRIVE: Copy destination
drive location (If the drive is a
copy destination drive in
Correction copy, DRIVE is
displayed as this Drive.)

When multiple copy statuses
exist, a line break is added to
every copy status line, and
then the information is
displayed.

 Pending (TYPE to DRIVE) Amber Drive Status-limited

Copying is in a suspended
status.

TYPE: Copy back, Dynamic
sparing, Drive copy

DRIVE: Copy source drive
location

When multiple copy statuses
exist, a line break is added to
every copy status line, and
then the information is
displayed.

 Copy incomplete Amber Drive Status-limited

Copying is in an incomplete
status.

 Reserved Amber Drive Status-limited

The spare disk is in an
unusable status.

 Installing None NAS Unified Firmware
Status-limited
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Status Part frame color Description

NAS Unified firmware is being
installed.

None NAS Module Status-limited

Unified Hypervisor is not
starting.

 Active None NAS Module Status-limited

This indicates normal status.

Unified Hypervisor Status-
limited

Unified Hypervisor started
completely.

Hypervisor Network
Module Status-limited

Hypervisor Network Module
operates normally.

NAS Unified Firmware
Status-limited

NAS Unified firmware is
normal.

 Active (Not Redundant) None NAS Unified Firmware
Status-limited

NAS Unified firmware
detected a failure in either
cluster.

 Active (Warning) None NAS Unified Firmware
Status-limited

NAS Unified firmware
detected trouble in either
cluster.

 Inactive None NAS Module Status-limited

No trouble occurs, but start-
up is not complete.

 Initial None Unified Hypervisor Status-
limited

Unified Hypervisor is
initialized.

 Failure Processing None Unified Hypervisor Status-
limited
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Status Part frame color Description

Unified Hypervisor is being
blocked.

NAS Unified Firmware
Status-limited

NAS Unified firmware is being
blocked.

 Failure Processing
(Stopped)

None Hypervisor Network
Module Status-limited

Hypervisor Network Module is
stopped.

 Failure Processing
(Restarting)

None Hypervisor Network
Module Status-limited

Hypervisor Network Module is
restarting.

 Processing None NAS Unified Firmware
Status-limited

NAS Unified firmware is
starting or stopping. (Case 2)

 Starting None Unified Hypervisor Status-
limited

Unified Hypervisor is starting.

NAS Unified Firmware
Status-limited

NAS Unified firmware is
starting. (Case 1)

 Starting (Service) None NAS Unified Firmware
Status-limited

The file storage function of
NAS Unified Firmware is
starting.

 Starting (NVRAM
Restoring)

None NAS Unified Firmware
Status-limited

NAS Unified firmware is
loading the configuration
definition.

 Stopping None Unified Hypervisor Status-
limited

Unified Hypervisor is
stopping.

 Stopping (Service) None NAS Unified Firmware
Status-limited
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Status Part frame color Description

The file storage function of
NAS Unified Firmware is
stopping.

 Stopped None Unified Hypervisor Status-
limited

Unified Hypervisor is stopped.

NAS Unified Firmware
Status-limited

NAS Unified firmware is
stopped.

 Stopped (Service) None NAS Unified Firmware
Status-limited

The file storage function of
NAS Unified firmware is
stopped.

4. When the Related Alerts window opens, check for alerts that indicate
hardware that needs to be replaced. The following window shows an
example.
 

 
Only the alerts including the action codes of the specified parts and the
related parts are displayed. To check the action codes, click the character
string in the Alert ID column to open an Alert Detail window. The
following window shows an example.
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The Related Alerts window shows a maximum of 256 alerts. Alerts
detected one hour or more before the most recent alert are not
displayed. In this case, see the Alert window.

Troubleshooting Hitachi Device Manager - Storage
Navigator

Troubleshooting installation

Failure Recovery action

The installation fails and the message

is displayed.

Operate according to the message that has been displayed
in the installer and the recovery action.

Check the status of the background services of Device
Manager - Storage Navigator to take actions (see 
Background service log on page 344).

The installation success message is

displayed. However, the Storage

Check the status of the background services of Device
Manager - Storage Navigator and take appropriate action.

You cannot collect dump files using the Dump tool.
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Failure Recovery action

Device List will not run or cannot

register the storage system.

Collect the target files manually (see Collecting dump files
manually on page 380).

The SVP is connected to the network

switch, but cannot access Device

Manager - Storage Navigator on the

SVP through the network switch.

Check that the network cable is connected securely.

Check that the network switch is not configured to block
the SVP connection.

Device Manager - Storage Navigator

cannot be installed because its files

and folders (for example, C:\Mapp)

were deleted.

Install Device Manager - Storage Navigator using the SVP
firmware media that corresponds to this version as the
version of Device Manager - Storage Navigator you want to
install.

The installation failed due to error

"21443-200027" and the error detail

code "1072" is displayed.

Install Device Manager - Storage Navigator again.

If the error occurs repeatedly, start the SVP again, and
then install Device Manager - Storage Navigator again.

Troubleshooting the SVP initial setting command

Failure Recovery Action

The initial setting command was

executed but failed, and a message

was displayed.

Operate according to the message that has been displayed

in the initial setting command.

The initial setting icompleted normally.

However, the Storage Device List will

not run or cannot register the storage

system.

Check the status of the Device Manager - Storage
Navigator background services and take appropriate action
(see Background service log on page 344).

If using the maintenance port, a communication error
might occur in the SVP connected to the management
port. Check the network status of the maintenance port.

Collect the dump files (see Using the Dump tool on
page 379).

If the collection fails, collect the target files manually (see 
Collecting dump files manually on page 380).

Troubleshooting the Storage Device List

For messages that are not described in the following table, go to <SVP
Installation Directory>\wk\supervisor\sdlist\help\
sdl_message.html.

Message ID Description Recovery Action

21041-006002 Clicking the storage
system in the Storage
Device List window
caused the error, and
Hitachi Device Manager -

The default browser is not defined.
Specify your browser as the default
browser (refer to the documentation for
your browser) and retry.
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Message ID Description Recovery Action

Storage Navigator cannot
start.

21041-006005 Starting the Storage
Device List caused the
error, and the Storage
Device List cannot start.

Failed to connect to the Supervisor
service (DKCMan/MAPPAppServer/
MAPPWebServer). From the Windows start
menu, click Control Panel > System and
Security > Administrative Tools >
Services, and confirm that the DKCMan,
MAPPAppServer, and MAPPWebServer
services started. Start the Storage Device
List again.

If the status of DKCMan, MAPPAppServer,
and MAPPWebServer did not start, right-
click the service and click Start, or reboot
the SVP.

21513-008004 [Warning] was displayed in
the storage system icon.

Clicking [Warning]
displayed "21513-008004"
in the Status field.

Another SVP is connected to the storage
system.

Stop the services of the storage system
running on the PC whose IP address is
shown in the troubleshooting code
TRCOMM000004 of the background
service log.

21513-008005 [Warning] was displayed in
the storage system icon.

Clicking [Warning]
displayed "21513-008005"
in the Status field.

The IP address for each CTL configured in
the Add System window and the CTL
number set for GUM are not identical.

Correct the IP address setting for each
controller in the Storage Device List
window.

21513-008006 [Warning] was displayed in
the storage system icon.

Clicking [Warning]
displayed "21513-008006"
in the Status field.

The storage system model configured in
the Add System window is different than
the model that was specified during
setup.

Delete the storage system from the
Storage Device List and re-register the
storage system with the correct model.

21513-008007 [Warning] was displayed in
the storage system icon.

Clicking [Warning]
displayed "21513-008007"
in the Status field.

The Configuration model set in the Add
System window is different than the
model that was specified during setup.

Delete the storage system from the
Storage Device List and re-register the
storage system with the correct Config
model.

21513-008008 [Warning] was displayed in
the storage system icon.

Clicking [Warning]
displayed "21513-008008"
in the Status field.

The serial number set in the Add
System window and the serial number
set in the storage system are not
identical.

Delete the storage system from the
Storage Device List and re-register the
storage system with the correct serial
number.
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Message ID Description Recovery Action

21513-008009 [Warning] was displayed in
the storage system icon.

Clicking [Warning]
displayed "21513-008009"
in the Status field.

The user name and the password set in
Add System window might be incorrect.

Set the user name and the password in
the Storage Device List again.

21513-008011 [Warning] was displayed in
the storage system icon.

Clicking [Warning]
displayed "21513-008011"
in the Status field.

The information update failed.

This information updates automatically.
However, if the message does not
disappear after approximately five
minutes, select the corresponding
storage system from the Storage
Device List, stop the system, and then
restart it.

If the failure does not recover, restart the
SVP.

21513-008012 [Warning] was displayed in
the storage system icon.

Clicking [Warning]
displayed "21513-008012"
in the Status field.

Another SVP might be connected to the
storage system to be used.

Check whether services are running for
another storage system. If another SVP
already started the services of the
storage system, stop the services.

21542-005011 Clicking Apply in the Add
System window caused a
"(21542-005011) error"
and the storage icon is not
created.

The SVP does not have sufficient free
space to create the storage icon. Make
20 GB or more of free space available in
the installation directory of the drive.

21542-005019 Clicking Start Service
caused the error, and the
service cannot start.

Two or more services cannot run
simultaneously. Stop the service before
starting another service.

21542-005026 Clicking Start Service
caused the error, and the
service cannot start.

The SVP IP address is invalid. At the top-
right of the screen of the Storage
Device List window, click SVP IP
Address. In the Change SVP IP
Address window, set the IP address of
the SVP, and then retry Start Service.

The status of the service
changed to Error after
rebooting the SVP with the
Start-up service set to
Auto. The Service Status
window shows the error,
and the Status field shows
BASE.

The SVP IP address is invalid. At the top-
right of the screen of the Storage
Device List window, click SVP IP
Address. In the Change SVP IP
Address window, set the IP address of
the SVP, and then retry Start Service.

21542-005026 After starting Device
Manager - Storage
Navigator, a window is
displayed indicating you
cannot log in to Device
Manager - Storage
Navigator.

Two or more SVPs can be connected.
Only one storage system can connect to
an SVP at a time. If other SVPs are
connected, disconnect them and then,
restart the SVP you are using. If the SVP
is not connected, reboot the GUM from
the maintenance utility, and then restart
the SVP.
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Message ID Description Recovery Action

21542-008001 [Warning] was displayed in
the storage system icon.

Clicking [Warning]
displayed "21542-008001"
in Status.

A processing time-out has occurred in the
service associated with the error code. If
this error occurs repeatedly, refer to the
background service log and perform the
relevant coping method.
If the background service log does not
exist or the condition does not improve,
stop the service or reboot the SVP.

21542-008002 [Warning] was displayed in
the storage system icon.

Clicking [Warning]
displayed "21542-008002"
in Status.

An error occurred in the service
associated with the error code. Refer to
the background service log.
If the background service log does not
exist or the condition does not improve,
stop the service or reboot the SVP.

Troubleshooting during Hitachi Device Manager - Storage Navigator
operations

Failure Recovery Action

After registering the storage system,

an error occurred while operating

Hitachi Device Manager - Storage

Navigator or Hitachi Device Manager -

Storage Navigator hangs.

Check the status of the Hitachi Device Manager - Storage
Navigator background services (see Background service
log on page 344). If a failure occurred in the background
service, perform the actions on the following row.

When using the maintenance port, a communication error
might occur in the SVP connected to the management port
due to the abnormal maintenance port status. Check the
network status of the maintenance port.
If the failure persists after taking the actions, collect the

dump files (see Collecting dump files from the

maintenance utility). If the collection fails, collect the

target files manually (see Collecting dump files manually

on page 380).

After changing the registered user

account without stopping the services

of the registered storage system, the

20122-208003 error occurred while

using Hitachi Device Manager -

Storage Navigator.

Stop the service of the registered storage system in the

Storage Device List. Click Edit to register the enabled

user account information again, and then start the service.

Other errors Refer to the appropriate sections in the Hitachi Device

Manager-Storage Navigator User Guide:
• Login errors
• No-response errors
• Incorrect display errors
• UNIX operation errors
• Other errors
• Troubleshooting - Using Device Manager - Storage

Navigator secondary windows
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Miscellaneous Hitachi Device Manager - Storage Navigator
troubleshooting

Failure Recovery Action

After registering the storage system

successfully, any error occurred during

operation.

Check the status of the Device Manager - Storage
Navigator background services and take appropriate action
(see Background service log on page 344).

Collect the dump files (see Using the Dump tool on
page 379).

If the collection fails, collect the target files manually (see 
Collecting dump files manually on page 380).

After changing the registered user

account without stopping the services

of the registered storage system, the

"20122-208003" error occurred during

the Hitachi Device Manager - Storage

Navigator operations.

Stop the service of the registered storage system in the

Storage Device List. Click Edit to register the enabled

user account information again, and then start the service.

Troubleshooting NAS Manager
If you experience problems using NAS Manager, refer to the troubleshooting
procedures in the following sections.

Setting disk capacity assignments

Failure Recovery

The LDEV created by Device Manager - Storage
Navigator or Hitachi Command Suite is not
reflected.

Refresh NAS Manager.

The system drive to create a storage pool is not
shown in the window.

To create a storage pool, four or more LDEVs are
required. Start Device Manager - Storage
Navigator or Hitachi Command Suite to create
LDEVs. NAS might not be selected when adding
the LUN path to LDEVs. For more information
about creating LDEVs, see the Hitachi Virtual
Storage Platform Installation and Reference
Guide for your storage system model.

Start Device Manager - Storage Navigator and
set the LUN path of the LDEVs to be assigned to
the storage pool for the NAS platform (user LU).
For more information about allocating LDEVs to
LUN paths, see the Hitachi Virtual Storage
Platform Installation and Reference Guide for
your storage system model.

EVS cannot be created. The common subnet mask must be assigned to
EVS in which the same link aggregation is set.
Specify the same numerical value as the subnet
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mask of the previously created EVS. For more
information about adding EVS, see the Hitachi
Virtual Storage Platform Installation and
Reference Guide for your storage system model.

IP addresses cannot be assigned to EVS. Check the IP address to be assigned to each
EVS. For more information about adding EVS,
see the Hitachi Virtual Storage Platform
Installation and Reference Guide for your
storage system model.

File systems cannot be created. No capacity might be available for creating new
file systems because all the capacity of the
storage pool to create file systems is assigned to
the existing file system.

Increase the storage pool capacity or create new
storage pools. For more information about
creating storage pools, see the Hitachi Virtual
Storage Platform Installation and Reference
Guide for your storage system model.

Setting a link to the external server

Failure Recovery action

The NTP server cannot be detected. The IP address or the name of the NTP server
might be incorrect. Correct the IP address or the
name of the NTP server. For more information
about setting the system date and time of the
NAS modules, see the Hitachi Virtual Storage
Platform Installation and Reference Guide for
your storage system model.

The NTP server might not start up. Start the NTP
server.

Communication is disconnected between the
NAS Module LAN port and the switch LAN port.

The Link Aggregation Control Protocol (LACP)
setting of the NAS Module might not be identical
with that of the switch. For more information
about setting the link aggregation, see the
Hitachi Virtual Storage Platform Installation and
Reference Guide for your storage system model.

The DNS server cannot be recognized. The IP address of the DNS server might be
incorrect. For more information about changing
name services (DNS, WINS), see the Hitachi
Virtual Storage Platform Installation and
Reference Guide for your storage system model.

The DNS server might not start.

The external servers that can be specified by
name, such as mail servers, cannot be specified
by name.

The DNS server might not be recognized. The
DNS server might not be running. For more
information about changing name services (DNS,
WINS), see the Hitachi Virtual Storage Platform
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Installation and Reference Guide for your
storage system model.

The Active Directory server cannot be detected. The IP address of the Active Director server
might be incorrect. For more information about
sharing file systems, see the Hitachi Virtual
Storage Platform Installation and Reference
Guide for your storage system model.

The Active Director server might not be running.

The NIS server cannot be recognized. The IP address of the NIS server might be
incorrect. For more information about setting the
NIS directory service, see the Hitachi Virtual
Storage Platform Installation and Reference
Guide for your storage system model.

The NIS server might not start.

The LDAP server cannot be recognized. The IP address of the LDAP server might be
incorrect. For more information about setting the
LDAP directory service, see theHitachi Virtual
Storage Platform Installation and Reference
Guide for your storage system model.

The LDAP server might not start.

The SMTP server for failure notification cannot
be recognized.

The name or IP address of the SMTP server
might be incorrect. For more information about
changing NAS failure e-mail notifications, see
the Hitachi Virtual Storage Platform Installation
and Reference Guide for your storage system
model.

The SMTP server might not be running.

A test mail is not received even if performing
Send Test Event.

The SMTP server might not be recognized or the
destination mail address might be incorrect. For
more information about changing NAS failure e-
mail notifications, see the Hitachi Virtual Storage
Platform Installation and Reference Guide for
your storage system model.

The SMTP server might not be running.

The Syslog server cannot be recognized. The IP address of the Syslog server might be
incorrect. For more information about setting
NAS failure notifications using the Syslog, see
the Hitachi Virtual Storage Platform Installation
and Reference Guide for your storage system
model.

The Syslog server might not start up.

The SNMP cannot be recognized. The IP address of the SNMP server might be
incorrect. For more information about setting
NAS failure notifications using SNMP, see the
Hitachi Virtual Storage Platform Installation and
Reference Guide for your storage system model.

The SNMP server might not start up.
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Troubleshooting file-level access operations

Problem Cause Recovery

The Status lamp on the
main window turns red or
amber. When Event Log is
checked, the error related
to the network link is
shown.

There is a problem with
the external servers (NIS,
LDAP, NFS Export Active
Directory, CIFS).

Recover the external servers to normal
operation.

Link aggregation is not set
properly.

Confirm that the same setting is used
between the NAS module and the client
PC to be connected to the NAS module or
the switch. For more information about
setting link aggregation, see the Hitachi
Virtual Storage Platform Installation and
Reference Guide for your storage system
model.

The host or the client PC
cannot access the file
system

There is a problem with
the external servers (NIS,
LDAP, NFS Export Active
Directory, CIFS).

Recover the external servers to normal
operation.

The settings of the
external servers (NIS,
LDAP, NFS Export Active
Directory, CIFS) are
incorrect.

Correct the external server settings. For
more information about setting the NIS
or LDAP directory service and sharing file
systems, see the Hitachi Virtual Storage
Platform Installation and Reference Guide
for your storage system model.

Troubleshooting the maintenance utility
Maintenance utility port numbers

Use the following table as a reference when changing port numbers for the
maintenance utility.

Port Number Description Can the port be closed?

80 Maintenance utility (HTTP) Yes

Use the maintenance utility.

161 SNMP (udp) No

443 Maintenance utility (HTTPS) No

1900 UPnP Yes

Requires upgrading firmware
before adjusting port access.

10500 MAPP connection No

31001 RAID Manager No
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Port Number Description Can the port be closed?

31002 RAID Manager No

Network cannot connect to the maintenance utility
If the network cannot connect to Maintenance Utility or the 32061-204002
error occurs while operating Maintenance Utility, check that the LAN cable is
not removed. If it is removed, connect the cable, and then restart the
operation. If the operation cannot recover:
• Log out, close your web browser, and then log in again.
• If it still cannot recover, enter the IP address of controller 1 or controller 2

in your web browser's address bar to log in to Maintenance Utility and
check the status of the storage system.

Maintenance Utility window is blank when it opens in Internet
Explorer

If the Maintenance Utility window shows no content when you open it in
Internet Explorer, even after waiting several minutes, use the following
procedure to add the Maintenance Utility window to the trusted sites, and
then open the Maintenance Utility window again.

Procedure

1. In Internet Explorer, click Tools > Internet Options, and then click the
Security tab.

2. Click Trusted Sites > Sites.
3. Clear the Require server verification (https:) for all sites in this

zone check box.
4. Enter the IP address of controller 1 to Add this website to the zone

and click Add, and then click Close.
5. Add the IP address of controller 2 using the same method.
6. When returning to the Internet Options window, click OK to close the

window.

Maintenance Window is blank when it opens in Google Chrome
If the Maintenance Utility window shows no content when you open it in
Google Chrome, even after waiting several minutes, use the following
procedure to add the Maintenance Utility window to the trusted sites, and
then open the Maintenance Utility window again.

Procedure

1. From the menu on the top of Google Chrome, click Settings.
2. Click Show advanced settings.
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3. Click Change proxy settings to open Internet Properties, and then
select the Security tab.

4. Click Trusted sites > Sites.
5. Uncheck Require server verification (https:) for all sites in this

zone.
6. In Add this website to the zone, enter the IP address of controller 1,

and then click Add and Close.
7. Use the same method in the previous step to add the IP address of

controller 2.
8. After returning to the Internet Properties window, click OK to close the

window.

Handling Java security messages
If you start the Update window of the Maintenance Utility, and the message
Application Blocked by Java Security or Application Blocked by
Security Settings appears, perform the following procedure.

Procedure

1. From the Windows start menu, click All Programs > Java, and then
click Configure Java.

2. Open the Java Control Panel.
3. In the Security tab, click Edit Site List in the Security tab.
4. Add the following URLs to the Exception Site List, and then click OK.

• <http://(IP address of controller 1)>
• <http://(IP address of controller 2)>
• <https://(IP address of controller 1)>
• <https://(IP address of controller 2)>

Note: If Security – HTTP Location is displayed when adding the
URL, click Continue.

5. Close the Java Control Panel, and then restart your web browser.

Contents in the Maintenance Utility window appear to be corrupt
If the contents displayed in the Maintenance Utility window appear to be
corrupt, exclude the maintenance utility from the compatibility view target.
In Internet Explorer, check the Compatibility View on the address bar. In
Internet Explorer versions 10 and earlier:

Procedure

1. Click Tools > Compatibility View setting.
2. Clear the Display intranet sites in Compatibility View check box and

the Display all websites in Compatibility View check box.
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3. Click Close.

Maintenance Utility window fails or is blank
In the unlikely event that the login to the Maintenance Utility window fails,
or the window opens with no content shown (even after waiting several
minutes), clear the web browser cache and open the Maintenance Utility
window again.

Forcing browser refreshes of the Maintenance Utility window
If images in the Maintenance Utility window do not appear properly,
refresh your web browser.

To refresh your web browser:

Procedure

1. If the maintenance utility is open, log out.
2. Press the Ctrl key and F5 key at the same time to force a refresh.

Maintenance Utility window freezes
The maintenance utility provides a locking feature you can use in case the
window freezes (hangs).

If the Maintenance Utility window hangs during normal operation:

Procedure

1. Check the network connection between the SVP and the storage system.
2. Log out of the SVP, and then log in again.
3. When the System Locked message appears after logging on again, click

System Locked to unlock the system.

Releasing the system lock
The maintenance utility cannot be used if it becomes locked. In this case, use
the following procedure to unlock the maintenance utility.

Before you begin

Before releasing the system lock, confirm with the system administrator that
releasing the system lock forcibly does not cause any problem.

Procedure

1. Start the maintenance utility:
• From Hitachi Command Suite. In the Hitachi Command Suite Main

window, click Storage System from the tree view of the Resources
tab. Expand the tree, and then click the Maintenance Utility menu to
open the Maintenance Utility window.
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• From Device Manager - Storage Navigator: In the Storage Navigator
main window, click the Maintenance Utility menu bar, and then click
Hardware > Maintain Other Hardware.

2. In the Maintenance Utility window, click System Management >
Force Release System Lock.
 

 
The Force Release System Lock page opens.

3. Click OK.
4. At the completion message, click Close to remove the message.

Update Firmware window cannot be displayed
If you receive a message in your browser about the Update Firmware
window cannot be displayed, or if an application error appears, perform the
following procedure:
• Terminate the tool, and then register the storage system on the SVP if the

error occurs while registering the storage system on the SVP.
• Close the error window, and then update the firmware again if the error

occurs during the firmware update on the maintenance utility.

Duplicate maintenance utility windows appear in Internet Explorer
If duplicate Maintenance Utility windows appear in Internet Explorer, turn
off the Smart Screen Filter function in your web browser.

Procedure

1. In Internet Explorer, click Safety > Smart Screen Filter, and then click
Turn off Smart Screen Filter.

2. Check that Turn off Smart Screen Filter is selected, and then click OK
to close the window.

Duplicate maintenance utility windows appear in Google Chrome
If duplicate Maintenance Utility windows appear in Google Chrome, turn off
the Smart Screen Filter function in your web browser.

Procedure

1. From the menu on the top of Google Chrome, click Settings.
2. Click Show advanced settings.
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3. Under Privacy, uncheck Enable phishing and malware detection
protection.

Request to download a file during firmware upgrade using Internet
Explorer

If a message about saving the JNLP file appears when the firmware update
window is displayed in Internet Explorer, perform the following procedure.

Procedure

1. In Internet Explorer, click Tools > Internet Options, and then click the
Advanced tab.

2. Under Security in Settings, clear Do not save encrypted pages to
disk.

3. Click OK to close the window.

Note: In Google Chrome, click Keep at the bottom of the window
to store the JNLP file. Do not click Discard.

Request to download a file during firmware upgrade using Google
Chrome

If a message about saving the jnlp file appears when the firmware update
window is displayed in Google Chrome, click Keep at the bottom of the
window to store the jnlp file. Do not click Discard.

 

 

Error when exporting the audit log or backing up user account
information

If the message Maintenance Utility cannot be started appears in
Internet Explorer, turn off the pop-up blocking.

Procedure

1. On the Start menu, click Control Panel > Internet Options.
2. In the Internet Properties window, click the Privacy tab.
3. Uncheck Turn on Pop-up Blocker, and then click OK.
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Background service log
You can output the logs of the background services that operate the SVP.

See the background service logs when checking that the SVP has started
normally.

The background service logs are stored in the following directory:

<installDir>\wk\supervisor\system\log

Log file type Log file name

Storage Device List log system_< serial number >.log

Storage Navigator log system_<serial number>_< serial number >.log

In the previous line:
• installDir = the installation directory of the SVP (for example, C:\Mapp).
• <serial number> = a sequential number of a given log file that begins with

0.

The background services include the following:

Storage Device List background services

Storage Device List background service Service name

Storage Device List server SDLSrv

SVP RMI- API forward server RMI-API Forward Server

Web Application Server Web Application Server

Storage Navigator background services

Storage Navigator background service Service name

Web Application Server Web Application Server

Storage Navigator server Storage Navigator

SVP RMI- API server RMI-API Server

External authentication relay service External Authenticator

SMI-S Provider service SMI-S

Communication service Communication

KMIP Communicator KMIP Communicator
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The output format of logs is: [Occurrence Date and Time] [Failure
Level] [Troubleshooting Code] [Service Name] [Log Content]

In the output format above:

• Occurrence date and time = date and time output in the following format:
YYYY/MM/DD hh:mm:ss.SS

• Failure level = one of the following failure levels:
INFO: Reference information (start, termination log, and so on).
WARN: Warning (configured values should be checked, service is
operating in the default status).
ERROR: Service cannot start due to an error.

• Troubleshooting code = troubleshooting codes are output.
• Service name = service names are output.
• Log contents = message are output.

The following logs are output in their respective background services. Check
these logs to ensure that the initialization process for each background
service has completed normally and started. These logs will also show
whether errors have occurred while the service is running

[2015/01/01 13:00:00.000][INFO][TRSTNA000001][Web Application Server] 
[Initializing]

 2015/01/01 13:00:15.000][INFO][TRSTNA000002][Web Application Server] [Ready]

 [2015/01/01 13:00:30.000][INFO][TRSTNA001001][Storage Navigator] [Initializing]

 [2015/01/01 13:01:00.000][INFO][TRSTNA001002][Storage Navigator] [Ready]

The following section describes troubleshooting codes and appropriate actions
to take.

Storage Device List server

The following example is a normal log output:

[2015/03/18 15:40:50.372][INFO] [TRSDLS000001] [SDLSrv] [Initializing]

:

:

[2015/03/18 15:41:28.009][INFO] [TRSDLS000002] [SDLSrv] [Ready]

The following example is when a log output contains errors:

[2015/03/19 17:12:14.551][INFO ] [TRSDLS000006] [SDLSrv] [Stopping]

[2015/03/19 17:12:14.934][ERROR] [TRSDLS000011] [SDLSrv] [Stopping : System is
locked (SN:400001).]
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[2015/03/19 17:12:15.216][ERROR] [TRSDLS000008] [SDLSrv] [ Ready : Failed to
stop. ]

The following table lists troubleshooting codes and recovery actions.

Troubleshooting code Failure level Recovery action

TRSDLS000001 INFO The initialization processing of
the Storage Device List server
started.

Check that TRSDLS000002 is
output and the initialization
processing completes normally.

TRSDLS000002 INFO The initialization processing of
the Storage Device List server
completed normally.

TRSDLS000003 ERROR The initialization processing of
the Storage Device List server
terminated with errors. See the
troubleshooting codes that
were output before and after
this log, and perform the
appropriate recovery actions.

If no other error log is output,
restart the SVP. If the condition
does not change after
restarting the SVP, set it up
again.

TRSDLS000004 ERROR The port shown in the log
cannot be used.

If the port exists, change the
port number used in the
application when allowed. If
you cannot change the port
number (see Changing SVP port
numbers), change the port
number for DKCManPrivate.
Then perform the following
procedure. If the result does
not change, restart the SVP. If
the condition still does not
change after, set up the SVP
again.

1. From the Windows Start
menu, click Control Panel >
System and Security >
Management Tool > Services.

2. Click DKCMan from the list
and click Start Services.

TRSDLS000005 ERROR The initialization processing of
the Storage Device List server
timed out.
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Troubleshooting code Failure level Recovery action

Restart the SVP. If the condition
does not change after
restarting the SVP, set it up
again.

1. From the Windows Start
menu, click Control Panel >
System and Security >
Management Tool > Services.

2. Click DKCMan from the list
and click Start Services.

TRSDLS000006 INFO Stopping the Storage Device
List server has begun. Check
that TRSDLS000007 is output
and the stop processing
completes normally.

TRSDLS000007 INFO Stopping the Storage Device
List server completed normally.

TRSDLS000008 ERROR Stopping the Storage Device
List server terminated with
errors. The port shown in the
log cannot be used. See the
troubleshooting codes output
before and after this log, and
perform the appropriate
recovery actions. If no other
error log is produced, perform
the following procedure to stop
the Storage Device List server.

1. From the Windows Start
menu, click Control Panel >
System and Security >
Management Tool > Services.

2. Show the DKCMan property.

3. On the General tab, set the
Type of Start-up to Manual.

4. Reboot the SVP.

TRSDLS000009 ERROR The Storage Device List server
cannot be stopped at this time.
Wait a few minutes, and then
try to stop it.

TRSDLS000010 ERROR The storage system with the
serial number displayed in the
log cannot stop its service.

Perform the following procedure
to stop the Storage Device List
server:

1. From the Windows Start
menu, click Control Panel >
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Troubleshooting code Failure level Recovery action

System and Security >
Management Tool > Services.

2. Show the DKCMan property.

3. On the General tab, set the
Type of Start-up to Manual.

TRSDLS000011 ERROR The system with the serial
number displayed in the log
cannot stop its service because
another user acquired the lock.
Release the lock, and then try
to stop the service.

TRSDLS000012 ERROR The stop processing of the
Storage Device List server
timed out. If it occurs
repeatedly, stop the Storage
Device List server in the
following procedure.

1. From the Windows Start
menu, click Control Panel >
System and Security >
Management Tool > Services.

2. Show the DKCMan property.

3. On the General tab, set the
Type of Start-up to Manual.

TRSDLS000013 WARN The service status acquisition
failed.

If this warning does not
disappear within three minutes,
stop the storage system by
Storage Device List, and then
restart it.

If it does not recover, restart
the SVP.

If the condition does not
change after restarting the SVP,
set it up again.

TRNASB000001 ERROR NAS Unified Firmware
Configuration Backup task
cannot be registered.

Register the NAS unified
firmware configuration backup
task.

TRNASB000002 ERROR NAS Unified Firmware
Configuration Backup task
cannot be deleted.

Delete the NAS unified firmware
configuration backup task.
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Troubleshooting code Failure level Recovery action

TRNASB000003 ERROR NAS Unified Firmware
Configuration Backup task
cannot be enabled.

Enable the NAS unified
firmware configuration backup
task.

TRNASB000004 ERROR NAS Unified Firmware
Configuration Backup
notification cannot be
registered.

Contact customer support.

TRNASB000005 ERROR NAS Unified Firmware
Configuration Backup
notification cannot be deleted.

Delete the NAS unified firmware
configuration backup
notification task.

TRNASB000006 ERROR NAS Unified Firmware
Configuration Backup cannot be
performed due to an internal
error.

If this problem persists, contact
customer support.

TRNASB000007 WARN The saving destination of NAS
Unified Firmware Configuration
Backup is not valid. Perform the
following procedure to check
the saving destination.

1. Click Control Panel >
Administrative Tools >
Task Scheduler to start.

2. Click Actions and confirm
that the description in the
Add arguments (optional)
is in the format specified
in the NAS unified
firmware configuration
backup.

TRNASB000008 WARN The number of generations for
NAS Unified Firmware
Configuration Backup is not
valid. Perform the following
procedure to check the number
of generations.

1. Click Control Panel >
Administrative Tools >
Task Scheduler to start.

2. Click Actions and confirm
that the description in the
Add arguments (optional)
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Troubleshooting code Failure level Recovery action

is in the format specified
in the NAS unified
firmware configuration
backup.

TRNASB000009 ERROR NAS Unified Firmware
Configuration Backup cannot be
performed due to an error in
connection to NAS. Perform the
following procedure to check
the NAS unified firmware
status.

1. Start Maintenance Utility.
2. Check if the storage

system status is Ready.
3. If the status is not ready,

perform maintenance.

TRNASB000010 ERROR NAS Unified Firmware
Configuration Backup cannot be
collected. Check the following
conditions:
• Whether the HDD capacity

in SVP is insufficient.
• Whether the saving

destination path length is
within 218 characters when
the destination is changed.

TRNASB000011 ERROR NAS Unified Firmware
Configuration Backup
notification task cannot be
registered due to an error in
connection to the storage
system. Perform the following
procedure to check the storage
system status.

1. Start Maintenance Utility.
2. Check if the storage

system status is Ready.
3. If the status is not ready,

perform maintenance.

TRNASB000012 ERROR Email address cannot be
collected. Perform the following
procedure to check the email
settings for Maintenance Utility.

1. Start Maintenance Utility.
2. Click Administration >

Alert Notifications > Email
and confirm the email
settings are valid.

TRNASB000013 WARN NAS Unified Firmware
Configuration Backup email
notification is disabled because
SMTP server authentication is
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Troubleshooting code Failure level Recovery action

enabled in email settings for
Maintenance Utility.

To receive error notification of
NAS unified firmware
configuration backup by email,
disable SMTP authentication in
email settings for Maintenance
Utility.

1. Start Maintenance Utility.
2. Click Administration >

Alert Notifications > Email
and confirm the email
settings are valid.

Note: If the user account control in Windows started, click Continue.

SVP RMI-API Forward Server

The following example is a normal log output when the server starts and
terminates normally.

[2015/03/17 15:49:09.638][INFO ][TRRMIS002001][RMI-API Forward Server]
[Initializing]

[2015/03/17 15:49:16.544][INFO ][TRRMIS002002][RMI-API Forward Server][Ready]

[2015/03/17 18:50:59.982][INFO ][TRRMIS002012][RMI-API Forward Server][Stopping]

[2015/03/17 18:51:00.003][INFO ][TRRMIS002013][RMI-API Forward Server][Stopped]

The following example is when a log output contains errors at termination.

[2015/03/17 15:49:09.638][INFO ][TRRMIS002001][RMI-API Forward Server]
[Initializing]

[2015/03/17 15:49:10.001][ERROR][TRRMIS002005][RMI-API Forward Server][Failed :
Environment is invalid.]

[2015/03/17 15:49:10.102][INFO ][TRRMIS002004][RMI-API Forward Server][Failed]

The following table lists troubleshooting codes and recovery actions.

Troubleshooting code Failure level Recovery action

TRRMIS002001 INFO Output when the RMI-API
Forward Server service starts.

To confirm that the RMI-API
Forward Server service started
normally, match it to the log
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Troubleshooting code Failure level Recovery action

and check that TRRMIS002002
is output.

TRRMIS002002 INFO Output when the start of the
RMI-API Forward Server service
completed normally.

TRRMIS002003 WARN The RMI-API Forward Server
service started, but a warning
occurred in the processing.
Check the troubleshooting
codes output through
TRRMIS002001 and log, and
take the appropriate action.

TRRMIS002004 ERROR The RMI-API Forward Server
service failed to start.

Check the troubleshooting
codes output through
TRRMIS002001 and log, and
take the appropriate actions.

TRRMIS002005 ERROR Acquiring the environment
setting information necessary
for starting the RMI-API
Forward Server service has
failed.

Restart the SVP. If the status
does not change after
restarting the SVP, set it up
again.

TRRMIS002006 ERROR Acquiring the environment
setting information necessary
for starting the RMI-API
Forward Server service failed.

Restart the SVP. If the condition
does not change after
restarting the SVP, set it up
again.

TRRMIS002007 WARN Acquiring the environment
setting information necessary
for starting the RMI-API
Forward Server service failed.

Restart the SVP. If the condition
does not change after
restarting the SVP, set it up
again.

TRRMIS002008 WARN The ports necessary for the
RMI-API Forward Server service
cannot be used.

Check that the port number is
not being used by another
application and change the port
number of the appropriate
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Troubleshooting code Failure level Recovery action

application when allowed. If
you cannot change the port
number (see Changing SVP port
numbers), change the port
number for RMIIFRegist and
then restart the SVP.

TRRMIS002009 WARN The ports necessary for the
RMI-API Forward Server service
cannot be used.

Check that the ports report to
the log are not used by another
application and change the port
number of the appropriate
application when permitted. If
you cannot change the port
number (see Changing SVP port
numbers), change the port
number for DKCManPrivate and
then restart the SVP.

TRRMIS002010 WARN Use the recovery action for
TRRMIS002008.

TRRMIS002011 WARN Use the recovery action for
TRRMIS002009.

TRRMIS002012 INFO Output when the RMI-API
Forward Server service stops.

To confirm that the RMI-API
Forward Server service stopped
normally, match it to the log
and check that TRRMIS002013
is output.

TRRMIS002013 INFO Output when the RMI-API
Forward Server service stopped
normally.

Web Application Server

The following example is a log output when it is normal.

[2015/12/02 16:21:47.113][INFO ][TRMAAS000001][Web Application Server]
[Initializing]

[2015/12/02 16:21:48.410][INFO ][TRMAAS000002][Web Application Server][Ready]

The following example is a log output when it is abnormal.

[2015/12/03 09:47:22.020][INFO ][TRMAAS000001][Web Application Server]
[Initializing]

[2015/12/03 09:48:25.004][ERROR][TRMAAS000004][Web Application Server][Failed :
Failed to connect to the starting port of the web server. Port=8080.]
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[2015/12/03 09:48:25.174][INFO ][TRMAAS000007][Web Application Server][Stopped]

The following table lists the troubleshooting codes and recovery actions.

Troubleshooting code Failure level Recovery action

TRMAAS000001 INFO Output when the Web
Application Server starts. To
check whether the Web
Application Server is running
normally, check whether this
troubleshooting code and
TRMAAS000002 are output.

TRMAAS000002 INFO Output when the Web
Application Server started
completely.

TRMAAS000003 WARN The ports necessary for the
Web Application Server service
cannot be used.

Check whether the ports output
to the logs are not used in
other applications and change
the application port numbers if
possible. If they cannot be
changed, see and change the
port numbers of
MAPPWebServer.

TRMAAS000004 ERROR The ports necessary for the
Web Application Server service
cannot be used.

Check whether the ports output
to the logs are not used in
other applications and change
the application port numbers if
possible. If they cannot be
changed, see and change the
port numbers of
CommonJettyStart.

TRMAAS000005 ERROR The ports necessary for the
Web Application Server service
cannot be used.

Check whether the ports output
to the logs are not used in
other applications and change
the application port numbers if
possible. If they cannot be
changed, see and change the
port numbers of
CommonJettyStop.

TRMAAS000006 INFO Output when the Web
Application Server stops.

To check whether the Web
Application Server stopped
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Troubleshooting code Failure level Recovery action

normally, check whether this
troubleshooting code and
TRMAAS000007 are output.

TRMAAS000007 INFO Output when the Web
Application Server stopped
normally and completely.

Storage Navigator Server

This is an example of a normal log output when the server starts normally.

[2015/03/19 18:08:31.046][INFO ][TRSTNA000001][Web Application Server]
[Initializing]

[2015/03/19 18:08:31.592][INFO ][TRSTNA000002][Web Application Server][Ready]

[2015/03/19 18:09:12.903][INFO ][TRSTNA001001][Storage Navigator][Initializing]

[2015/03/19 18:15:29.387][INFO ][TRSTNA001002][Storage Navigator][Ready]

This is an example of a normal log output at termination.

[2015/03/19 21:11:49.942][INFO ][TRSTNA000004][Web Application Server][Stopping]

[2015/03/19 21:11:50.478][INFO ][TRSTNA000005][Web Application Server][Stopped]

[2015/03/19 21:11:50.859][INFO ][TRSTNA001004][Storage Navigator][Stopping]

[2015/03/19 21:11:52.209][INFO ][TRSTNA001005][Storage Navigator][Stopped]

This is an example of log output when the server does not start normally.

[2015/03/20 11:15:33.543][INFO ][TRSTNA000001][Web Application Server]
[Initializing]

[2015/03/20 11:15:34.364][ERROR][TRSTNA000003][Web Application Server]
[Initializing : Failed to start a Storage Navigator.]

This is an example when log output contains errors at termination.

[2015/03/20 12:24:36.175][INFO ][TRSTNA000004][Web Application Server][Stopping]

[2015/03/20 12:24:38.931][INFO ][TRSTNA000005][Web Application Server][Stopped]

[2015/03/20 12:24:39.142][INFO ][TRSTNA001004][Storage Navigator][Stopping]

[2015/03/20 12:25:40.634][WARN ][TRSTNA001006][Storage Navigator][Stopped : Timeout
has occurred.]

The following table lists troubleshooting codes and recovery actions.
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Troubleshooting code Failure level Recovery action

TRSTNA000001 INFO Output when the Web
Application server starts.

To confirm that the Web
Application Server started
normally, match it to the
troubleshooting code and check
that TRSTNA000002 is output.

TRSTNA000002 INFO Output when the start of the

Web Application server is

completed.

TRSTNA000003 ERROR The Web Application server
failed to start.

Select the appropriate storage
system from the Storage
Device List, stop it, and then
restart it.

If it does not recover, restart
the SVP.

If it does not recover after
restarting the SVP, set up
Device Manager - Storage
Navigator again.

TRSTNA000004 INFO Output when the Web

Application server stops.

TRSTNA000005 INFO Output when the Web

Application server stops

completely.

TRSTNA000006 ERROR An error occurred by stopping
the Web Application server.

Restart the SVP.

If it does not recover after
restarting the SVP, set up
again.

TRSTNA000007 WARN The Device Manager - Storage
Navigator service stopped
unexpectedly, and then it is
restarting.

If the condition does not
change within three minutes,
stop the storage system by
Storage Device List and restart
it.

If it does not recover, restart
the SVP.
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If it does not recover after

restarting the SVP, set up

Device Manager - Storage

Navigator again.

TRSTNA000008 ERROR See to change the port number
range of DeviceJettyStart to the
unused range.
Then restart the SVP.

TRSTNA000009 ERROR See to change the port number
range of DeviceJettyStop to the
unused range.
Then restart the SVP.

TRSTNA000010 ERROR The Web Application Server
stopped forcibly. This message
might be output when SVP
restarted while the service is
running.

Select the relevant storage
system from the Storage
Device List, stop it, and then
restart it.

If it does not recover, restart
the SVP.

If it does not recover after
restarting the SVP, set up
Device Manager - Storage
Navigator again.

TRSTNA000011 ERROR The Web Application Server
stopped forcibly. This message
might be output when SVP
restarted while the service is
running.

Select the relevant storage
system from the Storage
Device List, stop it, and then
restart it.

If it does not recover, restart
the SVP.

If it does not recover after
restarting the SVP, set up
Device Manager - Storage
Navigator again.

TRSTNA001001 INFO Output when starting the
Device Manager - Storage
Navigator service.

To confirm that the Device
Manager - Storage Navigator
service has started normally,
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match it to the troubleshooting
code and check that
TRSTNA000008 is output.

TRSTNA001002 INFO The Storage Navigator service

started normally.

TRSTNA001003 WARN Might be output when the
Device Manager - Storage
Navigator service is running.

If the troubleshooting code is
output, the Device Manager -
Storage Navigator service is
acquiring the information. Wait
up to 30 minutes after
TRSTNA001001 is output. If
TRSTNA001002 is not output
after 30 minutes, see the
Hitachi Virtual Storage Platform
System Administrator Guide for
your model for corrective
action.

If it does not recover, restart
the SVP.

If it does not recover after
restarting the SVP, set up
Device Manager - Storage
Navigator again.

TRSTNA001004 INFO Output when the Device
Manager - Storage Navigator
server stops.

To confirm that the Device
Manager - Storage Navigator
service stopped normally,
match it to the troubleshooting
code and check that
TRSTNA001005 is output.

TRSTNA001005 INFO Output when the Device

Manager - Storage Navigator

server is stopped Device

Manager - Storage Navigator

completely.

TRSTNA001006 WARN A time-out has occurred when
stopping the Device Manager -
Storage Navigator service.

If it does not become start
completion ( TRSTNA001002)
at the next start time, restart
the SVP.
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If it does not recover after
restarting the SVP, set up
Device Manager - Storage
Navigator again.

TRSTNA001007 ERROR The Device Manager - Storage
Navigator service stopped
forcibly. This message might be
output when SVP restarted
while the service is running.

Select the relevant storage
system from the Storage
Device List, stop it, and then
restart it.

If it does not recover, restart
the SVP.

If it does not recover after
restarting the SVP, set up
Device Manager - Storage
Navigator again.

TRSTNA001008 ERROR The Device Manager - Storage
Navigator service stopped
forcibly. This message might be
output when SVP restarted
while the service is running.

Select the relevant storage
system from the Storage
Device List, stop it, and then
restart it.

If it does not recover, restart
the SVP.

If it does not recover after
restarting the SVP, set up
Device Manager - Storage
Navigator again.

SVP RMI-API Server

The following example is a normal log output when the server starts and
terminates normally.

[2015/03/17 15:49:07.750][INFO ][TRRMIS001001][RMI-API Server] [ Initializing ]

[2015/03/17 15:49:08.000][INFO ][TRRMIS001002][RMI-API Server] [ Ready ]

[2015/03/17 15:49:09.638][INFO ][TRRMIS002501][RMI-API Server] [ Initializing ]

[2015/03/17 15:49:16.544][INFO ][TRRMIS002502][RMI-API Server] [ Ready ]

[2015/03/17 15:52:03.405][INFO ][TRRMIS000001][RMI-API Server] [ Initializing ]

[2015/03/17 15:52:19.364][INFO ][TRRMIS000002][RMI-API Server] [ Ready ]
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:

:

[2015/03/17 18:50:59.982][INFO ][TRRMIS002510][RMI-API Server] [ Stopping ]

[2015/0 3/17 18:51:00.003][INFO ][TRRMIS002511][RMI-API Server] [ Stopped ]

[2015/03/17 18:51:06.645][INFO ][TRRMIS001006][RMI-API Server] [ Stopping ]

[2015/03/17 18:51:06.927][INFO ][TRRMIS000015][RMI-API Server] [ Stopping ]

[2015/03/17 18:51:08.249][INFO ][TRRMIS000016][RMI-API Server] [ Stopped ]

[2015/03/17 18:51:10.695][INFO ][TRRMIS001007][RMI-API Server] [ Stopped ]

The start logs of two or more services are reported in the SVP RMI-API
server. To confirm the normal start of the SVP RMI-API server, check the logs
of TRRMIS000002, TRRMIS001002, and TRRMIS002502. To check for normal
completion, check the logs of TRRMIS000016, TRRMIS001007, and
TRRMIS002511.

The following example is when a log output contains errors.

[2015/03/17 15:49:07.750][INFO ][TRRMIS001001][RMI-API Server][ Initializing ]

[2015/03/17 15:49:08.000][INFO ][TRRMIS001002][RMI-API Server][ Ready ]

[2015/03/17 15:49:09.638][INFO ][TRRMIS002501][RMI-API Server][ Initializing ]

[2015/03/17 15:49:16.544][INFO ][TRRMIS002502][RMI-API Server][ Ready ]

[2015/03/17 15:52:03.405][INFO ][TRRMIS000001][RMI-API Server][ Initializing ]

[2015/03/17 15:52:03.968][ERROR][TRRMIS000007][RMI-API Server][ Failed : Port is
already in use. Port=51100 ]

[2015/03/17 15:52:04.003][INFO ][TRRMIS000015][RMI-API Server][ Stopping ]

[2015/03/17 15:52:04.125][INFO ][TRRMIS000016][RMI-API Server][ Stopped ]

The following table lists troubleshooting codes and recovery actions.

Troubleshooting code Failure level Recovery action

TRRMIS000001 INFO Output when the RMI-API
Server service starts.

The log is output two or more
times by retry at the time of
error occurrence.

To confirm that the RMI-API
Server service has started
normally, match it to the log
and check that TRRMIS000002
is output.
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TRRMIS000002 INFO Output when the start of the

RMI-API Server service is

completed normally.

TRRMIS000003 WARN Reading the environment
setting files necessary for the
RMI-API Server service failed.

Restart the SVP.

If the condition does not
change after restarting the SVP,
set it up again.

TRRMIS000004 WARN Operating with the default
value indicated in the log
content because the
environment setting
information necessary for the
RMI-API Server service could
not be obtained.

Restart the SVP.

If the condition does not
change after restarting the SVP,
set it up again.

TRRMIS000005 WARN Operating with the default
value indicated in the log
content because the acquisition
of the environment setting
information necessary for the
RMI-API Server service failed.

Restart the SVP.

If the condition does not
change after restarting the SVP,
set it up again.

TRRMIS000006 WARN The port number used of the
RMI-API Server service is
already used.

Check that another application
is not using the port number
indicated in the log content and
close the application. Then stop
the appropriate storage system
from the Storage Device List
and restart it.

Check the port number key
using the port number indicated
by the log content and change
it to another port number (see
Changing SVP port numbers). If
no port management number
key corresponding to the port
number indicated by the log
content exists, the port number
cannot be changed.
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TRRMIS000007 ERROR The port number used of the
RMI-API Server service is
already used.

Check that another application
is not using the port number
indicated by the log content
and close the application.

Check the port number key
using the port number indicated
by the log content and change
it to another port number (see
Changing SVP port numbers). If
no port management number
key corresponding to the port
number indicated by the log
content exists, the port number
cannot be changed.

TRRMIS000008 WARN The file operation indicated by
the log content failed in the
RMI-API Server service.

Another application can access
the file. Close all other
applications, and then stop the
appropriate storage system
once from the Storage Device
List and restart it.

TRRMIS000009 ERROR An unexpected error occurred
in the RMI-API Server service.

Gather dump files.

Collect the dump files (see 
Using the Dump tool on
page 379).

If the collection fails, collect the
target files manually (see 
Collecting dump files manually
on page 380).

TRRMIS000010 WARN The connection to the
necessary services failed in the
RMI-API Server service.

Stop the appropriate storage
system once and restart it.

If the condition does not
change after restarting, restart
the SVP.

If the condition does not
recover after restarting the SVP,
set it up again.

TRRMIS000011 ERROR The connection to the
necessary services failed in the
RMI-API Server service.
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Stop the appropriate storage
system once and restart it.

If the condition does not
change after restarting, restart
the SVP.

If the condition does not
recover after restarting the SVP,
set it up again.

TRRMIS000012 WARN The IP address used in the RMI-
API Server service is invalid.

Check that the IP address of
the SVP set by the Storage
Device List is correct and
restart the SVP.

If the condition does not
recover after restarting the SVP,
set it up again.

TRRMIS000013 ERROR

TRRMIS000014 WARN Operating with the default
value indicated in the log
content because the acquisition
of the port number used for the
RMI-API Server service failed.

Check that the port value of the
port number key PreRMIServer
is set correctly (see Changing
SVP port numbers). Stop the
appropriate storage system
once from the Storage Device
List and restart it.

If the condition does not
change after restarting, restart
the SVP.

If the condition does not
recover after restarting the SVP,
set it up again.

TRRMIS000015 INFO Output when the RMI-API
Server service terminates.

The log is output two or more
times by retry at the time of
error occurrence.

To confirm that the RMI-API
Server service is completed
normally, match it to the log
and check the output of
TRRMIS000016 is output.

TRRMIS000016 INFO Output when the RMI-API
Server service is stopped
normally.

TRRMIS000017 WARN The connection to the
necessary services failed in the
RMI-API Server service.TRRMIS000018 ERROR
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Restart the SVP.

If it does not recover after
restarting the SVP, set it up
again.

TRRMIS000019 ERROR The file operation indicated in
the log content failed in the
RMI-API Server service failed.

Another application can access
the appropriate file. Close all
other applications.

TRRMIS000020 WARN The client cannot connect to the
RMI-API Server because the
connection to the necessary
service failed in the RMI-API
Server service.

Check whether DkcId32.dll
exists in the following paths.
• Windows system directory

(example: C:\Windows
\system32)

• · Windows directory
(example: C:\Windows)

• Directory defined in
environment variable PATH

When DkcId32.dll exists,
delete DLL and restart the SVP.

If the condition does not
recover after restarting the SVP
or DkcId32.dll does not exist
in the previous path, set up
again.

1 This log is output when RMI-
API Server detects a connection
error, even once.

Ignore this log when the
connection is successful by
retry and Storage Navigator (or
the client connected by external
RMI) is operating normally.

TRRMIS000021 ERROR An unexpected error occurred
in the RMI-API Server service.

Collect the dump files (see 
Using the Dump tool on
page 379).

If the collection fails, collect the
target files manually (see ).

TRRMIS000022 ERROR An unexpected error occurred
in the RMI-API Server service.
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Collect the dump files (see 
Using the Dump tool on
page 379).

If the collection fails, collect the
target files manually (see ).

TRRMIS000023 ERROR An unexpected error occurred
in the RMI-API Server service.

Collect the dump files (see 
Using the Dump tool on
page 379).

If the collection fails, collect the
target files manually (see ).

TRRMIS000024 ERROR An unexpected error occurred
in the RMI-API Server service.

Collect the dump files (see 
Using the Dump tool on
page 379).

If the collection fails, collect the
target files manually (see ).

TRRMIS001001 INFO Output when starting the RMI-
API Server service. To check
that the RMI-API Server service
has started normally, match it
to the log and check that
TRRMIS001002 is output.

TRRMIS001002 INFO Output when the start of the
RMI-API Server service is
completed normally.

TRRMIS001003 WARN Operating with the default
value indicated in the log
content because the acquisition
of the port number used in the
RMI-API Server service failed.

Check that the port value of the
port number key
RMIClassLoader is set correctly
(see Changing SVP port
numbers). Stop the appropriate
storage system once from the
Storage Device List and
restart it.

If the condition does not
change after restarting, restart
the SVP.

If it does not recover after
restarting the SVP, set it up
again.

TRRMIS001004 WARN Operating with the default
value indicated in the log
content because the acquisition
of the environment setting
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information necessary for the
RMI-API Server service failed.

Check that the IP address of
the SVP set by the Storage
Device List is correct and
restart the SVP.

If the condition does not
recover after restarting the SVP,
set it up again.

TRRMIS001005 WARN A log waiting for other services
necessary for starting the RMI-
API Server service.

The log is output once in ten
minutes and six times at a
maximum. If Device Manager -
Storage Navigator still cannot
start after outputting
TRRMIS001002 and outputting
the log six times, stop the
appropriate storage system
once from the Storage Device
List and restart it.

When TRRMIS001003 and
TRRMIS001004 are output with
the log, check the coping
method of the appropriate
troubleshooting code together.

If the condition does not
change after restarting, restart
the SVP.

If the condition does not
recover after restarting the SVP,
set it up again.

TRRMIS001006 INFO Output when the RMI-API
Server service terminates. To
confirm that the SVP RMI-API
Server service is completed
normally, match it to the log
and check the output of
TRRMIS001007.

TRRMIS001007 INFO Output when the RMI-API
Server service is stopped
normally.

TRRMIS001008 WARN Some functions of the RMI-API
Server services are not
operating normally.

The storage system cannot stop
normally.

Restart the SVP.

TRRMIS001009 ERROR An unexpected error occurred
in the RMI-API Server service.
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Collect the dump files (see 
Using the Dump tool on
page 379).

If the collection fails, collect the
target files manually (see ).

TRRMIS001998 ERROR The RMI-API Server service
terminated abnormally.

TRRMIS001999 ERROR The service stopped forcibly.
This message might be output
when SVP restarted while the
service is running.

Stop the storage system by
Storage Device List once, and
then restart it.

TRRMIS002501 INFO Output when the RMI-API
Server service starts.

To confirm that the RMI-API
Server service has started
normally, match it to the log
and check that TRRMIS002502
is output.

TRRMIS002502 INFO Output when the start of the

RMI-API Server service is

completed normally.

TRRMIS002503 WARN The RMI-API Server service
started but a warning has
occurred in the processing.

Check the troubleshooting
codes output from
TRRMIS002501 to the log and
take actions.

TRRMIS002504 ERROR The RMI-API Server service
failed to start.

Check the troubleshooting
codes output through
TRRMIS002501 and the log and
take actions.

TRRMIS002505 ERROR Acquiring the environment
setting information necessary
for starting the RMI-API Server
service has failed.

Stop the relevant storage
system from the Storage
Device List and restart it.

If the condition does not
change after restarting the
storage system, restart the
SVP.

TRRMIS002506 ERROR

TRRMIS002507 ERROR
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If it does not recover after
restarting the SVP, set up
Storage Navigator again.

TRRMIS002508 ERROR The ports necessary for the
RMI-API Server service are
unusable.

Check that the ports output to
the log are not used in another
application and change the port
number of the appropriate
application when permitted.

If you cannot change the port
number (see ), change the port
number for DKCManPrivate and
then restart the SVP. If the
applicable application port
number was changed, restart
the SVP.

TRRMIS002509 ERROR

TRRMIS002510 INFO Output when the RMI-API
Server service stops.

To confirm that the RMI-API
Server service is stopped
normally, match it to the log
and check that TRRMIS002511
is output.

TRRMIS002511 INFO Output when the RMI-API
Server service is stopped
normally.

TRRMIS002512 ERROR The RMI-API Server service has
stopped.

If the condition does not
change within five minutes, run
the following procedures in
order.

1. Stop the appropriate storage
system from the Storage
Device List and restart it.

2. If the condition does not
recover using step 1, restart
the SVP.

3. If there is still no recovery,
set up Storage Navigator again.

TRRMIS002513 ERROR The RMI-API Server service
stopped forcibly. This error
might occur when restarting the
SVP while the service is
running. When the SVP
restarted or the storage system
stopped, restart the storage
system by Storage Device List.
In other cases, the RMI-API
Server service restarts
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automatically. If the condition
does not change within three
minutes, perform the following
procedure sequentially.

1. Stop the storage system
using the Storage Device List
and restart it.

2. If there is no recovery using
step 1, restart the SVP.

3. If there is still no recovery,
set up Storage Navigator again.

TRRMIS002514 ERROR An error occurred in the
communication with the RMI-
API Server service. The RMI-
API Server service restarts
automatically. If the condition
does not change within one
minute, perform the following
procedure sequentially.

1. Check whether the SVP IP
address set by Storage Device
List is correct. If not, set it.

2. If there is no recovery using
step 1, stop the storage system
using the Storage Device List
and restart it.

3. If there is no recovery,
restart the SVP.

4. If there is still no recovery,
set up Storage Navigator again.

TRRMIS002515 ERROR The RMI-API Server service
stopped abnormally.

Check the troubleshooting
codes output from
TRRMIS002501 to this log and
take necessary actions.

Note:

1. If the router converts the IP address, the address might be different from the IP address of the
PC itself. In this case, confirm with the network administrator.

External authentication relay server

The following example is a normal log output when the server starts
normally.

[2015/03/19 18:08:31.265][INFO ][TREXAU000001][External Authenticator]
[Initializing]

[2015/03/19 18:08:31.858][INFO ][TREXAU000002][External Authenticator][Ready]
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The following example is when a log output is normal at termination.

[2015/03/19 21:11:48.812][INFO ][TREXAU000004][External Authenticator][Stopping]

[2015/03/19 21:11:48.943][INFO ][TREXAU000005][External Authenticator][Stopped]

The following example is when a log output contains errors at startup.

[2015/03/20 22:15:36.265][INFO ][TREXAU000001][External Authenticator][Initializing]

[2015/03/20 22:15:36.364][ERROR][TREXAU000003][External Authenticator][Stopped : An
unexpected error has occurred.]

The following example is when a log output contains errors at termination.

[2015/03/20 22:20:14.317][INFO ][TREXAU000004][External Authenticator][Stopping]

[2015/03/20 22:20:15.113][ERROR][TREXAU000006][External Authenticator][Stopped : An
unexpected error has occurred.]

The following table lists troubleshooting codes and recovery actions.

Troubleshooting code Failure level Recovery action

TREXAU000001 INFO Output when the external
authentication relay service
starts.

To confirm that the external
authentication relay service has
started normally, match it to
the troubleshooting code and
check that TREXAU000002 is
output.

TREXAU000002 INFO The external authentication
relay service has started
normally.

TREXAU000003 ERROR The external authentication
relay service failed to start.

Select the appropriate storage
system from the Storage
Device List, stop it, and then
start it.

If the condition does not
recover, restart the SVP.

If the condition does not
recover after restarting the SVP,
set up Device Manager -
Storage Navigator again.

TREXAU000004 INFO Output when the external
authentication relay service
stops.
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Troubleshooting code Failure level Recovery action

To confirm that the external
authentication relay serviced is
stopped normally, match it to
the troubleshooting code and
check that TREXAU000005 is
output.

TREXAU000005 INFO Output when the External
authentication relay service
stops normally.

TREXAU000006 ERROR An error occurred by stopping
the external authentication
relay service.

If the external authentication
relay service does not start
normally (TREXAU000002) at
the next start time, restart the
SVP.

If the condition does not
recover after restarting the SVP,
set up Device Manager -
Storage Navigator again.

TREXAU000007 ERROR The external authentication
relay service is not started.

Select the appropriate storage
system from the Storage
Device List, stop it, and then
start it.

If the condition does not
recover, restart the SVP.

If the condition does not
recover after restarting the SVP,
set up Device Manager -
Storage Navigator again.

TREXAU000008 ERROR The test communication to the
Hitachi Command Suite server
when setting the external
authentication link of the
Hitachi Command Suite server
failed.

The network setting of the
Hitachi Command Suite server
or the setting of the external
authentication can experience a
problem.

Check the setting of the Hitachi
Command Suite server.

TREXAU000009 ERROR The connection with the Hitachi
Command Suite server failed
when performing the external
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Troubleshooting code Failure level Recovery action

authentication for the Hitachi
Command Suite server.

The network setting of the
Hitachi Command Suite server
or the setting of the external
authentication can experience a
problem.

Check the setting of the Hitachi
Command Suite server.

TREXAU000010 ERROR The external authentication
relay service stopped forcibly.
This message might be output
when SVP restarted while the
service is running.

Select the relevant storage
system from the Storage
Device List, stop it, and then
restart it.

If the condition does not
recover, restart the SVP.

If the condition does not
recover after restarting the SVP,
set up Device Manager -
Storage Navigator again.

TREXAU000011 ERROR The external authentication
relay service stopped forcibly.
This message might be output
when SVP restarted while the
service is running.

Select the relevant storage
system from the Storage
Device List, stop it, and then
restart it.

If the condition does not
recover, restart the SVP.

If the condition does not
recover after restarting the SVP,
set up Device Manager -
Storage Navigator again.

SMI-S Provider service

The following example is a normal log output when the SMI-S Provider
service starts and terminates normally.

[2015/03/31 18:08:31.265][INFO ][TRSMIS000001][SMI-S][Initializing : start SMI-S
service. Port= 5989 ]

[2015/03/31 18:08:31.858][INFO ][TRSMIS000002][SMI-S][Ready]
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:

[2015/03/31 21:11:48.812][INFO ][TRSMIS000007][SMI-S][Stopping]

[2015/03/31 21:11:48.943][INFO ][TRSMIS000006][SMI-S][Stopped]

The following example is when a log output contains errors.

[2015/03/31 22:15:36.265][INFO ][TRSMIS000001][SMI-S][Initializing : start SMI-S
service. Port= 5989 ]

[2015/03/31 22:15:36.364][ERROR][TRSMIS000003][SMI-S][Failed : Failed to cache.]

The following table lists troubleshooting codes and recovery actions.

Troubleshooting code Failure level Recovery action

TRSMIS000001 INFO Output when the SMI-S
Provider service starts.

To confirm whether the SMI-S
Provider service has started
normally, check that
TRSMIS000002 is output with
this log.

When TRSMIS000006 is output
immediately after starting the
SMI-S Provider service, the
following factors are
considered. Take appropriate
actions for respective factors.
• The port number used by

other services is set.
Change the port number to
be used, and then start the
service again.

• There is no file necessary
for the SMI-S Provider
service to operate. Install
the SMI-S Provider program
product again, and then
restart the service.

TRSMIS000002 INFO Output when the start of the
SMI-S Provider service is
completed normally.

TRSMIS000003 ERROR The cache capacity used by the
SMI-S Provider service cannot
be secured.

Check the cache used by other
applications and delete the
unnecessary cache. Then, stop
the storage system once from
the Storage Device List and
restart it.
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Troubleshooting code Failure level Recovery action

TRSMIS000004 ERROR A time-out occurred in the SMI-
S Provider service.

When Modify is acquired in the
other applications, cancel
Modify of the corresponding
applications or wait until Modify
is canceled. If the error is not
resolved or other conditions
exist, stop the corresponding
storage system in the Storage
Device List, and then restart
it.

Stop the storage system once
from the Storage Device List
and restart it.

TRSMIS000005 ERROR An unexpected error occurred
while starting the SMI-S
Provider service.

Collect the dump files (see 
Using the Dump tool on
page 379).

If the collection fails, collect the
target files manually (see 
Collecting dump files manually
on page 380).

TRSMIS000006 INFO Output when the stop of the

SMI-S Provider service is

completed normally.

TRSMIS000007 INFO Output when the SMI-S
Provider service stops.

To confirm whether the SMI-S
Provider service has stopped
normally, check that
TRSMIS000006 is output with
this log.

TRSMIS000008 INFO Output when the SMI-S
Provider service communicates
with the RMI server.

To confirm whether the SMI-S
Provider service started
normally, check that
TRSMIS000002 and this log are
output.

TRSMIS000009 INFO Output when the SMI-S
Provider service communicates
with the SVP.

To confirm whether the SMI-S
Provider service started
normally, check that
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Troubleshooting code Failure level Recovery action

TRSMIS000002 and this log are
output.

Communication service

The following example is a normal the service starts and ends normally.

[2015/05/27 16:03:04.875][INFO ][TRCOMM000001][Communication] [Ready : Connection
to GUM2 opened.]

[2015/05/27 16:03:16.972][INFO ][TRCOMM000001][Communication] [Ready : Connection
to GUM1 opened.]

:

The following example is when a log output contains errors:

2015/05/27 16:03:17.288][ERROR][TRCOMM000004][Communication] [Failed : Connection
to GUM2 failed. Already connected MPC's IP Address is (1)10.xx.yy.zz ]

[2015/05/27 16:03:17.428][ERROR][TRCOMM000009][Communication] [Failed :
Authentication failed by GUM2.]

The following table lists troubleshooting codes and recovery actions.

Troubleshooting code Failure level Recovery action

TRCOMM000001 INFO Output when completing the
communication path connection
with GUM after the
communication service starts.

TRCOMM000002 INFO Output when completing device
authentication in the
communication path to GUM
after the communication service
starts.

TRCOMM000003 INFO Output when completing the
consistency check in the
communication path to GUM
after the communication service
starts. This indicates the state
that serial numbers, config
models, and models are
identical.

TRCOMM000004 ERROR Output when another SVP
connected to the storage
system is ready for use. Stop
the services of the storage
system running on the PC
whose IP address is shown in
the background service log.
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Troubleshooting code Failure level Recovery action

If your router converts IP
addresses, the address might
be different than the IP address
of the PC.

TRCOMM000005 WARN Output when detecting that the
IP address for each controller
set in the Add System window
and the controller number set
for GUM are not identical.
Correct the IP address setting
for each controller in the
Storage Device List.

TRCOMM000006 WARN Output when the storage
system model set in the Add
System window and specified
during setup is not identical.
Delete the storage system from
the Storage Device List and
register it again with the
correct storage system model.

TRCOMM000007 WARN Output when the config model
set in the Add System window
and specified during setup is
not identical. Delete the storage
system from the Storage
Device List and register it
again with the correct Config
model.

TRCOMM000008 WARN Output when the serial number
set in the Add System window
and specified during setup is
not the identical. Delete the
storage system from the
Storage Device List and
register it again with the
correct serial number.

TRCOMM000009 ERROR The user name and the
password set in the Add
System window might be
incorrect. Set the user name
and the password in the
Storage Device List again.

TRCOMM000010 INFO Output when disconnecting the
communication path to GUM
after the communication service
starts.

TRCOMM000011 ERROR Output when the information
update failed.

It updates again automatically.
However, if the TRCOMM000002
log is not output within five
minutes of log output, select
the storage system from the
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Troubleshooting code Failure level Recovery action

Storage Device List. Stop the
system, and then restart it.

If the failure does not recover,
restart the SVP.

TRCOMM000012 ERROR Another SVP might already
connect to the storage system
to be used.

Check whether any other PCs
starting the services of the
storage system exists for the
storage system to be used. If
an SVP already started the
services of the storage system,
stop the services.

TRCOMM000013 INFO Output when the
Communication service starts.

To check whether the
communication service is
starting normally, confirm that
this log and TRCOMM000002
are output.

TRCOMM000014 INFO Output when the
Communication service stops.

To confirm that the
Communication service is
stopped normally, confirm that
this log and TRCOMM000015
are output.

TRCOMM000015 INFO Output when the
communication service stops
normally.

TRCOMM000016 WARN Output when the connection
with the storage system fails.

Check the IP addresses of CTL1
and CTL2 that are set in
Storage Device List.

If the IP addresses are
incorrect, stop the service of
this storage system, and then
set correct IP addresses. After
setting, restart the service.

If the IP addresses are correct,
check the communication path
between the storage system
and the SVP or the
maintenance utility
TRCOMM000017 operation
status.
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Troubleshooting code Failure level Recovery action

TRCOMM000017 ERROR The communication service
terminated abnormally.

TRCOMM000018 ERROR The communication service is
stopped forcibly.

This might be output when SVP
restarts while the
communication service is
running.

Stop the service of this storage
system using Storage Device
List and restart it.

KMIP Communicator

The following example is a log output with errors.

[2015/11/19 10:49:49.617][ERROR][TRKMIP000001][KMIPCom][Failed : SSL settings are
invalid.]

Troubleshooting code Failure level Recovery action

TRKMIP000001 ERROR An unexpected error occurred
in the KMIP Communicator
service.

Collect the dump files (see 
Using the Dump tool on
page 379).

If the collection fails, collect the
target files manually (see ).

Dump tool
About the Dump tool

Use the Dump tool to collect Hitachi Device Manager - Storage Navigator
configuration information.

You should collect dump files:
• Before deleting the storage management software.
• To troubleshoot Device Manager - Storage Navigator.
• Before replacing the storage system.

The Dump tool has two files.
• Dump_Normal.bat collects dump files containing information about the SVP

and minimum information about the storage system. Use this tool when
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there is no fatal error, such as a problem with accessing Device Manager -
Storage Navigator.

• Dump_Detail_bat collects detailed dump files and contains comprehensive
information about the storage system in addition to the contents of the
normal dump file. Use this tool if you cannot start Device Manager -
Storage Navigator or to check for problems with the storage system.

Using the Dump tool

Before you begin

• The client PC must be connected to the SVP using the Remote Desktop
Connection.

• Verify Hitachi Device Manager - Storage Navigator is running.
• No other user should be using the Dump tool.
• No maintenance operation is being performed.
• Dump tools for other storage systems are not being used.

Note: If there are issues related to starting Hitachi Device Manager - Storage
Navigator, use the dump tool while Hitachi Device Manager - Storage
Navigator is not running and collect the information related to SVP.

Procedure

1. In Hitachi Device Manager - Storage Navigator, click File > Refresh All
to refresh the configuration information shown.

2. On the SVP, exit to a Windows command prompt as Administrator.
3. Change to the directory where the Dump tool is located.

For example, C:\Mapp\wk\83xxxxxxx\DKC200\mp\pc where 83xxxxxxx is
the DKC serial number.

Note: In the command above, C:\Mapp indicates the installation
directory of the SVP. If the installation directory is different,
replace C:\Mapp with the specified installation directory.

4. Specify the output folder for the dump file (for example, C:\Mapp\wk
\83xxxxxxx\DKC200\tmp) as an output destination, and then run
Dump_Normal.bat or Dump_Detail.bat. For example, to output the
performance result of the Detail Dump tool to C:\Result_832000400001,
enter the following: Dump_Detail.bat C:\Result_832000400001

Note: The dump file name is hdcp.tgz. To manage the dump file
for each storage system, assign the serial number to the output
destination folder name. For example, If the serial number: is
832000400001, set the file name to C:\Result_832000400001.
While executing the tool, Executing appears in the command
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prompt. When completing the tool execution, zSv_AutoDump.exe 
is completed appears in the command prompt.

5. At the completion message, close the command prompt.
6. Under the output destination folder, check that the following files are

created.:
• hdcp.tgz is the dump file. If many dump files are output to the

storage system, the SVP free space might be insufficient, and you will
have to move the dump files to a location other than the SVP.
zSv_AutoDump.log is the dump tool log file. If the dump file was not
created, send this log file to your administrator. Otherwise, delete the
log file.

7. Exit the command prompt.

Collecting dump files manually
If you cannot use the Dump tool or the Dump tool fails, collect the following
dump files manually.

In the following list:
• installDir is the SVP installation directory (for example, C:\Mapp).
• %USERPROFILE% is the installation login user of the SVP (for example, C:

\Users\<user name>).
• %WINDIR% is the Windows folder in the system drive (for example, C:

\Windows).

 <installDir>\wk\supervisor\dkcman\log\*.*
 <installDir>\wk\supervisor\dkcman\cnf\*.*
 <installDir>\wk\supervisor\rmiserver\log\*.*
 <installDir>\wk\supervisor\rmiserver\cnf\*.*
 <installDir>\wk\supervisor\sdlist\log\*.*
 <installDir>\wk\supervisor\mappiniset\logs\MappIniSet\*.*
<installDir>\wk\supervisor\mappiniset\mpprt\cnf
<installDir>\wk\supervisor\portmanager\logs\PortManager\*.*
<installDir>\wk\supervisor\restapi\data
<installDir>\wk\supervisor\restapi\logs
<installDir>\wk\supervisor\restapi\build.json
<installDir>\wk\supervisor\restapi\version.json
<installDir>\wk\supervisor\system\log\*.log
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 <installDir>\OSS\apache\logs\*.log
 <installDir>\OSS\apache\logs\ssl\*.log
 <installDir>\OSS\jetty\logs\*.log
 %USERPROFILE%\AppData\LocalLow\Sun\Java\Deployment\log
 %WINDIR%\system32\config\SysEvent.Evt
 %WINDIR%\system32\config\SecEvent.Evt
%WINDIR%\system32\config\AppEvent.Evt
%WINDIR%\minidump\*.dmp
%WINDIR%\System32\Winevt\Logs\Application.evtx
%WINDIR%\System32\Winevt\Logs\Security.evtx
%WINDIR%\System32\Winevt\Logs\System.evtx
%WINDIR%\system32\drivers\etc\HOSTS*
%WINDIR%\system32\drivers\etc\services*
%WINDIR%\minidump\*.dmp
c:\SetupTrace\*.*

Checking the event log when NAS modules are installed
The event log shows the operational status of NAS modules. If the lamp of
Server Status Console at the top left of the main NAS Manager window
turns red, check the event log for errors.

Procedure

1. Log in to NAS Manager.
2. Click Status & Monitoring.
3. In the Status & Monitoring window, click Event Log.
4. Check the information in the Event Log window

Checking SIM alerts
Some alarm, warning, and information notifications shown in the
Maintenance Utility window include SIM alerts.

If an alert, warning, or information item appears in the maintenance utility
without a SIM associated with it, use the following procedure to obtain more
information about the item.
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Procedure

1. In the navigation area of the Maintenance Utility window, check the
status of the storage system.

2. In the header area, click Alert.
The Alerts tab opens.

 

 

Storage
system
status

Description
Acknowledg
ed alert?

Navigation area Alert color

Failed The storage

system might

be down.

No  

 

 

 

Red

Yes  

 

 

 

Red

Warning A part has a

Blocked or

Warning

status.

No  
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Storage
system
status

Description
Acknowledg
ed alert?

Navigation area Alert color

 

Amber

Yes  

 

 

 

Amber

Ready All parts have

a normal

status.

No  

 

 

 

Green

Yes  

 

 

 

Green

Power-on in

progress

Power-on is in progress.  

 

N/A

Power-off in

progress

Power-off is in progress.  

 

N/A

Unknown The storage system is in an

unknown state prior to power

on.

 

 

N/A

3. In the Alerts tab, click DKC, GUM (CTL1), and GUM (CTL2), and then
check the alerts.
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4. Under the Alert ID column, click an entry.

The Alert Detail window opens.
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5. To check the internal alert, click Internal Alerts (DKC) or Internal

Alerts (GUM) from the View Internal Alerts list. Click an entry under
Alert ID.

6. When the Alert Detail window opens, check the alert information:
• SSB shows high-priority error information.
• SSBS shows low-priority error information.

SSB Tab in the Internal Alerts (DKC) Window
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SSBS Tab in the Internal Alerts (DKC) Window
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SSB Tab (CTL1) tab in the Internal Alerts (GUM) Window
 

 
SSB Tab (CTL2) tab in the Internal Alerts (GUM) Window
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Turning the storage system on or off using the maintenance
utility

In the event the SVP is not operational or cannot connect to the storage
system, use the maintenance utility to turn on and turn off the storage
system.

Note: If the storage system is turned off by the main switch, you cannot use
the maintenance utility to turn on a storage system. Use the main switch to
turn it on.

Before you begin

• Verify the breaker is turned on.
• Verify the amber POWER LED on the storage system is on.

Procedure

1. Start the browser on the client PC.
2. In the browser address bar, enter the address of controller 1, and press

Enter.
The login window opens.

3. Log in.
The Maintenance Utility window opens.
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4. To turn on the storage system, click Power Management > Power on
Storage System. At the confirmation message, click Submit.

5. To turn off the storage system, click Power Management > Power off
Storage System. At the confirmation message, click Submit.

Using LEDs to diagnose problems
The storage system LEDs provide system status and diagnostic indicators.

If the storage system used in a remote TrueCopy configuration restarts with
the TrueCopy status of enabled, the following occur:
• The path used by TrueCopy becomes blocked. Notifications from the

Hitachi Device Manager - Storage Navigator email alert function, SNMP
Agent Support function, and SNMP trap occur when the path is blocked.
Follow the instructions in the notification. The blocked path recovers
automatically after restarting the storage system.

• If the TrueCopy pair status is PAIR or COPY, the pair changes to PSUE. In
this case, suspend the pairs before restarting the storage system.

Power LED does not go on

Procedure

1. Set the main switch to on.
2. Is the Power LED on at the controller?

• Yes: Go to step 9.
• No: Power on the host computer.

3. Is the Power LED on at the controller?
• Yes: Go to step 9.
• No: Set the main switch to off.

4. Check that the PDU on the rack is delivering power to the storage
system.

5. Verify that the AC cable is correctly connected to the plug socket and the
equipment.

6. Set the main switch to on.
7. Is the Power LED on at the controller?

• Yes: Go to step 9.
• No: Set the main switch to off.

8. Contact your administrator. Go to step 10.
9. Is the Ready LED on?

• Yes: Continue to use the equipment, even if the green Ready LED
blinks fast.

• No: Use the following corrective action. See Ready LED does not go on
or Ready LED went on and then off on page 390.
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Power LED turned off

Procedure

1. Is AC power being supplied?
• Yes: Check the power cables are connected properly and turn off the

main switch.
• No: Supply AC power to the storage system and restart the storage

system.
2. Wait more than a minute and then set the main switch to on.
3. Is the Power LED on at the controller?

• Yes: Go to step 5.
• No: Set the main switch to off.

4. Contact your administrator. Go to step 6.
5. Is the Ready LED on at the controller?

• Yes: Use the equipment in its current operational state, even if the
green Ready LED blinks fast.

• No: Use the following corrective action. See Ready LED does not go on
or Ready LED went on and then off on page 390.

Ready LED does not go on or Ready LED went on and then off

Procedure

1. Is the controller Power LED on?
• Yes: Go to step 2.
• No: Go to step 4 in POWER LED does not go on.

2. Is the ALARM LED on at the controller?
• Yes: See ALARM LED is on.
• No: Go to step 3.

3. Turn off the main switch.
4. Wait more than one minute, and then set the main switch to on.
5. Is the Ready LED on at the controller?

• Yes: Continue to use the equipment. If the green Ready LED blinks
fast, the storage system is operational. Go to step 8.

• No: Go to step 8.
6. Set the main switch to off.
7. Contact your system administrator.

Alarm LED is on

Procedure

1. Identify which component failed (see Checking SIM alerts on page 381).
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2. Contact your system administrator and do not use the storage system.

Ready LED is on

Procedure

1. Identify which component failed (see Checking SIM alerts on page 381).
2. Contact your system administrator and continue using the storage

system.

Warning LED goes on

Procedure

1. Identify which component failed (see Checking SIM alerts on page 381).
2. Contact your system administrator and continue to use the storage

system.

Troubleshooting related to SMI-S provider startup setting
A message appears if an error occurs when performing the SMI-S provider
startup setting.

The following table describes the error message and troubleshooting actions
that you can take to resolve the error.

Error message Probable cause and recommended action

One or both parameters are not specified. Specify the serial number of the storage system

and the startup type as parameters.

The storage system with the specified serial
number is not added to the Storage Device List.

Verify the specified serial number.

The specified startup type is not valid. Specify enable or disable for the startup type.

This function is not supported. Update the software version of the SVP to

83-03-01-x0/00 or later.

An internal error occurred. Contact the HDS Support Portal at https://

support.hds.com/en_us/contact-us.html,

Troubleshooting SMI-S
You can send an SMI-S test report to determine whether the communication
between the listeners and the SMI-S provider succeeds or fails. If an error
occurs when executing the SMI-S test report, an error message is displayed.
The following table lists test report errors.
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Error message Possible cause and recovery action

The user ID or the password is not valid. User ID or password is invalid. Enter the correct

user ID or password, and then retry the

operation.

An error occurred during the listener information

acquisition.

An error occurred during the listener information

acquisition.
Collect dump files (see Using the Dump tool on
page 379).

No listeners are subscribed to the provider. The listeners are not subscribed to the SMI-S
provider.

Have the listeners subscribe to the provider, and
retry.

The test report cannot be sent to some listeners. Collect dump files (see Using the Dump tool on
page 379).

A time-out error occurred. Send the test report again. If this problem

persists, collect dump files (see Using the Dump

tool on page 379).

An internal error occurred. Collect dump files (see Using the Dump tool on
page 379).
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A
Warning labels on the storage system

□ CBSS/CBSSD controller

□ CBSL/CBSLD controller

□ CBLM controller

□ CBLH controller

□ Small form factor drive tray (AC and DC models)

□ Large form factor drive tray (AC and DC models)

□ Flash module drive tray

□ Dense intermix drive tray

□ CBSS/CBSL/CBSSD/CBSLD controller

□ CBLM controller CBLH controller

□ Drive for a flash module drive tray (DKC-F710I-1R6FM/DKC-
F710I-3R2FM)

□ Drive for a flash module drive tray (DKC-F810I-1R6FN/DKC-
F810I-3R2FN/DKC-F810I-6R4FN)

□ Dense intermix drive tray power supply

□ CMA (used to secure dense intermix drive tray)

□ Battery
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□ Host port expansion chassis

□ PCIe switch board

□ NAS module
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CBSS/CBSSD controller
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CBSL/CBSLD controller
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CBLM controller
 

 

CBLH controller
 

398 Warning labels on the storage system
Service Guide for VSP Gx00 and VSP Fx00 Models



 

Small form factor drive tray (AC and DC models)
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Large form factor drive tray (AC and DC models)
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Flash module drive tray
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Dense intermix drive tray
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CBSS/CBSL/CBSSD/CBSLD controller
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CBLM controller CBLH controller
 

 

Drive for a flash module drive tray (DKC-F710I-1R6FM/
DKC-F710I-3R2FM)
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Drive for a flash module drive tray (DKC-F810I-1R6FN/DKC-
F810I-3R2FN/DKC-F810I-6R4FN)
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Dense intermix drive tray power supply
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CMA (used to secure dense intermix drive tray)
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Battery
 

 

Host port expansion chassis
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PCIe switch board
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NAS module
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Index
Numerics

10-Gbps iSCSI board (copper) 48
10-Gbps iSCSI board (optical) 48
16-Gbps Fibre Channel board 49, 51
32-Gbps Fibre Channel board 49
8-Gbps Fibre Channel board 49

A
AC power supply units

CBSL controller 55
CBSS controller 55
large form factor drive tray 68
small form factor drive tray 68

add 117
alerts

hardware replacement 315
SIM 381

attaching 88
attaching and removing bezel 88

B
back end module

LEDs and connectors 54
back end module replacement 223
background service log 344
backup module replacement 269
battery replacement 121

guidelines 311
bezel 43, 88
bezels

attaching and removing 88
CBLH controller 39
CBLM controller 39
CBSL controller 35
CBSS controller 32
dense intermix drive tray 65
flash module drive tray 62
large form factor drive tray 59
small form factor drive tray 57

blockig a drive 109

C
cables

removing 94
cache flash memory replacement 251
cache memory replacement 185

NAS Module 196
CBLH 43
CBLH controller 40, 43

rear panel 42, 46
with front panel bezel 39
without front bezel 45

CBLM controller 39, 40
rear panel 42
with front panel bezel 39

CBSL controller 35
AC power supply unit 55
CBSL controller 35
front panel bezel 35
rear panel 37
without front panel bezel 37

CBSLD power supply unit 55
CBSS controller 32

AC power supply unit 55
rear panel 34
with front panel bezel 32
without front panel bezel 33

CBSSD power supply unit 55
checking for loose or damaged cables or
connectors 311
checking the event log when NAS modules are
installed 381
cleaning the storage system 310
components

replacing 77
controller replacement 161
controllers

CBLH 43
CBLM 39
CBSL 35
CBSS 32

correct values for the storage system IP address
314
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D
damaged cables or connectors 311
DC power supply units

CBSLD 55
CBSSD 55
large form factor drive tray 68
small form factor drive tray 68

dense intermix 117
dense intermix drive tray 65

display LEDS 66
rear panel 67
with front panel bezel 65

DHCPv4 configuration for storage systems 314
display LEDS on dense intermix drive tray 66
drive 117

blocking 109
drive replacement 107
drive trays

dense intermix 65
flash module 62
large form-factor 59
small form-factor 57

dump tool 378

E
electric shock 17
electrostatic discharge precautions 78
emergency 17
ENC replacement procedure 229
event log when NAS modules are installed 381
EVS migration

after servicing nodes 102
before servicing nodes 97

F
fan

host port expansion chassis 70
inspection 310
replacement 129

fan screw on host port expansion chassis 137
faults 24
Fibre Channel

cable removal 94
filtering TCP/IP ports 315
flash module drive tray 62

rear panel 64
with front panel bezel 62
without front panel bezel 63

front 88
front end module replacement 205
front end modules

10-Gbps iSCSI board (copper) 48
10-Gbps iSCSI board (optical 48
16-Gbps Fibre Channel board 49, 51
32-Gbps Fibre Channel board 49
8-Gbps Fibre Channel board 49

front panel 43

front panel bezels
attaching and removing 88
CBLH controller 39
CBLM controller 39
CBSL controller 35
CBSS controller 32
dense intermix drive tray 65
flash module drive tray 62
host port expansion chassis 69
large form factor drive tray 59
small form factor drive tray 57

G
general troubleshooting 314

H
hardware faults 24
hardware replacement alerts 315
Hitachi Device Manager - Storage Navigator
troubleshooting 330
host port expansion chassis 69

fan 70
fan screw 137
front panel bezel LEDs 69
power cable 157
power supply 72, 154
power supply connection 155
replacing a fan 136

I
identifying hardware faults 24
inspecting fans 310
IP address

host configuration 315
storage system 314
used by other storage systems or hosts 314

iSCSI
cable removal 94

L
LAN blade LEDs and connectors 53
LAN blade replacement 261
large form factor drive tray

AC power supply unit 68
DC power supply units 68
with front panel bezel 59

large form-factor drive tray 59
rear panel 61
without bezel 60

LED troubleshooting 389
logging in and out of NAS Manager 96
loose cables or connectors 311
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M
maintenance utility

port numbers 338
starting 81

maintenance utility troubleshooting 338
maintenance, periodic 310
module 73

N
NAS 73
NAS Manager

logging in and out 96
NAS Manager troubleshooting 335

P
parts 24
parts replacement 84
PCIe cable connector

LEDs 70
PCIe module 52

replacing 279
PCIe switch board

replacing 285
PCIe switchboard

LED 69
periodic maintenance 310
physical SVP

rear panel 75
port filtering 315
port numbers

maintenance utility 338
power supply unit 56
power supply unit replacement 141
power supply units

CBSL controller 55
CBSLD 55
CBSS controller 55
CBSSD 55
host port expansion chassis 72, 154

procedures 17

R
rear panel of physical SVP 75
rear panels

CBLH controller 42, 46
CBLM controller 42
CBSL controller 37
CBSS controller 34
dense intermix drive tray 67
flash module drive tray 64
large form-factor drive tray 61
small form factor drive tray 59

recovery withreplacement parts 105
removing cables 94
replaceable parts 24

replacing
back end module 223
backup module 269
battery 121
cache flash memory 251
cache memory 185
cache memory for a NAS Module 196
controller 161
drive 107
ENC 229
fan 129
front end module 205
host port expansion chassis 136
LAN blade 261
NAS module 303
parts 84
PCIe module 279
PCIe switch board 285
power supply unit 141
SAS cable 235
small form-factor pluggable 213
small form-factor pluggable for a NAS module
218

replacing components 77
electrostatic discharge precautions 78
guidelines after replacement 80
guidelines before replacement 80
replacement parts 84
safety considerations 79
unpacking 78

replacing parts
recovery 105

restarting the storage system 311

S
safety considerations when replacing components
79
SAS cable replacement 235
SAS cables

removing 94
screw on host port expansion chassis 137
searching storage system across IPv6 routers
315
service processor 73, 74
Setting a link to the external server 336
Setting disk capacity assignments 335
SIM alerts 381
small form factor drive tray

AC power supply unit 68
DC power supply units 68
rear panel 59
with front panel bezel 57
without bezel 58

small form-factor drive tray 57
small form-factor pluggable replacement 213
small form-factor pluggable replacing

NAS module 218
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starting
maintenance utility 81

storage system
cleaning 310
DHCPv4 configuration 314
IP address values 314
restarting 311
searched across IPv6 routers 315
storing 311
warning labels 393

storage system controllers
CBLH 43
CBLM 39
CBSL 35
CBSS 32

storing the storage system 311
SVP 73

T
TCP/UDP port filtering 315
tray 117
troubleshooting

dump tool 378
general 314
hardware replacement alerts 315
Hitachi Device Manager - Storage Navigator
330
LEDs 389
maintenance utility 338
NAS Manager 335
SIM alerts 381

Troubleshooting file-level access operations 338
turning the storage system on or off using the
maintenance utility 388

U
unpacking replacement components 78
used by other storage systems or hosts 314
using LEDs to troubleshoot 389
using the maintenance utility to turn the storage
system on or off 388

V
values for the storage system IP address 314
Virtual Storage Platform G200 Virtual Storage
Platform G400, G600 Virtual Storage Platform
G800 Virtual Storage Platform F400, F600 Virtual
Storage Platform F800 47

W
warning labels 393
without front panel bezel 40
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